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1 Introduction

EagleFiler is an easy-to-use information manager. It lets you organize and search mail, Web pages,
PDF files, notes, and more. Use it to collect stuff from a variety of sources. Browse everything
using a standard three-pane interface. Organize using folders and annotate using tags and notes,
or just leave everything in one folder and pin-point what you need instantly using the live search.
Since EagleFiler stores its library in Finder format, you can use it in concert with the other tools
in your Mac ecosystem.

EagleFiler in a nutshell:

1. With a single keypress, import a Web page, mail messages, a scrap of text, or any file
on your Mac.

2. EagleFiler stores them in an open format: regular files and folders that are fully acces-
sible to your other applications.

3. Optionally: encrypt the files, add tags, notes, color-coded labels, and other metadata.

4. Browse by folder or by tag, or use the live search to find the information you need
(faster than Spotlight).

5. View, edit, or create documents directly in EagleFiler’s streamlined interface, or double-
click to edit using a more specialized application.

What can you do with EagleFiler? EagleFiler is a digital filing cabinet, a research assistant, and a
snippet collector. You can use it to write a journal, track all the files for a project or job, save your
favorite Web articles, store financial statements, run a paperless office, plan a trip, collect your
course notes, archive your e-mail correspondence, search mailing list archives, research a purchase,
remember recipes to cook or books to read, store scientific papers, gather legal case notes, or
assemble a scrapbook. It’s the most flexible tool on your Mac.

1.1 Importing Is a Snap

Getting your information into EagleFiler is easy. When you’re viewing a Web page in Safari or
NetNewsWire1, looking at a mailbox in Mail, or browsing files in the Finder, just press the capture
key (F1 by default, or Option-F1 to see the options below). EagleFiler will save the document
into its library, and you can go right on working without interrupting your flow. (Of course, you
can also use drag and drop or other methods if you prefer.) Once the document is in EagleFiler,
you’ll always have a copy of the way it looked when you imported it. No more bookmarking a
great article, only to find out later that the page is no longer available or that registration or even
payment is now required. If you do research on the Web, you know that pages change—sometimes

1http://netnewswireapp.com/mac

6

http://netnewswireapp.com/mac


without notice—so it’s always good to keep a paper trail of exactly what you read. There’s no
shame in being a digital pack rat when today’s Macs ship with tens or even hundreds of gigabytes
of storage.

1.2 Familiar Mail-like Interface

EagleFiler browser windows use a three-pane view that’s familiar to any Mail user. This is not a
database front-end; it’s a real Mac application with a fully Aqua user interface. Click on one or
more sources to view their contents. Enter some text in the search box to filter the record list.
Click on a record to view it right there in the window. HTML mail messages can be viewed as rich
text, or you can view e-mails as plain text, complete with color-coded quoted text and clickable
links. You can open as many windows as you want to view different parts of the library.
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1.3 Search Everything

It’s no good to store your information if you can’t find it when you need it. Fortunately, EagleFiler
offers some powerful search options. If you know the title, author, or recipient you’re looking for,
you can search by one of those fields. Or, use EagleFiler’s indexed search to look through the
entire contents of your documents. Like Spotlight, EagleFiler can search different types of files at
once—after all, what matters is what you’re looking for, not whether it’s in a PDF, an e-mail, or
a chat.

Unlike Spotlight, EagleFiler makes it easy to narrow down the results. You’re searching within
the library, not all the files on your hard disk, so the search is fast. You can select one or more
folders or mailboxes within the library to restrict the search—reducing the amount of data that
EagleFiler has to look through, and number of results that you’ll have to comb through. You can
even do Boolean, tag, and phrase-based searches to tell EagleFiler exactly what you’re looking
for. Once you’ve narrowed the search results to a manageable number of documents, it’s easy to

8



find the information you’re looking for because you can view the document contents right there in
EagleFiler.

For more complex searches, or for quick access to your most common searches, you can create your
own smart folders.

1.4 The Library Is Open

Like iTunes and iPhoto, EagleFiler keeps your data in a library. The library is just a special folder
in the Finder that EagleFiler manages, so there’s no lock-in. You shouldn’t re-arrange the files and
folders in the library except through EagleFiler, but other than that you can treat it just like a
regular folder. Browse its contents in the Finder or Path Finder2—the folder structure matches the
folders in EagleFiler.

View and edit the files using your favorite applications. Drag key files to the Dock or make aliases
of them on your desktop. Search the files using Spotlight. Back them up using Time Machine.
Label files in EagleFiler, and the labels automatically show up in the Finder—and vice-versa. Files
in the library will still show up in your application’s Open Recent menus, and Preview will still

2http://www.cocoatech.com
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remember which page of the PDF you were reading. In short, you can capture, organize, and search
your files using EagleFiler, without giving up the normal conveniences of the Mac experience.

1.5 Reliable Data Storage

The library may look like just a folder full of files, but EagleFiler uses a Core Data3 SQL database
(with an automatic XML backup) to keep track of the files and their metadata. This lets you
put thousands of files in the library and access them reliably and quickly. Each time you open a
library, EagleFiler checks to make sure that all the files are present. It can even verify the library
(using MD5 checksums4) to make sure that none of the files has been corrupted. There’s no point
in storing and backing up damaged files. When you archive your documents in EagleFiler, you can
be sure that when you need to read them again they’ll be in pristine condition.

Plus, EagleFiler libraries go great with backups and archival. Your data is stored in individual files,
so smart backup and synchronization programs won’t waste time and space copying the documents

3http://developer.apple.com/macosx/coredata.html
4http://en.wikipedia.org/wiki/Md5#Applications
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that haven’t changed. Since the files are in standard formats like PDF, RTF, and mbox, you’ll be
able to read them years from now, even if—alas—you’re no longer using EagleFiler.

1.6 Add Tags and Notes

Tags are somewhat like labels in the Finder, except that each record can have as many tags as
you want. EagleFiler has some tags such as “unread,” “flagged,” and “replied” built-in, and it will
import these from Mail. If you’ve created additional tags in Mail using MailTags5, EagleFiler will
import those as well. You can also create your own tags. Tags may be treated like keywords, and
each tag also appears as a source in the browser window, which acts like a playlist in iTunes or an
album in iPhoto.

Each document or message in EagleFiler can also have a note. Notes, which you can edit in
EagleFiler’s Info inspector, are like comments in the Finder on steroids. They support rich text
with multiple fonts, sizes, and colors. Notes can even include clickable links, graphics, tables, and
lists. Use notes to write down information that goes with your documents, to excerpt key passages,
to add your own comments or analysis, or to add links to related records in EagleFiler.

1.7 Speed Up and Simplify Your Other Applications

Most e-mail programs are designed for communicating with your mail server and letting you read
and write messages—not for storing all your old mail. By cleaning out your mail program’s
database, you can remove some clutter from its mailbox list and speed it up. EagleFiler pre-
serves the entire message source, including headers and attachments, as well as MailTags6. But
cleaning it out doesn’t have to mean lots of time wasted trying to predict which messages you might
need in the future. Disk space is plentiful—just archive all your old mail into EagleFiler. Later,

5http://www.indev.ca/MailTags.html
6http://www.indev.ca/MailTags.html
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you’ll be able to find what you need with a quick search. Meanwhile, the archived messages will no
longer be slowing down Spotlight searches of your files and current messages. Nor will they slow
down and fill up your Time Machine backups.

Likewise, your Web browser’s bookmarks feature is great for remembering sites that you’ll want
to go back to frequently. But it isn’t ideal for remembering the information found on Web pages.
Don’t bookmark news articles, recipes, reviews, and other documents—and then try to look through
your overflowing bookmarks folder to recall the articles by title and URL. Instead, capture the Web
pages into EagleFiler where you’ll be able to search their entire contents.

1.8 Multiple Libraries

Some people like to dump all their information into a single EagleFiler library, with minimal folder
structure, and locate documents that they need using the search feature. But EagleFiler also
supports multiple libraries, for those who like to separate their business and personal files, group
them by project or client, or keep different kinds of files in different places. For example, you might
keep some of your files on your iPod or USB keychain drive, some in an encrypted library, and
others in your Documents folder. Unlike with iPhoto and iTunes, you can have multiple EagleFiler
libraries open at once. However you want to group your files, EagleFiler can accommodate.

1.9 Feature List

The following is a partial list of EagleFiler’s features, so that you can quickly see how it works and
how it’s unique:

General

• Easy to install: just drag and drop a single application file. There’s no need to install a
database engine, plug-ins, or script files to integrate with your other applications.

• Easy to use, with a familiar three-pane interface—lots of power, without lots of cluttered
options.

• Makes efficient use of RAM and disk space.

• AppleScript support, for automation and integration with other applications.

Importing

• Can import any kind of file. EagleFiler has special support for displaying most common
formats, and it can use Quick Look to display the others.

• Just press a hotkey while in another application, and EagleFiler will intelligently import
the Web page, mailbox, or file that you’re currently viewing.

• Press the Quick entry hotkey to create a new file in EagleFiler from any application.
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• Store Web pages in the following formats: bookmark, PDF, PDF (single page), plain
text, rich text, rich text with images, Web archive.

• Import from any application by printing and choosing Save PDF to EagleFiler or
by saving a file into EagleFiler’s To Import folder or directly into the library’s folder
structure.

• Move or save new files directly into the library folder, and EagleFiler will auto-import
them when it does a Scan for New Files.

• Import Web pages using bookmarklets7.

• Automatically import scans by setting your scanner software (Fujitsu ScanSnap8 recom-
mended) to save its files in the To Import folder.

• There are many other ways to import (e.g. drag and drop, services) so you can choose
whatever’s easiest for the task at hand. Hold down the Option key when importing, and
you can choose where to save the file and add tags, notes, and other metadata.

• Automatically detects duplicate files to save disk space and help you see what’s already
been imported.

Mail

• First-class support for archiving e-mail. EagleFiler understands the content of messages
and treats them as mail rather than as text or RTF files.

• Import the selected mailboxes or messages simply by pressing a hotkey in Apple Mail,
Entourage, Mailsmith, Outlook, or PowerMail.

• EagleFiler retains the full message data, including attachments, read/flagged/replied
status, and MailTags9, so nothing is lost when moving mail into EagleFiler.

• Speed up your mail program by moving older messages to EagleFiler.

• Messages are efficiently stored using the standard “mbox” format and can be imported
back into any mail program if desired.

• You can also store messages as individual .eml files, for Spotlight searchability, and you
can freely convert between the .eml and mbox formats.

• Can display messages as plain text (with colored quote levels and clickable links) or as
HTML.

• Extract and convert your e-mail from Microsoft Outlook (or another proprietary mail
client format) into standard mbox or .eml files.

Organization

• EagleFiler supports multiple libraries, stored wherever you want (hard disk, Dropbox,
iPhone, iPad, iPod, USB drive, etc.).

• You can open more than one library at a time, and more than one window per library.

• Files can be organized with folders and tags, both of which can be nested.
7http://c-command.com/eaglefiler/bookmarklets
8http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/scansnap-iX500.html
9http://www.indev.ca/MailTags.html
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• Use the Go menu to quickly jump around to viewing different parts of your library.

• Select a record, choose Copy Record Link, and paste the link into another application;
click it to open the record in EagleFiler.

Editing

• Create a new file with a single button or keypress and immediately begin typing. There’s
no need to open a new window or go through a Save dialog box.

• Use stationery (a.k.a. templates) to quickly create any type of new file. Stationery can
automatically trigger AppleScripts to dynamically fill in the metadata for you.

• RTF, text, OpenDocument, and bookmark files can be edited from within EagleFiler.
Powerful text editing features include find & replace, spelling and grammar checking,
smart links/quotes/dashes, data detectors, automatic text replacement, and case trans-
formations.

• For other types of files (e.g. Word, Pages), just double-click to open them in your favorite
editor. The changes are automatically saved back into the EagleFiler library.

Storage

• Your data and notes are stored in regular files using standard formats (RTF, PDF, Web
archive, mbox, etc.), so there’s no lock-in or risk of database corruption, and it plays
well with Time Machine10.

• Uses MD5 checksums to verify the integrity of all files in the library, for safe long-term
archival.

• Metadata (tags, titles, source URLs, etc.) goes into a Core Data11 SQL database for
reliable storage and quick access.

• EagleFiler automatically backs up the metadata and notes to XML property list files. In
the rare event that the database file becomes damaged, you can import the files into a
new library, and EagleFiler will build a new database and reconstruct all the metadata.

• Can copy tags into OpenMeta12 and the Spotlight comments field to make them search-
able and accessible to other applications.

Encryption

• Libraries can be encrypted with AES-128 or AES-25613 for secure, password-protected
storage.

• Encrypted libraries are stored using Apple’s disk image technology, so their contents are
accessible on any Mac, whether or not EagleFiler is installed.

• The entire library contents—including the metadata, indexes, and temporary files—are
encrypted. Unencrypted data never touches the disk.

10http://www.apple.com/macosx/features/timemachine.html
11http://developer.apple.com/macosx/coredata.html
12http://openmetainfo.org
13http://en.wikipedia.org/wiki/Advanced Encryption Standard#Security of AES
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• In other respects, an encrypted library works just like a regular one. It’s still fully
searchable, and the files are still accessible to other applications (once you’ve entered
the passphrase).

• Unlike with FileVault, the contents of an encrypted EagleFiler library are protected from
anyone who doesn’t know the passphrase, including other users on the same Mac.

Search

• EagleFiler uses its own optimized indexes so that you can search the contents of your
library faster than with Spotlight.

• You can do exact searches across individual fields (title, filename, notes, tags, from,
to/cc) as well as searches across the entire file contents.

• Searches can use phrases, wildcards, Boolean AND/OR/NOT, and grouping.

• Do quick tag searches by selecting one or more tags at once.

• Create your own smart folders and organize them into folders. Custom smart folders
can contain an unlimited number of criteria, optionally using nested Any/All/None. You
can define actions to occur when you drag a record onto a smart folder.

• Matching search terms are highlighted in the document contents and in the records list.
Use the Find panel or its keyboard shortcuts to search within a document and to jump
from one highlighted occurrence to the next.

• EagleFiler reads most files itself, so it can index text that Spotlight wouldn’t see (e.g.
files attached to e-mail messages, invisible Web content, Skim14 notes attached to PDF
files). It automatically takes advantage of third-party Spotlight importer plug-ins to
support custom file formats.

• Since the files and notes are stored out in the open, they’re also searchable with Spotlight
(for when you want to search your entire Mac at once), without the need for stub files
in the Caches/Metadata folder.

• EagleFiler’s search indexes are immediately available after syncing, restoring from a
backup, or transferring your files to a new Mac; there’s no need to wait for it to reindex,
as with Spotlight.

Metadata

• For each file, EagleFiler records the document title, author/from, and source URL.

• You can assign tags (a.k.a. keywords). Tags can have abbreviation symbols and colors,
and they can be nested. Quickly assign tags by typing (with auto-completion), drag-
and-drop, or by clicking on them in the Tag Cloud.

• The Tags column in the records list compactly shows the abbreviation symbols for all
the assigned tags.

• Each file or mail message can have notes, which can include rich text, clickable links,
images, and tables.

• Each file and folder can have a colored label, which also shows up in the Finder.
14http://skim-app.sourceforge.net
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• You can copy links to EagleFiler records and paste them into notes or RTF files, or into
other applications.

• When importing via the capture key, EagleFiler can preserve metadata (e.g. tags, notes,
titles, URLs) from the source application. This is often higher fidelity than using that
application’s own export feature.

• When importing an existing file, EagleFiler can import tags and notes from the file’s
Spotlight comments.

• EagleFiler can display and search Skim15 notes attached to PDF files.

2 Installing and Updating

2.1 Requirements

EagleFiler requires Mac OS X 10.6.8 or later.

2.2 Installing EagleFiler

Drag the EagleFiler icon onto the Applications folder. Double-click the Applications folder
to open it. Double-click the EagleFiler icon to launch it. Eject the white EagleFiler-1.6 icon.

System Services

Please see Enabling EagleFiler’s Services in the Services section of the manual.

PDF Service

If you purchased via the Mac App Store, due to Apple’s guidelines, EagleFiler cannot automatically
install the PDF service that adds the Save PDF to EagleFiler command to the Print dialog.
To install the PDF service yourself, open the folder:

/Users/<username>/Library/PDF Services/

(To open the Library folder under Mac OS X 10.7 Lion or later, go to the Go menu in the Finder
and hold down the Option key.) Select the EagleFiler application in the Finder. Choose File .
Make Alias. Drag the new alias into the PDF Services folder and rename it to Save PDF to
EagleFiler.

Growl
15http://skim-app.sourceforge.net
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It is recommended that you also install Growl16 to take full advantage of EagleFiler’s notification
features, although this is not required.

2.3 Updating From a Previous Version

The easiest way to update EagleFiler is to use the Software Update. . . command to download and
install the latest version.

Alternatively, you can replace the old EagleFiler application file with the new one. That is, if
EagleFiler is installed in the Applications folder, drag the new EagleFiler application icon into
the Applications folder and click Replace when the Finder asks if you want to overwrite the old
version. If you get an error saying that you do not have sufficient privileges, drag the old EagleFiler
to the trash and empty it, and then drag the new one into the Applications folder.

Note: If you purchased via the Mac App Store, you should update EagleFiler using the App Store
application.

2.4 Uninstalling EagleFiler

To uninstall EagleFiler, drag its application file to the trash.

Although you will no longer be able to open your libraries with EagleFiler, the files in the libraries
will remain accessible in the Finder. Next to each library is a folder called Files (which contains
the files and folders in the library) and a folder called Notes (which contains any notes that you’ve
added).

To remove EagleFiler from the PDF button-menu in the Print dialog, drag the file:

/Users/<username>/Library/PDF Services/Save PDF to EagleFiler

to the trash. (To open the Library folder under Mac OS X 10.7 Lion, go to the Go menu in the
Finder and hold down the Option key.)

3 Using EagleFiler

3.1 Basics

Welcome to EagleFiler. Like iTunes and iPhoto, EagleFiler stores its files in a library. To get
started, choose New Library. . . from the File menu. You can save the library wherever you want,

16http://growl.info
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and you can create multiple libraries if desired. To add to your EagleFiler library, you can:

Import existing files or Web pages

The easiest way to import is often to press the capture key or the capture with options key.
EagleFiler will automatically figure out the current Web page or the selected mail messages
and import them. There are also many other ways to import.

While EagleFiler is importing, it will show a green arrow in the Dock icon and a spinning
progress indicator in the library’s browser window. To ensure a correct import, do not modify
or delete the files being imported until you can see that EagleFiler has finished. Generally
speaking, when you import an existing file, it’s copied into the EagleFiler library. When it’s
done, you can delete the original if desired.

Create new files using EagleFiler

In EagleFiler’s File menu, the New Record . Rich Text File and New Record . Plain Text
File commands let you create new, empty files. The Quick entry hotkey lets you create new
files from within any application.

You can also add your own stationery commands to the New Record submenu. This lets
you create other types of files (e.g. Word or Pages documents) and create new files from
templates. To do this, choose New Record . Open Stationery Folder and copy your template
files into this folder.

The contents of your libraries are stored in library folders. The files are visible in the Finder, and
you can view and edit them via other applications. However, the files are managed by EagleFiler,
so you should only move, rename, or delete them from within EagleFiler.

Each library that’s open in EagleFiler is displayed in one or more browser windows. Each browser
window contains a source list, which lets you access the library’s records. The record is the basic
unit of information in EagleFiler. Files, folders, and mail messages are all records. Each record
has contents that can be displayed (and perhaps edited) in the record viewer. You can search for
records and annotate them with tags and notes.

3.2 Library Folders

Outside of EagleFiler, for example when you are browsing in the Finder, each EagleFiler library
appears as a library folder with the following structure:
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Structure of a Library Folder

• The .eflibrary file is the way that you open the library in EagleFiler. It also holds var-
ious information about the contents of the library, such as indexes that EagleFiler uses for
searching, as well as tags and other metadata that you’ve added.

• The Files folder contains all the files and folders that have been imported into the library.
The folder hierarchy within the Files folder matches that within EagleFiler, so you can easily
browse and search the contents of your library from outside of EagleFiler.

• The Notes folder contains one RTF file for each record that has a note. You can edit a
record’s notes using the Info inspector. The notes are searchable within EagleFiler and also
from Spotlight.

• One way to import files into the library is to move or save them into To Import folder.

• If a file in the To Import folder cannot be imported, EagleFiler moves it to the Unable to
Import folder. It is safe to delete files in this folder at any time, if you don’t want to keep
them. If there have not been any such errors, this folder will not exist.

• The Smart Folders folder contains a .plist file for each smart folder in the library. You
can copy a smart folder from one library to another by copying the associated .plist file.
(Make sure that the libraries aren’t open in EagleFiler when you do this.)
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Rules for Library Folders

The contents of the library folder are managed by EagleFiler. What this means is that the files and
folders are fully accessible to other applications, but there are some limits to the kinds of changes
you can make to the library from outside of EagleFiler. These restrictions ensure that the contents
of the library folder stay in sync with the .eflibrary, so that EagleFiler knows where all the files
are.

You can:

• view and search the contents of the library folder using the Finder, Spotlight, and other
applications.

• open files using other applications.

• edit files using other applications and save your changes (without changing the filename).

• add files to the To Import folder.

• add files and folders to the Files folder; EagleFiler will detect them when it does a Scan for
New Files.

• change the Finder label, Spotlight comments, and extended attributes of files in the library
folder.

• edit folder and file icons using the Finder’s Get Info window.

• store the library folder on a shared volume.

So long as you don’t do it while the library is open in EagleFiler, you can:

• move or rename the library folder in the Finder.

• rename the .eflibrary file in the Finder.

• backup and restore the entire library folder.

You should not:

• open the library in more than one copy of EagleFiler at a time.

• move, rename, or delete files inside the Files or Notes folders.

• modify the .eflibrary file.

• move or rename the library folder’s ancestor folders while the library is open in EagleFiler.

• edit the contents of mailbox files.
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• store a library inside another library’s folder.

• tag files from outside of EagleFiler.

Renaming a Library

To rename a library, first close it in EagleFiler. Then you can use the Finder to rename the library
folder, the .eflibrary file, and the To Import folder to have the new name.

Deleting a Library

If you no longer wish to use one of your libraries, you an drag the entire library folder to the trash in
the Dock. This will delete all of the files, as well as EagleFiler’s metadata. To delete an encrypted
library, drag the .sparsebundle or .sparseimage file to the trash.

Syncing a Library

It’s fine to use software that copies folders quickly by only copying the files that have changed. An
example of this is SuperDuper’s17 Smart Update feature. Such software works great with EagleFiler
because it copies data in only one direction at a time. You end up with the same result as if you’d
done a regular copy, but it doesn’t take as long. If you use ChronoSync, be sure to uncheck Prune
folders and Ignore invisibles.

You should not use software that synchronizes or merges by copying data in both directions at
once. This is equivalent to adding/moving/renaming/deleting files, which would violate the above
rules, so it would cause the Files and Notes folders to get out of sync with the .eflibrary file.

3.3 What Can Be Imported

EagleFiler can import virtually any file on your Mac, as well as Web pages that are displayed in your
browser and e-mail messages that are displayed in your mail program. EagleFiler has specialized
importing and viewing support for the following types of files:

• AudioNote18 documents.

• Bean19 documents.

• Bookmark (.webloc and .url) files and bookmarks dragged from Safari20 and OmniWeb21.

• Chat transcripts from Messages22 and iChat.
17http://www.shirt-pocket.com/SuperDuper/SuperDuperDescription.html
18http://luminantsoftware.com
19http://www.bean-osx.com
20http://www.apple.com/macosx/features/safari/
21http://www.omnigroup.com/applications/omniweb/
22http://www.apple.com/osx/apps/#messages
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• Dragged text from other applications. In some cases, EagleFiler will be able to import more
information if you drag the text onto one of its windows rather than its Dock icon. For
example, when dragging text from Safari, EagleFiler will be able to store URL that goes with
the text.

• Folders. EagleFiler imports the contents of the folder (and any subfolders, preserving the
hierarchy).

• HTML files.

• iCalendar (.ics) files.

• Images.

• Keynote presentations. (For best results, set Keynote to Include preview in document.)

• Mailboxes in mbox format, Apple Mail mailboxes (attachments included), and Apple Mail
archive mailboxes. The Importing Mail section explains the recommended ways to import
mail messages from each e-mail program.

• Mail messages, stored as .eml files.

• Microsoft Word files.

• Movies.

• Numbers spreadsheets. (For best results, set Numbers to Include preview in document.)

• OpenDocument Text files.

• Pages documents. (For best results, set Pages to Include preview in document.)

• PDF files. EagleFiler also understands PDFD bundles created by Skim23 and can display
and index Skim notes that are attached to PDF or PDFD files.

• PostScript and EPS files.

• Property list files (XML and binary).

• Rich Text (RTF and RTFD) files.

• RSS mailbox folders from Apple Mail.

• Sounds and music.

• Text files (encoded with ASCII or UTF-8, or with a byte-order-mark) and text clippings.

• URLs, which will be downloaded and converted to Web archives.

• vCard (.vcf) files from Contacts.

• Web archives.
23http://skim-app.sourceforge.net
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Documents that aren’t of any of the above types can also be imported into EagleFiler. EagleFiler
can preview their contents using Quick Look, and it uses Spotlight’s importers to index them for
searching. You can use the Open With External Viewer command to open the documents in other
applications.

When importing files, EagleFiler automatically imports tags from the Spotlight comments and
extended attributes.

3.4 Ways to Import

Many ways to get your files and data into EagleFiler are described in the sections below and in the
Importing Mail section.

Capturing

Usually, the easiest way to import from another application is to press the capture key or the
capture with options key. EagleFiler will automatically determine what you have selected or what
you’re viewing in the current application, and it will import it into the library. For example, if
you’re looking at a Web page in Safari, you can press the capture key to import it as a Web archive.
Press the capture with options key if you want to import it and, at the same time, assign tags or
choose which folder it will go into. The Applications That Support Capture section describes which
applications you can capture from and what will be imported.

Asking for Options

Normally, EagleFiler imports into the top level of the library (Unfiled) and assigns the “unread”
tag. In general, you can hold down the Option key when importing to have EagleFiler show you
the options window. From there, you can choose which folder to import into, and you can change
the tags, label, notes, and other metadata right at the time of import.

Multiple Libraries

If more than one library is open (and you didn’t drag into a specific library’s window), EagleFiler
assumes that you meant to import into the current library (the one with the frontmost window).
If no library is open, EagleFiler will show a dialog asking you to open one; then you can click the
Import button to import the files into that library.

3.4.1 Importing Existing Files

If your data is already saved as a file, there are several methods for moving or copying it into an
EagleFiler library:

Moving Files Into the Library
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In the Finder, you can drag and drop to move files into the To Import folder or the Files folder.

Copy Files Into the Library

• Drag and drop onto the source list, records list, Drop Pad, or Dock icon.

• Select files in another application and invoke one of EagleFiler’s Services via a menu or
keyboard shortcut.

• Choose Import Files. . . from the File menu.

• In the Finder, Option-drag to copy into the the To Import folder or the Files folder.

• Drag and drop files from one EagleFiler library window to another.

• Control-click on a file in the Finder and choose Open With . EagleFiler.

• Run an AppleScript such as:

tell application "EagleFiler"
import files {POSIX file "/Users/mjt/Desktop/MyFile"}

end tell

3.4.2 Importing Web Pages and URLs

• Press a capture hotkey, as described in the Ways to Import section.

• Choose Import URLs. . . or Import Bookmarks. . . from the File menu.

• Click on one of the EagleFiler bookmarklets24 in your Web browser’s toolbar.

• Drag and drop URLs onto the source list, records list, Drop Pad, or Dock icon.

• Select a URL in another application and invoke one of EagleFiler’s Services via a menu or
keyboard shortcut.

• Run an AppleScript such as:

tell application "EagleFiler"
import URLs {"http://www.apple.com", "http://c-command.com"}

end tell

The Web page format preference lets you choose whether EagleFiler saves URLs as Web archives,
PDF files, bookmarks, etc.

Private Web Pages
24http://c-command.com/eaglefiler/bookmarklets
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Some Web pages, such as order confirmation pages or account information screens, can only be
loaded when you’re logged into the site. EagleFiler cannot share the login session with your browser,
so if you’re logged in via Safari you would need to save the page using Safari. There are two says
to do this:

• Choose File . Print in Safari and then choose Save PDF to EagleFiler from the PDF
button menu. This will convert the page to PDF format and import it into EagleFiler. (If
you have the Mac App Store version of EagleFiler, see Installing EagleFiler for how to install
the PDF service.)

• Choose File . Save As in Safari and then choose the Web Archive format and save the
file into your library’s the To Import folder or the Files folder.

Similar techniques work in other Web browsers.

Processing Web Pages

Before saving from a Web browser into the To Import folder or the Files folder, you can reformat
the page using a JavaScript bookmarklet such as Readability25.

You can also set EagleFiler to automatically process every Web page that it downloads. For
example, to process every page using the Instapaper Mobilizer26, enter this command in Terminal:

defaults write com.c-command.EagleFiler WebToolURLProcessingPrefix ’http://www.instapaper.com/m?u=’

To turn off processing, enter this command in Terminal:

defaults delete com.c-command.EagleFiler WebToolURLProcessingPrefix

3.4.3 Importing Text Snippets

• Press the Quick entry hotkey and paste or begin typing.

• Select text in another application and invoke one of EagleFiler’s Services via a menu or
keyboard shortcut.

• Drag and drop text onto the source list, records list, Drop Pad, or Dock icon.

• Put some text on the clipboard using Edit . Copy and then choose Import Clipboard
from EagleFiler’s Dock menu or New Record . From Clipboard from the File menu.

25http://lab.arc90.com/experiments/readability/
26http://mobilizer.instapaper.com/m
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• Install some AppleScript files so that you can import directly from LaunchBar27 or Quicksil-
ver28.

• Run an AppleScript such as:

tell application "EagleFiler"
import text "Create an RTF file."
import plain text "Create a plain text file."

end tell

3.4.4 Importing From a Scanner

If you use a scanner (e.g. the Fujitsu ScanSnap) to digitize paper documents, you can set the scanner
software to use the To Import folder or the Files folder as its output folder. Then EagleFiler will
automatically import the scans into your library.

See also:

• How can I run optical character recognition (OCR) on my PDFs?.

• The Import From Scanner29 script.

• The OCR With PDFpen30 script.

3.4.5 The To Import Folder

The To Import folder is in the library folder, next to the .eflibrary file in the Finder. When the
library is opened (and, periodically, while it’s open) EagleFiler checks this folder, imports any files
that are in it, and then deletes them. You can add files to the To Import folder even if EagleFiler
is not currently running.

You may wish to drag the To Import folder to your Dock or to the Finder’s sidebar so that it’s
easy to find.

EagleFiler not import files in the To Import folder that are open or busy. This prevents it from
importing partial files that have not been completely written to disk.

If Allow duplicate files in library is unchecked, EagleFiler will move any duplicate files in the To
Import folder into the Unable to Import folder.

27http://c-command.com/scripts/eaglefiler/launchbar-import-text
28http://c-command.com/scripts/eaglefiler/quicksilver-import-text
29http://c-command.com/scripts/eaglefiler/import-from-scanner
30http://c-command.com/scripts/eaglefiler/ocr-with-pdfpen
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Do not copy folders into the To Import folder, as this may take a while and EagleFiler may start
importing before the copy is complete.

3.4.6 The Files Folder

The Files folder is in the library folder, next to the .eflibrary file in the Finder. As with the The
To Import Folder, you can import files by moving or saving them directly into the Files folder.
There are a few differences, however:

• You can save into any subfolder of the Files folder.

• You can put new folders into the Files folder.

• EagleFiler ignores the Allow duplicate files in library setting. When you add to the Files
folder, you are specifically adding to the library’s hierarchy, so EagleFiler does not check for
duplicates.

• The files appear in the EagleFiler window when EagleFiler does a Scan for New Files.

3.4.7 Services

When in other applications, the application menu contains a Services submenu. This is also
available when Control-clicking on selected text. The EagleFiler: Import service lets you import
the selected file, URL, or text into the current EagleFiler library. The EagleFiler: Import With
Options service is similar except that it lets you choose the destination library and folder and
assign tags and other metadata.

Enabling EagleFiler’s Services

After installing EagleFiler, you may have to log out and log in again in order for the services to
work. To make sure the services are enabled, open System Preferences, click on Keyboard, then
click on Keyboard Shortcuts. Click on Services in the list at the left, then look under the Text
section at the right and make sure there are checkmarks next to the EagleFiler items.

Keyboard Shortcuts

By default, the keyboard shortcut for EagleFiler: Import is Command%, and the keyboard
shortcut for EagleFiler: Import With Options is Command-Option-%. You can customize the
keyboard shortcuts from the Keyboard pane (see above).
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3.5 Importing Mail

Importing mail into EagleFiler speeds up your mail program and backups, creates an efficient and
secure archive of your mail, and lets you organize and search mail messages alongside related files.
The recommended way to import mail varies depending on which mail program you’re using. Please
find the section below that corresponds to your mail program.

As described in the Basics section, you should not modify or delete the mail while EagleFiler is in
the midst of importing it.

Viewing Messages

EagleFiler has native support for viewing e-mail messages. There are two options in the The View
Menu for controlling how messages are displayed: Message . Plain Text and Message . Raw Source.
The plain text font and size can be set in the Preferences. You can use the Quick Look command
in the The Record Menu to preview attached images. The Reply to Message command lets you
resume a conversation by opening a new message in your e-mail program. You can also double-
click a message to open it in your e-mail program (e.g. to forward it or to access the attachments).
EagleFiler opens messages using Mac OS X’s default viewer for .eml files, which is normally Apple
Mail. To change the default viewer, use the Open With command.

What’s Imported

EagleFiler imports the entire raw source of the message, including the attachments and headers. In
other words, all the information is preserved; if desired, the messages can be imported back into the
mail program with full fidelity. (Exceptions: When importing from Eudora, EagleFiler imports the
message text as processed and stored by Eudora, and it does not import the attachments, which
Eudora stores separately. Webmail messages imported as PDFs do not include the full source or
attachments.)

Copying and Deleting

As with other types of imports, EagleFiler copies the messages into its library. When it’s done, you
can delete the messages from your mail program. It’s simpler to have each message stored in only
one place (the mail program or EagleFiler), and this way you won’t accidentally import multiple
copies of the same messages into EagleFiler.

Mailbox (mbox) vs. Individual (.eml) Files

EagleFiler preferes to store messages in mailbox (“mbox”) files. This is both for efficiency (one file
rather than thousands for a mailbox containing thousands of messages) and for compatibility with
other software that can read the standard mbox format. When you capture multiple e-mails at
once, EagleFiler stores them in a mailbox file automatically.

If you prefer to store your messages as individual .eml files rather than mailboxes, you can drag
and drop the messages out of the mailboxes once they’re in EagleFiler. You can also import an
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individual message directly from Apple Mail via capture or drag and drop. Individual message files
can be combined into a mailbox via the Merge Message Files command.

Merging

Each time you import from a mailbox, a new mailbox file is created in EagleFiler, using the same
name as in your mail program. If you had previously imported from that mailbox, you may already
have a mailbox file in EagleFiler with that name.

• Some people like to leave each import as a separate mailbox, e.g. so that for each mailbox
there’s one file per month or per year.

• Others prefer to have a single file that holds all the messages imported from that mailbox
over time. To do this, select the Records source and sort by title. This will group the related
mailboxes together. You can then select the related mailboxes and use the Merge Mailboxes
command to combine them into a single mailbox. The combined mailbox will be stored in the
folder that contained the oldest of the selected mailboxes, so your organizational structure
is preserved even though the newly imported mailbox might have been imported at the top
level.

3.5.1 Importing Mail From Apple Mail

To import from Apple Mail, select some messages and press the capture key (F1 or fn-F1). Eagle-
Filer will preserve the message status and flagged indicators from Mail, as well as any keywords,
projects, and notes from MailTags31. EagleFiler is able to import messages from IMAP mailboxes,
however it will only import the parts of the messages that have been downloaded from the server.
Thus, it is recommended that you select the option in Mail’s preferences to keep All messages
and their attachments for offline viewing.

Importing Message Files

To import messages as individual .eml files instead of as mailbox files, capture one message at a
time or use the Import From Apple Mail script32.

Importing Mailbox Hierarchies

Another way to import from Apple Mail is to drag and drop folders or mailboxes from the Finder.
This makes it possible to import whole hierarchies of mail. The mailboxes are stored in the folder:

/Users/<username>/Library/Mail

31http://www.indev.ca/MailTags.html
32http://c-command.com/scripts/eaglefiler/import-from-apple-mail
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(To open the Library folder under Mac OS X 10.7 Lion, go to the Go menu in the Finder and
hold down the Option key.)

Importing Conversations

If you have View . Organize by Conversation checked, Mail behaves differently depending on
whether you have Use classic layout checked in the Viewing preferences.

With the classic layout, if you select a message with a blue triangle and the triangle is collapsed,
EagleFiler captures all the messages in the conversation from the selected mailbox(es). If the
triangle is expanded, EagleFiler captures only the messages that are selected in the message list,
even though more messages may be displayed in the message viewer.

• With the widescreen layout, if you select a message with a triangle, EagleFiler captures all
the messages in the conversation from the selected mailbox(es), regardless of whether the
triangle is expanded. (As with the classic layout, you can select individual messages indented
below the triangle if you only want to capture those.)

• To import both sides of a conversation, Command-click in the mailbox list to select the Sent
mailbox as well as the mailbox containing the received messages. Then Mail’s conversation
view will show both types of messages in the list. You may also find it helpful to use a
smart mailbox to display related messages from different mailboxes, and then capture from
the smart mailbox.

Importing an entire mailbox is much simpler. You can always use Edit . Select All to select all
the messages, regardless of whether Mail is in conversation mode or which triangles are expanded.

Archive Mailboxes

EagleFiler cannot directly import “archive mailboxes” that have been exported from Mail. For
better data fidelity it is recommended that you import the mailbox back into Mail and then capture
the messages from Mail to EagleFiler.

Capturing When Mail Is Busy

In order to safely read Apple Mail’s message data, EagleFiler makes sure that Mail is not in the
process of downloading messages from the server or moving them between mailboxes. You can open
the Activity window and wait until it’s empty to make sure that Mail is idle.

(The Activity window is a more accurate measure of this than the Mail Activity pane in Mail’s
main viewer window.) If you press the capture key and EagleFiler detects that Mail is busy, it will
suggest that you try again later. You can click Cancel and wait until Mail has finished downloading
mail or use the Mailbox menu to take it offline. You can also click Capture Anyway to proceed
if you know that Mail is not doing anything with the messages that you had asked it to capture.

Mail Perspectives
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If you have a Mail Perspectives33 window open (and it’s frontmost), EagleFiler will capture the
selected messages from that window, rather than from the regular viewer window.

3.5.2 Importing Mail From Entourage

To import from Entourage, select some messages (or a folder) and press the capture key (F1 or fn-
F1). EagleFiler will preserve the message flags, categories, and projects. EagleFiler skips messages
that have been assigned the “OmitFromArchive” category in Entourage.

To import from multiple folders at a time, use a saved search (a.k.a. custom view) to show messages
from multiple folders at once (for example, use “From Contains @” to show all messages), select
all the messages, and press the capture key.

Dragging individual mailboxes or messages from Entourage to EagleFiler may work, but using the
capture key is recommended because it is more reliable.

3.5.3 Importing Mail From Eudora

Mailboxes for Eudora 6 are stored in the Mail Folder folder inside the Eudora Folder folder,
and they can be dragged from the Finder into EagleFiler. They are not actually in mbox format
(for example, the attachments are removed), but the format is close enough that EagleFiler will be
able to read most of the messages. Running the mailboxes through Eudora Mailbox Cleaner34 or
Emailchemy35 before importing them into EagleFiler may produce better results. The .toc files
are not mailboxes and should not be imported.

33http://www.indev.ca/MailPerspectives.html
34http://homepage.mac.com/aamann/Eudora Mailbox Cleaner.html
35http://www.weirdkid.com/products/emailchemy/
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3.5.4 Importing Mail From GyazMail

Select some mailboxes and choose File . Export . Unix mbox. . .. Then drag the exported files
into EagleFiler.

3.5.5 Importing Mail From MailMate

You can import individual messages from MailMate by dragging and dropping them.

To import a whole mailbox, find its folder in the folder:

/Users/<username>/Library/Application Support/MailMate/Messages/IMAP/

and drag it into EagleFiler.

3.5.6 Importing Mail From Mailsmith

Select some mailboxes or messages and press the capture key. EagleFiler will preserve the notes
(as EagleFiler notes) and message status and label (as EagleFiler tags).

Note: If you want to separate messages by age before importing them into EagleFiler, you may
find it helpful to use Email Archiver36.

3.5.7 Importing Mail From Outlook

To import from Outlook, select some messages (or a folder and no messages) and press the capture
key (F1 or fn-F1). EagleFiler will preserve the message flags, read status, and categories. EagleFiler
skips messages that have been assigned the “OmitFromArchive” category in Outlook.

Note: Dragging individual mailboxes or messages from Outlook to EagleFiler may also work, but
using the capture key is recommended because it is more reliable.

Importing Message Files

To import messages as individual .eml files instead of as mailbox files, capture one message at a
time or use the Import From Outlook script37.

Importing All Your Mail
36http://www.garrison.com.au/freeware/emailarchiver.html
37http://c-command.com/scripts/eaglefiler/import-from-outlook
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To import all your mail at once, use a smart folder to show all the messages:

1. In the upper-right corner of the Outlook window, click in the search box. This will
make the Search tab active.

2. In the Search tab, select All Mail.

3. Then click the Advanced button.

4. Click on the Item Contains pop-up menu and change it to say Date Created. The
pop-up menu next to it should now say Any Date.

5. Click the Save button to create a new smart folder and name it All Mail.

6. With All Mail selected in the folder list, you can now use Edit . Select All to select
all of your messages at once and import them by pressing the capture key.

EagleFiler creates a mailbox file for each folder that you imported messages from. All the mailboxes
are created at the same level; if desired, you can create folders in EagleFiler to organize them.

Importing a Folder and Its Subfolders

To import from multiple folders at a time, use a smart folder to show messages from multiple folders
at once:

1. Select the folder in Outlook.

2. In the upper-right corner of the Outlook window, click in the search box. This will
make the Search tab active.

3. In the Search tab, select Subfolders.

4. Then click the Advanced button.

5. Click on the Item Contains pop-up menu and change it to say Date Created. The
pop-up menu next to it should now say Any Date.

6. Click the Save button to create a new smart folder and name it My Folder.
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7. With My Folder selected in the folder list, you can now use Edit . Select All to
select all of the messages at once and import them by pressing the capture key.

Importing PST Files

To import .pst files from the Windows version of Outlook, import them into the Mac version of
Outlook, then select the messages and press the capture key.

The Mac version of Outlook has an AppleScript bug that affects some messages imported from
Windows Outlook. This can prevent the message bodies from transferring to EagleFiler, making
the messages appear blank (aside from the headers). To work around this bug, instead of importing
via the capture key, import by dragging the mail folder (or individual messages) from Outlook to
a folder in the Finder; this will export the messages (but not the message flags, read status, or
categories). You can then drag the files from the Finder into EagleFiler to import them.

Another option is to one of the various Windows utilities that can convert from PST format to
Mbox format, and then to import the Mbox files into EagleFiler.

3.5.8 Importing Mail From Outspring Mail

The messages are stored in the folder:

/Users/<username>/Library/Application Support/Outspring Mail/

as individual .eml files. (To open the Library folder under Mac OS X 10.7 Lion, go to the Go
menu in the Finder and hold down the Option key.) They can be imported into EagleFiler via drag
and drop or by pressing the capture key in the Finder.

3.5.9 Importing Mail From Postbox

Importing Individual Messages

You can drag and drop the selected messages from Postbox to EagleFiler. You can also use the
File . Save As . File command to save a message in Mail Files format. Either way you will
end up with one .eml file per message in EagleFiler.

For large numbers of messages, EagleFiler will be faster if you merge the .eml files into a single
mailbox using the Merge Message Files command.

Importing Whole Mailboxes

Before importing into EagleFiler, make sure that Postbox has completely downloaded all the mes-
sages and use the Compact Folders command. The POP/local mailboxes are stored in the
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folder:

~/Library/Application Support/Postbox/Profiles/<profile>/Mail/Local Folders/

(To open the Library folder under Mac OS X 10.7 Lion, go to the Go menu in the Finder and
hold down the Option key.) The IMAP mailboxes are stored in the folder:

~/Library/Application Support/Postbox/Profiles/<profile>/ImapMail/

The mailbox files have no extension and can be dragged from the Finder to EagleFiler. The .msf
files are not mailboxes and can be ignored or deleted from EagleFiler’s library.

3.5.10 Importing Mail From PowerMail

Select some folders or messages and press the capture key. EagleFiler will preserve the message
status and label.

3.5.11 Importing Mail From Thunderbird and Eudora 8

To import an individual message from Thunderbird, select the message and choose File . Save
As . File. Save the .eml file into EagleFiler’s To Import folder.

To import whole mailboxes from Thunderbird, make sure that Thunderbird has completely down-
loaded all the messages and use the Compact Folders command. The POP/local mailboxes are
stored in the folder:

/Users/<username>/Library/Thunderbird/Profiles/<profile>/Mail/Local Folders/

(To open the Library folder under Mac OS X 10.7 Lion, go to the Go menu in the Finder and
hold down the Option key.) The IMAP mailboxes are stored in the folder:

/Users/<username>/Library/Thunderbird/Profiles/<profile>/ImapMail/

The mailbox files have no extension and can be dragged from the Finder to EagleFiler. The .msf
files are not mailboxes and can be ignored or deleted from EagleFiler’s library.

To import an individual message from Thunderbird, use the File . Save As . File command to
save the message in Mail Files (.eml) format.

35



3.5.12 Importing Mail From Webmail/Gmail

Web-based mail services do not store mail files on disk, so there is nothing for EagleFiler to read.
The best way to import Webmail is to connect to the mail account using one of the above mail
programs. If your Webmail does not support this, you can drag and drop text from your Web
browser, use File . Save to save messages into EagleFiler’s To Import folder, or print and choose
Save PDF to EagleFiler.

You can also import individual messages by saving their raw source to a .eml file. This has the
advantage of preserving the message’s attachments. In Gmail, this is possible with the Show
Original command.

3.6 Drag and Drop

This section summarizes the different ways that you can use drag and drop in EagleFiler:

Source List

Folders
Drag a folder or mailbox onto a folder to rearrange the folders in the source list. Drag
a file from the records list onto a folder to move it into that folder. Drag onto the
Records source to move the record to the top-level Files folder; it will then appear
under Unfiled.
Drag from another application onto a folder in order to import directly into that folder.
EagleFiler supports spring-loaded folders. If you drag and hover over a collapsed folder,
it will expand so that you can drag onto one of its subfolders.

Smart Folders
Drag a record onto a smart folder to apply the smart folder actions that you’ve set in
the Edit Smart Folder. . . window.
Drag and drop smart folders into folders to rearrange the source list.

Tags
EagleFiler supports hierarchical tags. Drag and drop tags to rearrange them in the
source list.
Drag records onto a tag to assign them that tag.
Drag from another application onto a tag in order to import the dragged items and then
assign that tag.

Records List

With a folder selected in the source list, drag onto the records list to move the records into
that folder (if dragging from another EagleFiler window) or to import into that folder (if
dragging from another application).
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Drag from the records list onto a folder or tag in the source list in order to move the records
or assign that tag.

Drag to the Finder to create copy the files from EagleFiler.

Drag to Terminal to enter the file’s path.

Drag to a text view in another application to create links to the selected records.

Record Viewer

You can drag and drop text and images to/from other applications as normal.

Notes

You can drag and drop text and images to/from other applications as normal.

Drop Pad and Dock

Drag from another application onto EagleFiler’s Drop Pad window or Dock icon to import
into the current library.

When dragging from another application, you can drag files, URLs, or text to import them into
EagleFiler.

3.7 Shortcuts

This section summarizes EagleFiler’s built-in keyboard shortcuts. Many other keyboard shortcuts
are available in the menus, and you can search the menu commands using the Search field in the
Help menu. You can customize the keyboard shortcuts from the Keyboard pane in System
Preferences.

Importing

F1
Capture Key. (Depending on your settings in System Preferences, you may need to press
fn-F1.)

Option-F1
Capture with options. (Depending on your settings in System Preferences, you may
need to press fn-Option-F1.)

Command-%
The “EagleFiler: Import” system service. Type this from another application to import
the selected text or URL into EagleFiler.

Command-Option-%
The “EagleFiler: Import With Options” system service. Type this from another ap-
plication to import the selected text or URL into EagleFiler. EagleFiler will show the
options window so that you can set the destination folder, label, tags, notes, etc.
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Batch Change

Shift-Command-A
Append.

Shift-Command-R
Replace.

Command-3
Choose label.

Enter or Command-Return
OK.

Capture With Options and Quick Entry

Command-1
Choose library.

Command-2
Choose folder. Then you can select a folder by typing the first few letters of its name.

Command-3
Choose label.

Command-K
Reset.

Enter or Command-Return
Capture or Save.

Command-{
Select the previous tab (Metadata, Source, Text).

Command-}
Select the next tab (Metadata, Source, Text).

Info inspector

Command-click title bar
Show a path menu for the file being inspected.

Command-I
Open the Info inspector and bring it to the front.

Command-Option-I
Open the Info inspector without bringing it to the front.

Tags inspector

Spacebar
Toggle whether the tag is assigned to the selected records.

Navigating browser windows
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Command-Option-F
Make the search field active.

Command-Shift-T
Make the tag bar active.

Tab (in source list) or Control-Shift-Tab (in record viewer)
Make the records list active.

Tab (in records list) or Shift-Tab (in source list)
Make the record viewer active.

Control-Tab (in record viewer) or Shift-Tab (in records list)
Make the source list active.

Editing a rich text file or notes

Option-Tab
Begin a new bulleted list.

Tab
Increase the indentation of the current list item.

Shift-Tab
Decrease the indentation of the current list item.

Records list

Enter or Return
Edit the filename of the selected record.

Option-Enter or Option-Return
Edit the title of the selected record.

Delete
Delete the selected records (if viewing multiple sources or a folder) or untag them (if
viewing a tag).

Option-Delete
Delete the selected records.

Command–Up Arrow
View the container of the current folder or mailbox (i.e. go up a level in the hierarchy).

Command–Down Arrow
View the contents of the selected folder or mailbox (i.e. go down a level in the hierarchy).

Down Arrow or Command-Control–Down Arrow
View the next record. Down Arrow works in the records list. Spacebar works in the
records list and in uneditable viewers. Command-Control–Down arrow works every-
where, even from an inspector window.

Up Arrow or Command-Control–Up Arrow
View the previous record.
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Left Arrow
Change the keyboard focus to the source list.

Double-click
Open a folder or mailbox in the same window, like Contents of Record, or open a file in
the external viewer.

Command-double-click
Open With External Viewer.

Option-double-click
Open Source URL.

Shift
Hold the Shift key while mousing over a record to see the tooltip faster. The tooltip
shows the path and source URL.

Spacebar
Quick Look

Option-Spacebar
Slideshow

Three-Finger Swipe Left
Select the previous record.

Three-Finger Swipe Right
Select the next record.

Source list

Left/Right Arrow
Collapse or expand the selected sources. If the selected source is already expanded and
you press Right Arrow, changes the keyboard focus to the records list and selects the
first record.

Option-Left/Right Arrow (or Option-click disclosure triangle)
Collapse or expand the selected sources and all their children.

Command-click
Select multiple sources at once.

Command–Up Arrow
Select the enclosing folder in the source list.

Double-click
Open in New Window.

Enter or Return
Edit the filename of the selected source.

Type-selection
Type the first few letters of a source’s name to select it.

Dragging from Source list or Records list
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Drag to Finder
Create a copy of the file.

Command-Option-Drag to Finder
Hold down before starting the drag to create an alias of the file.

Drag to an EagleFiler browser window
Copy the record to another library.

Drag to Terminal
Enter the file’s path.

Hiding

Option-click on another application
Switch to that application and hide EagleFiler. While hidden, EagleFiler will tem-
porarily show itself if you press the Capture with options key and then re-hide itself
automatically.

Option-click on an EagleFiler window
Bring EagleFiler to the front and hide the other applications.

Double-click on the horizontal split bar
Hide or show the record viewer.

Tags Bar

Command-Shift-T
Move the focus to the tags bar.

Spacebar, Return, or Comma
End the current tag so that you can begin typing the next one.

Tab
Move focus to the search field. Press Tab-Tab to move to the source list or Tab-Tab-Tab
to move to the records list.

Toolbar

Option-click New RTF
Creates a new plain text file.

Option-click Tags
Opens the Tag Cloud window.

Windows

Command-‘
Move focus to next window.

Command-Shift-‘
Move focus to previous window.
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4 Browser Windows

Each browser window contains a source list, a records list, a record viewer, and a toolbar. Drag
the split bars to resize the different portions of the window. Double-click a split bar to collapse it
entirely. Hold down the Option key while dragging a split bar to grow or shrink the window as you
drag.

You can use the Tab key to move between the different panes using the keyboard. When editing
in the record viewer, you may need to type Control-Tab rather than Tab (which will insert a tab
character into the document).

4.1 Source List

The top-level sources are:

Library

Records
All the records in the library, from all the folders (except the trash). Click the triangle
next to the Records source to expand it and see folder sources matching the folders
in the library’s Files folder in the Finder. You can drag and drop files and folders to
re-arrange their hierarchy.

Trash
The records that have been deleted from the library, but which are still available until
you empty the trash. This corresponds to the library’s Trash folder in the Finder.

Search For

Recently Added
The last 25 files that were added to the library.

Recently Modified
The last 25 files that were modified within EagleFiler or using another application.

Unfiled
Files that are at the top level of the library, e.g. ones that are directly in the Files
folder rather than in one of its sub-folders. For example, if you like to categorize all your
files into subfolders, Unfiled shows you all the files remaining to be categorized.

Untagged
Files anywhere in the library that do not have any tags (other than “note”).

Tags

Tag sources behave like playlists in iTunes or albums in iPhoto. Select a tag source to view
all the records with that tag. You can drag records onto a tag source to assign that tag to
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them. Each record may appear in any number of tag sources. Deleting a record from a tag
source unassigns that tag; the record remains in the library. You can drag and drop tags to
re-arrange their hierarchy.

Selecting Multiple Sources

You can select more than one source at a time to view all their contents at once or to winnow by
tag. For example:

• To see all the messages in either of two mailboxes, select both mailboxes at once.

• To see all the flagged files in a folder, select the folder and the flagged tag.

• To see all the records that are both flagged and unread, select both the flagged and unread
tags.

Importing via the Source List

Drag files here to import them. You can drop onto a folder or tag source to import files directly
into that folder or to import them and assign that tag. You can use Exposé mid-drag to bring a
window to the front and reveal the source that you want to drop onto.

Navigating

You can type the first few letters of a source’s name to select it. See also the collapsing and
expanding Shortcuts.

Hiding and Showing

To hide and show the source list, you can use the Show . Source List command in The View Menu.
You can also drag or double-click the divider.

Renaming

With a source selected, press Return or Enter to edit its name.

Custom Folder Icons

You can customize folder icons in the source list. First copy an image to the clipboard (e.g. using
Preview). Then Control-click on a source and choose Paste Icon.
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4.2 Records List

The records list shows the contents of the selected source(s). If a folder or tag is the selected source,
you can drag files into the records list to import them with that folder or tag.

The columns are:

Tags

The abbreviations for the assigned tags (e.g. • for unread).

Count (#)

The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Icon

An icon that shows the record’s type.

Title

The subject of a message or title of a document. For most document types, the title is separate
from the filename, e.g. it’s set in the Properties window in TextEdit and in Microsoft Word.
If the title is blank, this column shows the filename.

From

The sender of a message, author of a document, or domain of a Web page.

To

The recipient of a message or document.

Date Modified

The date the record’s contents was modified. For a file, this is the file’s modification date.
For a message, this is when the message was received.

Date Added

The date the record’s file was added to the library.

Date Created

The date the record’s file was created. For a message, this is when the message was received.
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Size

The amount of disk space used by the record.

File

The name of the file containing the record.

Kind

The type of the record.

Label

The Finder label of the record’s file.

Container

The name of the folder or mailbox that the record is inside.

Tag Names

The full names of the assigned tags.

Source URL

The URL where the file was downloaded from.

Notes

The record’s note text.

•
Whether the record has the “unread” tag.

.

Whether the record has the “flagged” tag.

Drag and drop the column headers to change their order. Click the 5 or Control-click on a column
header to choose which columns are visible.

You can type the first few letters of a record’s title to select it. Double-clicking a folder or mailbox
in the list opens it in the same window. Double-clicking a file is equivalent to choosing Open With
External Viewer. Option-double-clicking is equivalent to choosing Open Source URL. Press Enter
(or Return) to rename the selected file or Option-Enter (or Option-Return) to change its title.

4.3 Record Viewer

The record viewer shows the contents of the selected file or e-mail message. Text, RTF, and RTFD
files can be edited directly in the viewer. EagleFiler automatically saves your changes to disk, and
it supports standard features such as spell-checking, find/replace, and text-to-speech.
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EagleFiler knows how to display many different kinds of files. If it does not natively understand a
file’s format, EagleFiler uses Quick Look to display a preview of the file.

There is also a tags bar at the bottom of the viewer for assigning or unassigning the tags of the
current item.

While the record viewer has focus, you can press Command-Delete to delete the current record(s).

Control-click on a selected word or phrase to set that phrase as the tag, filename, from, or title.

To hide and show the record viewer, you can use the Show . Record Viewer command in The View
Menu or drag or double-click the divider.
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4.4 Searching

The search box lets you filter the records of the selected sources to display only those records that
match the search criteria. After searching, the query is automatically entered into the Find panel
so that you can search within the current record in the Record Viewer, e.g. using Find . Find
Next/Previous.

Search Scope

When you have the Records source selected, EagleFiler searches the entire library. This will
include or not include e-mail messages depending on whether Show . Messages in Records Source
is checked.

When a folder or tag is selected, EagleFiler displays and searches only the contents of that folder or
the records with that tag. If Search Contained Folders/Mailboxes/Tags is checked, EagleFiler
searches all the folders and mailboxes inside the folder, or the subtags of the tag; otherwise, it
searches only the top level.

Indexed Searches

There are two kinds of indexed searches:
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Anywhere

Searches the contents of the records, as well as the Title, From, To, Cc, attachment names, and
notes. Also searches for records whose tags exactly match the query (ignoring the enhanced
syntax below).

Notes

Searches the notes of the records.

These support an enhanced query syntax:

&, AND

Boolean AND. The <space> character also represents a Boolean AND.

|, OR

Boolean inclusive OR.

!, -

Boolean NOT. For example, apple -orange finds records that contain apple and do not
contain orange.

(, )

Opening and closing delimiters for logical grouping. For example, (apple AND orange) OR
(apple AND pear) finds records that contain apple and another fruit, but not ones that
contain only apple.

"

Opening and closing delimiter for phrase-based searching. Phrase-based searches find records
that contain all of the words in sequence. Non-word characters inside the quotes are treated
as word separators and thus do not need to appear in the match.

*

Wildcard for prefix or suffix. Ignored in phrase-based searches. To search for a partial word,
use two *’s, e.g. *ant* will find ant, repellant, anthem, and words with ant in the middle.
If Match Partial Words is checked, EagleFiler will find partial word matches without your
having to type the wildcards each time.

Examples:

1. Searching for "IDP policy" "commit fails" finds records containing the two phrases
IDP policy and commit fails (since the space implies AND).

2. Searching for tech lead !"tech lead" finds records containing both tech and lead
but not those two words in sequence.
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3. Searching for "ProductVersion 1.2" finds records containing the word ProductVersion
followed by the word 1 and then the word 2. This includes records containing ProductVersion
1 2 as well as ProductVersion=1.2, because the = and . are considered to be word
separator characters for indexed searches.

Exact Searches

There are also five kinds of exact (though case- and diacritic-insensitive) searches:

Filename

Searches the filenames as displayed in the records list.

From

Searches both the names and e-mail addresses.

Tags

Finds records that have the specified tag names. If Match Partial Words is not selected,
tag searching is exact, so you must type the complete tag names (with the proper case). You
can put - or ! before a tag name to find records that don’t have that tag. (Because those
characters have special meaning, it’s best not to use them in the names of your tags.)

Example: Searching for unread -flagged will find the records that are unread but not
flagged.

To/Cc

Searches both the names and e-mail addresses.

Title

Searches record titles and message subjects.

Tag Searches

For both indexed and exact searches, you can restrict a search to records with certain tags by adding
tag:<tagname> at the beginning of the query. (This syntax is not available in smart folders; there
you should create a separate Tags criterion.) The search will then match only the records with all
of those tags.

Examples:

1. Searching for tag:apple steve means to search for steve and show only the records
with the apple tag.

2. Searching for tag:-apple steve means to search for steve and show only the records
without the apple tag.
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3. Searching for tag:mac tag:ipod halo !bungie means to find all the records that in-
clude the word halo, do not include the word bungie, and have both the mac and ipod
tags.

Complex Searches

To perform complex searches with multiple criteria, use the New Smart Folder. . . command.

5 Menus

5.1 The EagleFiler Menu

5.1.1 About EagleFiler

The About EagleFiler window shows the credits, as well as download and support information.

You can always download the latest version of EagleFiler from the EagleFiler Web site38.

Questions about EagleFiler may be sent to eaglefiler@c-command.com39. We’re always looking to
improve EagleFiler, so please feel free to send any feature requests to that address.

To make sure that you have the latest version of EagleFiler, you can use the Software Update. . .
command.

5.1.2 Software Update. . .

Checking For Updates

Click the Check Now button, and EagleFiler will tell you whether a newer version is available for
download. By default, EagleFiler will automatically check for new versions each time it is launched
and once per day. You can disable this feature by unchecking the checkbox.

Updating

If a new version is available, EagleFiler will tell you what’s new in that version. Click Download
to have EagleFiler download the .dmg file for the new version to your downloads folder. Click
Download & Install to have it download the .dmg and then update the installed EagleFiler
application to the new version.

Passwords
38http://c-command.com/eaglefiler/
39mailto:eaglefiler@c-command.com
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In order to properly install the new version, you may need to enter your Mac’s administrator
username and password. The username and password for the automatic software update are the
ones for logging into your Mac. They’re not related to EagleFiler. If you don’t know your username
and password, you can still update manually by downloading from the EagleFiler Web site40 and
following the instructions in the Read Me file. Or, you can reset your Mac’s password41.

Privacy

To check for a new version, EagleFiler contacts a Web server at c-command.com. EagleFiler trans-
mits the following information to the server: the name of the product (EagleFiler) and its version,
the version of Mac OS X, the kind of processor that the Mac has, whether EagleFiler has been
purchased, the values of certain esoteric preferences, and the name of the current language. This
information is used to guide future development. No personal information is transmitted.

Mac App Store

If you purchased DropDMG or EagleFiler via the Mac App Store, the Software Update. . . menu
command is not present, and updates are available via the App Store application.

5.1.3 Purchase. . .

This window lets you buy EagleFiler. To purchase, choose Purchase. . . from the EagleFiler
menu. You can use the Purchase Online button to enter the online store42.

Trial/Demo Period

EagleFiler has a free trial period that lasts for 30 days. (After the 30 days, if you haven’t had
a chance to use EagleFiler very much, you can continue using it for up to a total of 7 launches.)
During the trial period, EagleFiler is fully functional; the only difference in behavior is that it will
periodically remind you that you are using the trial. To use EagleFiler beyond the trial period,
you must purchase it. This entitles you to free updates and support.

After Purchasing

Soon after paying, you’ll receive an e-mail with your serial number. Enter the name and serial
number from the e-mail into the Purchase window and click Personalize. You do not have to
“install the purchased version”; rather, EagleFiler will then know that you have purchased and
you can keep using it as before—with all the preferences that you had set and data that you had
entered.

Reinstalling a Previous Purchase
40http://c-command.com/eaglefiler/
41http://support.apple.com/kb/HT1274?viewlocale=en US&locale=en US
42http://c-command.com/store/
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If you need to re-install EagleFiler, you can simply re-enter your name and serial number and click
Personalize; there’s no need to purchase again.

If you cannot find your serial number, click the Look Up My Serial Number button. This will
open a form where you can enter your e-mail address and look up your order information.

License Information

A license for EagleFiler is good for one person or one computer. This means that you can use it on
your desktop Mac and your laptop, or you and your family can use it (in separate user accounts) on
a shared Mac. If there are multiple users on multiple Macs, you should purchase multiple licenses.
Discounts for packs of 2, 10, and 50 licenses are available above. A family (all living in the same
household) can share a 2-user license.

Upgrade Policy

All maintenance releases (1.0.1, 1.0.2, 1.6.1, etc.) and minor feature updates (1.1, 1.2, 1.5, etc.)
are free. We have a track record of many such updates, and they have included significant new
features. Major upgrades (2.0, 3.0) are free if you purchased the previous version within the last
six months. If you purchased longer ago than that, you get a 50% discount. (Note: The upgrade
discounts are only available if you originally purchased direct from C-Command, since the Mac
App Store does not support upgrades.)

Mac App Store

The Purchase. . . menu command is not present if you purchased via the Mac App Store. In that
case, there is no trial period, and licensing is based on your iTunes account rather than the number
of people or computers.

5.1.4 Mac App Store

EagleFiler is available from the Mac App Store43 as well as direct from C-Command44.

It’s Your Choice

We’re happy wherever you choose to purchase our software. The Mac App Store makes it very
convenient to buy, download, and install, and you get updates via the store. The purchase is tied
to your iTunes account. If you buy direct, you drag-and-drop to install and get updates via the
application’s auto-updater or the Web site. Either way, you can sign up for the EagleFiler News
mailing list45 or the EagleFiler RSS feed46 to be notified about new versions and important product
news.

43http://www.apple.com/osx/apps/app-store.html
44http://c-command.com/store/
45http://c-command.com/eaglefiler/support
46http://c-command.com/blog/category/eaglefiler/feed
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Prices

Pricing is substantially the same, although there will be slight differences due to Apple’s pricing
tiers and currency conversions. All Mac App Store purchases are for single-user licenses. Purchasing
direct, you can also buy family packs and get volume and educational discounts. Although you pay
the same price, Apple’s higher fees mean that direct purchases send 25+% more of your money to
C-Command.

Trials

EagleFiler has a fully-featured 30-day trial version that’s available from the Web site. If you
purchase direct, you can click a link in your order confirmation to enter your serial number and
take it out of trial mode. If you purchase from the Mac App Store, you should first delete your
trial version so that the store doesn’t see EagleFiler as already installed. Your preferences and user
data will be seamlessly shared between both versions.

Updates and Upgrades

Our standard policy has been to provide customers lots of free minor updates and 50% discounts
on major upgrades. The Mac App Store does not support upgrade pricing, so currently we can
only guarantee the 50% discount if you originally purchased direct from C-Command. We’ll do the
best we can, however, and Apple may make more options available in the future.

Updates to EagleFiler will be available from the Mac App Store sometime after they are available
direct from C-Command. This is delay is due to Apple’s review process, which has historically
taken anywhere from a few days to a few weeks.

Transfers

If you purchase via the Mac App Store, the direct version will recognize your receipt from Apple. So
(barring changes in the way Apple handles receipts) you’ll always have the option of downloading
the software yourself to get the full features and the latest updates. Apple, unfortunately, provides
no way to transfer purchases in the other direction, for existing customers who would prefer to
receive updates via the Mac App Store.

Feature Differences

We intend the Mac App Store and direct versions of EagleFiler to be as similar as possible, however
some differences are necessary in order to comply with the rules for Apple’s store. Our first priority
is to design the direct version as best we know how; it should not be limited by Mac App Store
considerations. Secondly, if a feature cannot be accepted in the Mac App Store, we will try to
adapt it or make it available in another way. This may not always be possible or practical, however.
Additionally, the Mac App Store rules are subject to change, and so EagleFiler will change with
them.

Here are the current differences between the Mac App Store and direct versions:
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• The direct version automatically adds a Save PDF to EagleFiler command to each ap-
plication’s Print dialog. With the Mac App Store version, you can install the PDF service
manually.

• The direct version uses OpenMeta47 to share your recently used tags with other applications.
The Mac App Store version can read the list of recent tags but cannot update it.

• It is likely that, in a future version, the Mac App Store version will not be able to create
encrypted libraries.

5.2 The File Menu

5.2.1 New Library. . .

Creates a new library. Double-click the .eflibrary file to open the library in EagleFiler. You can
move the library folder around in the Finder, so long as it isn’t currently open in EagleFiler.

See also:

• How can I encrypt my files?

• How can I access my library from multiple Macs?

5.2.2 New Record . Rich Text File

Creates a new, empty RTF or RTFD file inside the selected source.

If the File column is visible and editing is enabled, EagleFiler brings the filename into edit mode
so that you can set the name of the newly created file. When you’re done, press Tab or click in the
viewer to begin entering the contents of the file. If the File column is hidden or editing is disabled,
EagleFiler opens a sheet that lets you enter the name of the new file.

5.2.3 New Record . Plain Text File

Creates a new, empty plain text (UTF-8) file inside the selected source. Plain text files are easier
to edit on iOS devices.

If the File column is visible and editing is enabled, EagleFiler brings the filename into edit mode
so that you can set the name of the newly created file. When you’re done, press Tab or click in the
viewer to begin entering the contents of the file.

47http://code.google.com/p/openmeta/
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If the File column is hidden or editing is disabled, EagleFiler opens a sheet that lets you enter the
name of the new file. If you enter a name containing an extension, EagleFiler uses that; otherwise,
it adds .txt as the file extension.

5.2.4 New Record . From Clipboard

Creates a new RTF, RTFD, or PNG file inside the selected source. The content of the file is taken
from the clipboard. In a way, you are creating a new file in EagleFiler by “pasting,” and the
keyboard shortcut of Command-Shift-V reflects this.

You can use the PrefersRichText esoteric preference to set EagleFiler to create plain text files
instead.

5.2.5 New Record . Open Stationery Folder

The stationery feature lets you create any type of new file from within EagleFiler. Whichever files
you put in the Stationery folder become available as templates in the File . New Record menu
and in the toolbar. You can also put whole folder hierarchies in the Stationery folder, e.g. if you
often need to create subfolders with a particular structure.

Choose Open Stationery Folder to have EagleFiler open the Stationery folder in the Finder.
This makes it easy to add new stationery files.

Keyboard Shortcuts

You can assign keyboard shortcuts for them from the Keyboard pane in System Preferences. Click
on Application Shortcuts and then click the + button to add your own shortcut.

Setting Stationery Metadata

You can edit the stationery file in the Finder in order to control the metadata that EagleFiler
assigns when creating a new record from the stationery. For example, you can assign a label or
add Spotlight comments. The new record will have the same label as the stationery file, and the
Spotlight comments will control the tags and notes.

For example, to set the tags to “journal” and “draft” and the note to “This is the note.”, set the
Spotlight comments to:

&journal &draft This is a note.

The Writing Stationery Scripts section describes how you can use AppleScript to create even more
powerful stationery items.
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5.2.6 New Folder. . .

Creates a new folder in the source list of the current library. You can set a custom icon for the
folder by selecting it in the Finder, choosing File . Get Info, clicking on the icon, and pasting
your own image.

If a smart folder is selected, creates a folder for holding smart folders rather than a folder for holding
files.

5.2.7 New Tag

Creates a new tag and selects it in the source list. If records are selected, they are assigned the
new tag. If a tag is selected, the new tag becomes a subtag of that tag. You can drag and drop
tags to re-arrange their hierarchy.

5.2.8 New Browser Window

Creates an additional browser window for viewing the contents of the current library.

5.2.9 New Smart Folder. . .

A smart folder is like a saved search; it shows shows records in the library that match certain criteria.
EagleFiler has four built-in smart folders: Recently Added, Recently Modified, Unfiled, and
Untagged. This command lets you create your own smart folders.

You can organize smart folders into folders. To do this, select a smart folder and choose New
Folder. . .. Then re-arrange the smart folders using drag and drop.

5.2.10 Edit Smart Folder. . .

Conditions

The Conditions tab lets you set the criteria that determine which records are shown in the
smart folder.
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Search Scope

Search inside
This pop-up menu lets you select a folder, a mailbox, or the entire library to deter-
mine which records the smart folder can display.

subfolders
If this is checked, EagleFiler searches the entire contents of the folder or library. If
it’s unchecked, it only searches the first level of files in the folder.

mailboxes
If this is checked, when EagleFiler encounters a mailbox it searches the messages
inside of it. If you don’t need to search the messages, unchecking this will make the
search go faster.

Adding and Removing Criteria
Now that you’ve chosen which records EagleFiler will search, you can create an unlimited
number of criteria to narrow down the results. Click + to add a criterion or - to remove
one. You can drag and drop to re-arrange the criteria.

Nested Criteria
Option-click + to add a new Any/All/None grouping of criteria (i.e. for nested Boolean
conditions).

The Available Criteria

Anywhere
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Searches the contents of the records, as well as the Title, From, To, Cc, attachment
names, and notes (but not tags). The detailed search options are described in the
Searching section.

From
The names and e-mail addresses.

To/Cc
The names and e-mail addresses.

Title
Record titles and message subjects.

Count
The number of pages in a PDF, messages in a mailbox, or attachments in a message.

Source URL
The URL that a record was downloaded from.

Label
The Finder label of the record’s file.

Notes
The notes, set in the Info inspector.

Tags
The full names of the assigned tags.

Filename
Searches the filenames as displayed in the records list.

Size
The amount of disk space used by the record.

Kind
The type of the record, as shown in the records list.

Container name
The name of the folder or mailbox that the record is inside.

Date added
The date the record was added to the library.

Date created
The date the record’s file was created.

Date modified
The date the record’s contents was modified. For a file, this is the file’s modification
date. For a message, this is when the message was received.

Every record
This is useful when combined with subfolders and mailboxes. When you click
on a folder in the source list, EagleFiler shows only the immediate contents of the
folder. If you create a smart folder using Every record, EagleFiler will show the
contents of the folder and of its subfolders.

Actions

The Actions tab lets you control what happens when you drag a record onto the smart folder
or create a new file while the smart folder is selected. Actions can add tags, remove tags, set
the label, or move the records to a folder.
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5.2.11 Open Library. . .

Opens a .eflibrary file, letting you view the library in EagleFiler.

To open an encrypted library, first double-click its .sparsebundle or .sparseimage file in the
Finder and enter your passphrase. Then you will be able to see the .eflibrary file and open it in
EagleFiler. For quick access, you can also drag the .eflibrary file to the Dock or create an alias.

Rebuilding a Library

If you hold down the Command and Option keys when opening a library, EagleFiler will show
the Rebuild Indexes dialog. Rebuilding increases the speed of Anywhere and Notes searches,
compacts the index, and repairs any damage to it. For example, you might want to rebuild the
indexes if you’ve deleted a lot of files from the library, or if an Anywhere or Notes search is not
finding a record that you think should be in the index.

Indexing Preferences

When rebuilding an index you can choose whether EagleFiler should index words or phrases. In-
dexing for word searches is much faster, but searching for multiple words will find all the documents
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that contain those words anywhere in the document. Indexing for phrase searches lets you search
for a group of words that appear near each other in a document, however indexing will take longer
and the index files will be several times as large.

Skipping Initial Operations

When you open a library, EagleFiler will automatically verify that all of the files are present, backup
the metadata, copy the tags to OpenMeta, and copy the tags to the Spotlight comments (if you’ve
selected that option). To skip these operations, hold down the Shift key when opening the library.

5.2.12 Close & Lock

Closes an encrypted library and ejects its disk image. Accessing the library again will require its
passphrase.

5.2.13 Scan for New Files

An easy way to add new files to your EagleFiler library is to save new files (or move existing files)
directly into the Files folder in the library folder. When EagleFiler scans the library folder, it
will import the new files in-place (without copying them) and assign tags and notes based on the
Spotlight comments and OpenMeta. When importing in this manner, EagleFiler does not skip
duplicate files; any file that you specifically add to the library folder will stay there.

EagleFiler scans the Files folder for new files when you open the library. In this way, files added
since the last session will be auto-imported. Unlike with the To Import folder, EagleFiler does
not automatically scan the Files folder for new files once the library is open. This is to prevent
accidentally importing files (or packages) that are in the midst of being saved, which could lead to
duplicate files or data corruption. Instead, you can manually trigger a scan at an opportune time
(i.e. when you are not in the midst of copying or saving new files) by choosing Scan for New
Files from the File menu or by invoking that command via AppleScript.

There may be cases where you want to prevent certain files from being auto-imported by a scan.
To hide the contents of a folder from EagleFiler, assign it the ef unscanned tag. This will let you
store files in that folder in the Finder, without having EagleFiler detect them, import them, and
clutter up its window.

You can also use the UnscannedExtensions default to make the scan ignore files and folders of
certain types inside of an already-imported folder. For example, to prevent EagleFiler’s scan from
picking up temporary files generated by LaTeX, you could type this command into Terminal:

defaults write com.c-command.EagleFiler UnscannedExtensions -array aux out toc

You can also use the UnscannedFilenames default to make the scan ignore files and folders with a
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certain name inside of an already-imported folder. For example, to prevent EagleFiler’s scan from
picking up ctags48 files named tags, you could type this command into Terminal:

defaults write com.c-command.EagleFiler UnscannedFilenames -array ’tags’

Changes take effect after relaunching EagleFiler.

You can disable automatic scans using the ScanForNewFilesOnOpen esoteric preference.

It is also possible to exclude certain filenames and extensions from indexing, to work around buggy
Spotlight importers. For example, this command will exclude the file foo.xls:

defaults write com.c-command.EagleFiler SpotlightImporterSkippedNames -array-add foo.xls

and this command will exclude all .xls files:

defaults write com.c-command.EagleFiler SpotlightImporterSkippedExtensions -array-add xls

5.2.14 Import Files. . .

Opens a sheet that lets you choose one or more files or folders to be imported into the current
library.

5.2.15 Import URLs. . .

Opens a sheet for importing one or more URLs into the current library, using the Web page format
chosen in the preferences. The text field will be pre-filled with the contents of the clipboard. If you
enter a URL that’s not for a Web page (e.g. the URL of a PDF or image file) EagleFiler imports
the file directly rather than converting it to a Web archive, PDF, etc.

5.2.16 Import Bookmarks. . .

EagleFiler can import Netscape-format HTML bookmarks files from the following products:

Delicious

Click on Settings and then Export / Backup Bookmarks.
48http://ctags.sourceforge.net
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Pinboard

Go to Pinboard’s export page49 and choose the option to export as HTML. Choose a filename
that ends with .html.

Safari

Choose Export Bookmarks. . . from the File menu.

The URLs will be imported using the chosen Web page format. EagleFiler will preserve the tags,
titles, and descriptions that you’ve set, as well as the original bookmarking date.

5.2.17 Export. . .

Opens a sheet that lets you choose a folder to which the selected records will be exported.

• The selected files/folders will be copied into the folder.

• Individual selected e-mail messages will be exported as a single mailbox file. To access the
messages, import them into a mail program or EagleFiler.

Please note that, because the library is open, it is not necessary to export files in order to open
them with other applications. You could instead use the Open With External Viewer or Reveal In
Finder commands. The Export. . . command is intended for when you want to make copies of the
selected files or when the selected records are scattered throughout the library so that they would
not be easy to access from the Finder.

EagleFiler natively stores e-mail as mailbox files using the standard mbox format. All Mac e-mail
programs can import files in this format. Here are specific instructions for some common e-mail
programs:

Apple Mail

Choose File . Import Mailboxes. . ., select the mbox files radio button, click Continue,
and then choose the folder containing the exported mailbox file.

Entourage and Outlook

Choose File . Import. . ., select the Contacts or messages from a text file radio button,
then click the right arrow. Select the Import messages from an MBOX-format text
file radio button and click the right arrow. Select the file and then click the Import button.

Note: If you’re unable to import a mailbox file that’s stored in EagleFiler, it may help to select
the messages and export them as a new mailbox file. This is for two reasons:

49http://pinboard.in/export/
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1. EagleFiler stores the messages exactly as you imported them, and some mail programs
are not very tolerate of format differences. When you export, EagleFiler tries to convert
the messages to as standard a format as possible, and this can lead to more successful
imports.

2. Entourage and Outlook will only let you select a file for importing if it has type code
TEXT. Most mailbox files do not have a type code, however EagleFiler will set the type
code when you ask it to create a new mailbox using the Export. . . command.

5.2.18 Backup Metadata

Metadata is EagleFiler-specific information such a record’s title, from, checksum, source URL, tags,
and notes. It is stored inside the .eflibrary file.

EagleFiler will automatically backup a library’s metadata when it’s opened and also periodically
thereafter. You can manually backup the metadata by holding down the Option key and choosing
Backup Metadata from the File menu.

Metadata is backed up to invisible XML EagleFiler Metadata.plist files inside the library folder.
These are standard Mac OS X property lists that can be viewed in TextEdit and processed by many
other programs.

The backups allow EagleFiler to reconstruct all of your metadata if the .eflibrary file is damaged
or deleted.

To Rebuild/Restore a Library

1. Create a new library.

2. In the Finder, drag the old library’s Files folder into the new library’s Files folder.

3. In EagleFiler, choose File . Scan for New Files.

4. In EagleFiler, drag all the records in the Files folder onto Records to move them to
the top level.

5. Close the library.

6. In the Finder, replace the contents of the new library’s Smart Folders folder with the
contents of the old library’s Smart Folders folder.

5.2.19 Empty Trash. . .

Empties the trash of the current library. Hold down the Option key to skip the warning.
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5.2.20 Print

By default, EagleFiler prints the contents of the record viewer. If the source list or records list has
focus, and you hold down the Option key, EagleFiler will instead print the list.

5.3 The Edit Menu

5.3.1 Undo/Redo

Most actions in EagleFiler can be undone and redone, and EagleFiler supports multiple levels of
undo. When you close a library or empty the trash, EagleFiler clears the list of undoable actions
for that library.

5.3.2 Copy

Copies the selected text, the titles of the selected records or sources, or the names of the selected
tags.

See also: Copy Source URL, Copy Record Link, Copy Filename50, and Copy File Path51.

5.3.3 Copy Source URL

Copies to the clipboard the original http URLs for files that were imported from Web pages.

5.3.4 Copy Record Link

Copies a x-eaglefiler URL to the clipboard for each selected record. You can then paste the link
into an EagleFiler note or into another application. Opening the URL will launch EagleFiler, open
the library, and select the record so that its contents are shown in the source list or viewer.

Links will continue to work as you re-arrange the files within the library. However, if you move
the library folder or rename the .eflibrary file in the Finder, previously copied x-eaglefiler
URLs for that library will break. Links to individual e-mail messages will break if you merge the
message’s mailbox with another mailbox, as that will delete the original mailbox.

Another way to use record links is to select some records in EagleFiler and choose a command from
the Services menu, e.g. Text Edit . New Window Containing Selection or OmniFocus:

50http://c-command.com/scripts/eaglefiler/copy-filename
51http://c-command.com/scripts/eaglefiler/copy-file-path
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Send to Inbox. This will send the record links to that application without your having to copy
and paste.

See also the Copy File URL52 script.

5.3.5 Paste/Paste and Match Style

Regular Paste preserves the font and style information from the copied text. This means that the
pasted text may not fit in with its surroundings.

Paste and Match Style is like converting the clipboard to plain text before pasting. Any for-
matting is removed. The pasted text will blend in with the surrounding text.

5.3.6 Find . Library Search. . .

Brings the focus to the search field in the current browser window so that you can search the library
for the records that are of interest. This is described in the Searching section. After searching,
the query is automatically entered into the Find panel so that you can search within the current
record, e.g. using Find . Find Next/Previous.

5.3.7 Find . Find. . .

Opens the Find panel so that you can find (or replace) text within the current record. You can
hold down the Option key when clicking the Replace All button to make it only replace within
the selection.

5.3.8 Find . Find Next/Previous

If the query has already been set (using Find . Find. . . or Find . Use Selection for Find), jumps
to the next (or previous) occurrence within the current record.

5.3.9 Find . Use Selection for Find

A shortcut for entering the selected text into the Find panel. This, combined with Find . Find
Next/Previous, makes it possible to search within a record without having to open the Find panel.

52http://c-command.com/scripts/eaglefiler/copy-file-url
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5.3.10 Spelling and Grammar

This submenu lets you check the spelling and grammar53, turn automatic checking on/off, and turn
automatic spelling correction on/off.

5.3.11 Substitutions

This submenu lets you control whether EagleFiler uses smart copy/paste54, smart quotes55, smart
dashes56, smart links57, data detectors58, and automatic text replacement59.

5.3.12 Transformations

This submenu contains commands60 for making the selected text lowercase, uppercase, or capital-
ized.

5.4 The View Menu

5.4.1 Message . Raw Source

If this is checked, the viewer will show the raw RFC-82261 source for e-mail messages. If it’s
unchecked, the viewer will instead show the decoded Subject, From, Date, To, and body of the
message.

5.4.2 Message . Plain Text

If this is checked, EagleFiler will show all e-mail messages in plain text format. For HTML-only
messages, a plain text representation will be created. If this is unchecked, HTML messages will be
shown using rich text and plain text messages will be shown in plain text.

53http://support.apple.com/kb/ph10844
54http://support.apple.com/kb/PH10620
55http://support.apple.com/kb/PH4513
56http://support.apple.com/kb/PH4820
57http://support.apple.com/kb/PH11346
58http://support.apple.com/kb/PH11351
59http://support.apple.com/kb/PH11347
60http://support.apple.com/kb/PH11348
61http://www.ietf.org/rfc/rfc0822.txt
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5.4.3 PDF . Next/Previous Page

These commands let you control which page of a PDF is displayed in the record viewer. There are
several ways to change the page without using the menu bar:

• Click on the PDF page, so that it gets keyboard focus, and then press the Down or Up arrow
key. In order for this to work, View . Zooming . Zoom to Fit must be checked.

• Press Command–Left Arrow or Command–Right Arrow.

• Control-click on the PDF page and use the commands in the contextual menu.

• Use the View . Customize Toolbar command to add Next and Previous toolbar buttons
for changing the page.

• Use the Keyboard pane of System Preferences to change the keyboard shortcuts for
Next Page and Previous Page.

5.4.4 Show . Source List

Hides or shows the source list. As a shortcut, you can double-click on the divider.

5.4.5 Show . Record Viewer

Hides or shows the record viewer. As a shortcut, you can double-click on the divider.

5.4.6 Show . Deleted Messages

E-mail messages that you’ve deleted are still stored in their mailbox files, but they are hidden from
view. This option in the View menu lets you see all of the messages, even the deleted ones. To
undelete a message, select it and press Delete.

5.4.7 Show . Messages in Records Source

If this is checked in the View menu, EagleFiler will show e-mail messages (from all your mailboxes)
as well as files in the Records source. Uncheck it if you want to avoid the clutter of seeing all the
e-mail messages, or if viewing the library is slow because you have lots of messages. This setting is
saved per-library.
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5.4.8 Show . Messages in Tag Sources

If this is checked in the View menu, EagleFiler will show e-mail messages (from all your mailboxes)
as well as files in tag sources. Uncheck it if you want to avoid the clutter of seeing all the e-mail
messages, or if viewing tag sources is slow because you have lots of messages. This setting is saved
per-library.

5.4.9 Allow Editing in Record Viewer

This controls whether Text, RTF, and RTFD records can be edited directly in the record viewer,
without opening the file in another application. You might uncheck this if you want to avoid making
accidental changes while viewing a record.

5.4.10 Open in New Window

This opens a new browser window in EagleFiler and selects the current record. If more than one
record is selected, EagleFiler opens one window per record.

A shortcut for this command is to double-click an item in the source list.

5.4.11 Enter Full Screen

This makes the browser window take over the whole screen. You can still bring up the info and tag
inspectors if desired. Requires Mac OS X 10.7.

5.5 The Go Menu

The commands at the bottom of this menu let you quickly jump to key items in the source list:
Records, Recently Added, Recently Modified, Unfiled, Untagged, flagged, and unread.

5.5.1 Enclosing Record

View the container of the current folder or mailbox (i.e. go up a level in the hierarchy). For
example, if you have a file selected in the records list, this will select the file’s folder in the records
list. If you have a folder selected in the source list, this will select the containing folder in the
source list.
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5.5.2 Contents of Record

View the contents of the selected folder or mailbox (i.e. go down a level in the hierarchy). For
example, if the Records source is selected, you can use the search box to enter the name of the
folder or mailbox that you want to view, select it in the record list, and then choose Contents of
Record. This is often quicker than expanding the various folders inside the Records source to
find the one you want.

If a message or non-mailbox file is selected, Contents of Record will instead say Reveal in
Container, and it will select the containing mailbox or folder in the source list and select the
message or file in the records list. This lets you search for a message or file in Records, a tag
source, or a smart folder, and then reveal it in its original context.

5.5.3 Previous/Next Record

These commands select the previous or next record in the record list. This lets you change which
record is being viewed while the viewer pane has keyboard focus.

When the records list or the record viewer has keyboard focus, you can type Spacebar or Shift-
Spacebar to select the next or previous record.

5.6 The Record Menu

5.6.1 Mark as Unread/Read

Add (or remove) the “unread” tag to the selected records.

5.6.2 Mark as Flagged/Unflagged

Add (or remove) the “flagged” tag to the selected records.

5.6.3 Tag

Gives keyboard focus to the tags text field at the bottom of the browser window, which lets you
edit the tags of the selected record.
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5.6.4 Edit Notes

Opens the Info inspector and places the insertion point in the Notes field.

5.6.5 Set Label

Lets you set the Finder label of the selected records. Since e-mail messages do not appear as distinct
files in the Finder, setting the label of a message sets the Finder label of the message’s mailbox.

5.6.6 Move To

Moves the selected records to another folder.

5.6.7 Batch Change. . .

This window lets you set the title, from name, label, tags, and notes of multiple selected records at
once. You can either Append or Replace. For example, appending tag mac will add that tag to
the selected records, while Replace would add the mac tag and remove any pre-existing tags.
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There are keyboard shortcuts for Append (Shift-Command-A), Replace (Shift-Command-R),
Label (Command-3), Cancel (Command-. or Escape), and OK (Enter or Command-Return).

5.6.8 Convert for Editing

Converts the selected Web archives to (editable) rich text files, preserving the tags, notes, source
URL, and other metadata.

The ImportTextAsWebArchive esoteric preference can be used to make selected Web text always
import in rich text rather than Web archive format, so that it’s not necessary to convert for editing.

5.6.9 Verify

When you open a library, EagleFiler checks that all the files and notes are present. The Verify
command does this, and it additionally checks that their contents are what EagleFiler was expect-
ing. To verify the entire library, select the Records source and choose Verify. You can also verify
individual files or folders.
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This can help you detect file corruption before it becomes a serious problem. For example, if there
is damage to your disk and a file becomes corrupt, you’ll learn of the problem as soon as you use the
Verify command. Without Verify, you would only learn of the problem when you tried to access
the file (perhaps a long time in the future), and perhaps not even then, because the corruption
might not be readily apparent. Because you learn about the damage early, you can restore a correct
version of the file from a backup, rather than filling your future backups with damaged copies of
the file.

In order to detect when files have changed, EagleFiler stores a checksum of each file. If EagleFiler
reads a file and calculates the same checksum that it got before, it knows that the file has not
changed. Thus, if the file was in good condition before, it is still in good condition. If EagleFiler
calculates a different checksum, that means that the file’s contents are different.

Sometimes, the checksum should be different. For example, when you edit a file, you intentionally
change its contents, resulting in a different checksum. When you edit a file within EagleFiler,
EagleFiler automatically updates its stored checksum to match the file’s new contents. Thus, if
you only edit files using EagleFiler, the checksums will always be in sync with the files’ contents,
and any checksum that doesn’t match means that the file is damaged.

EagleFiler also allows you edit files using other applications. For example, you can double-click a
Microsoft Word document to open it in Word, make some changes, and choose File . Save. In
this case, the file has changed, but there is no way for EagleFiler to know that this is because of
what you did in Word. The changes could have been due to damage. Thus, if you edit a file outside
of EagleFiler, you must use the Update Checksum to tell EagleFiler that the file’s current contents
are correct. EagleFiler will then update its stored checksum to match.

Verify is a specialized feature for people who want extra data integrity protection. If you don’t
need this, or if you frequently edit files outside of EagleFiler and don’t want to have to Update
Checksum, then you can simply ignore the Verify command. EagleFiler will then behave like a
normal Mac application: it won’t complain about files being different than it expected, but neither
will it detect when they are damaged.

A verification can fail with two different types of errors:

Missing File

This means that you had a file in your library, but it is no longer where EagleFiler expects
to find it. Probably the file (or a containing folder) was renamed, moved, or deleted using an
application other than EagleFiler. (As described in the Library Folders section, you should
not do this.)

The Errors window shows the expected name of the file, and you can click Reveal to show its
expected folder in the Finder or Reveal in Library to show its expected folder in EagleFiler.

If you can find the file in the Finder (or in a backup), use the Finder to move back to the
expected folder. Then EagleFiler will be able to find it again.

If you cannot find the file, you click the Trash button to delete it in EagleFiler and then
empty the trash so that EagleFiler stops looking for it.
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Bad Checksum

This means that the file’s contents no longer match what EagleFiler was expecting. If you have
modified the file outside of EagleFiler, this is normal and you can click Update Checksum
to tell EagleFiler that the file is OK. Otherwise, the file is probably damaged, and you should
try to restore it from a backup. Use the Finder to move the correct file into place, replacing
the one with the bad checksum.

To quickly delete a large number of verification errors, choose Edit . Select All and then press
the Delete key.

5.6.10 Update Checksum

The Update Checksum command tells EagleFiler that you have edited the selected file(s) using
another application. This is necessary for proper operation of the Verify command and duplicates
detection.

If you do not edit files outside of EagleFiler, or if you do not use Verify or duplicates detection,
you can ignore the Update Checksum command.

5.6.11 Merge Mailboxes/Message Files

Merges the selected mailboxes (or .eml files) into a single mailbox file with the name and location of
the oldest mailbox (or .eml file) in the selection. The tags and notes of the messages are preserved.
The original files are then moved to the trash.

Merging can reduce clutter in the source list and speed up EagleFiler.

5.6.12 Reply to Message

Lets you reply to a message in your default e-mail program.

5.6.13 Open With External Viewer

Opens the selected records in a specialized viewer application such as Preview, Safari, or Mail.
Folders and mailboxes will open in a new window in EagleFiler. If you open an e-mail, the message
that’s displayed in Mail is the message that’s stored in EagleFiler’s library, not the original message
that was imported from Mail (which might already have been deleted).

If a search is in effect, EagleFiler passes the search string to the external viewer so that it can show
you the matches in the document.
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Double-clicking a record is a shortcut for choosing this command from the menu. Hold down the
Option key to open the source URL instead of the stored file.

To open the record using an application other than the default, use the Open With command.

To change the keyboard shortcut for this command, see the CommandOToOpenRecord esoteric pref-
erence.

5.6.14 Open With

The Open With submenu lets you temporarily override the default application for opening a file.
For example, perhaps you normally open PDF files using Preview, but in a particular circumstance
you want to use Adobe Reader instead. To do this, select the file and choose Open With . Adobe
Reader from the Record menu or the contextual menu.

The Always Open With submenu lets you change the default application for all files of a partic-
ular content type (UTI62). For example, perhaps you want all your HTML files to open in BBEdit
when double-clicked.

To change the default application for a particular file, use the Reveal in Finder command, then
choose Get Info from the Finder’s File menu and look in the Open with section of the info
window.

5.6.15 Open Source URL

With a Web archive record (or an RTFD file converted from a Web archive) selected, this opens
the (live, not archived) Web page in your Web browser.

You can also Option-double-click on a record to open its source URL.

EagleFiler uses the Default web browser that’s set in Safari’s preferences.

5.6.16 Open in Delicious

This opens a Web archive’s URL in the Delicious63 social bookmarking site to help you find related
pages.

62http://en.wikipedia.org/wiki/Uniform Type Identifier
63http://delicious.com
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5.6.17 Quick Look

EagleFiler uses Apple’s Quick Look64 technology to preview in the record viewer files that it doesn’t
natively understand. The Quick Look menu command lets you open a larger preview window.

You can Quick Look multiple records at once to compare thumbnails of them in the Quick Look
window.

A shortcut for opening the Quick Look window is to press the Spacebar when in the records list.

5.6.18 Slideshow

Opens a full-screen Quick Look window to view the selected records. To see this menu command,
hold down the Option key.

A shortcut for opening the Quick Look window is to press Option-Spacebar when in the records
list.

The Slideshow feature requires Mac OS X 10.6 or later.

5.6.19 Reveal in Finder

This shows the selected records in the Finder. If you have Path Finder65 running, the files will be
revealed in it instead.

5.7 The Format Menu

This menu contains commands for use when editing a rich text file in EagleFiler’s viewer or when
editing a note. You can change the font and style and add clickable links, lists, and tables. In
addition to the standard Mac OS X formatting commands, EagleFiler provides a command called
Highlight, which makes the background of the selected text yellow, as if it had been drawn over
with a highlighter.

64http://www.apple.com/macosx/features/quicklook.html
65http://www.cocoatech.com
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5.8 The Window Menu

5.8.1 Show Info

This window lets you view and edit the properties of the selected records. You can type Tab to
move between to text fields, or Control-Tab to move out of the notes text view. The Info inspector
can be opened via Command-I or Command-Option-I.

File Properties

This shows the file’s name, kind, size, and dates, as well as EagleFiler metadata such as the
title, source URL, and from.
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If the file didn’t have an embedded title (or you set the title to be blank), EagleFiler will
use the filename (without the extension) as the title, and the title will stay in sync with the
filename if you rename it.

Label

This is the Finder label of the file. In EagleFiler, the label is shown as the background color
in the records list and also in the Label column. E-mail messages are stored as mailboxes,
not as individual files, so all the messages in the mailbox share the mailbox file’s label. You
can edit the label names from the Finder’s Preferences window.

Tags

This shows the tags assigned to the record. You may find it more convenient to create and
assign tags by typing them in the text field than by using the Show Tags command.

Notes

Notes support rich text, clickable links, embedded graphics, tables, etc. Most of the commands
for editing notes are in the Format menu. You can use the Copy Record Link to copy a link
to an EagleFiler record; then paste the link into another record’s note so that you can easily
find one record while viewing the other. As a shortcut, you can type Option-Tab to start
a bulleted list or Option-Shift-Tab to dedent the current list item. EagleFiler automatically
adds the “note” tag to records that have notes, and removes it from ones that don’t.

5.8.2 Show Tags

This window shows a list of tags for the current library. You can also view the tags using the Show
Tag Cloud command.
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The columns are:

√

The box is checked if all of the selected records in the browser window have this tag. It shows
a - sign if some (but not all) of the selected records have the tag. It is disabled if no records
are selected.

•
The abbreviation (if any) for the tag. Abbreviations are shown in the Tags column of
the records list; for example, the “unread” tag is shown as a blue •. Double-click on an
abbreviation to edit it. The abbreviation can be composed of ordinary letters, or of special
symbols. To enter a special symbol, first double-click to edit the abbreviation. Then click the
Characters button to open the Character Palette. Click on the character that you want,
then double-click it or press the Insert button.

Note: Make sure that you are using a View that does not have a Font pop-up menu; this
way you can ensure that you enter a true Unicode character.
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Note: You can choose any Unicode character. On Mac OS X 10.7 and later, you can also
choose color emoji66 pictures or copy and paste them from this Web page67.

Name

The name of the tag. Double-click on a name to edit it. (The names of built-in tags such as
“unread” cannot be edited.) Each tag must have a unique name.

You can give the tags palette keyboard focus by:

• Clicking in its title bar.

• Choosing Show Tags from the Record menu.

• Clicking the Tags button in the toolbar of a browser window.

• Editing an abbreviation or name.

Once the tags palette has keyboard focus, you can:

• Type the first few letters of a tag’s name to select it in the list.
66http://en.wikipedia.org/wiki/Emoji
67http://www.grumdrig.com/emoji-list/
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• Press the spacebar to toggle whether the selected records in the browser window have the
selected tags. This is like checking or unchecking the boxes of all the selected tags at once.

• Click the Colors button in the toolbar. Then choose a new color for the selected tag(s) and
abbreviation(s).

You can Control-click on a tag to reveal it in the source list, thus showing all the records with that
tag.

5.8.3 Show Tag Cloud

The Tag Cloud window shows a compact listing of all the tags. You can click on a tag to toggle
whether it’s assigned to the selected record(s).

A shortcut for opening the Tag Cloud window is to Option-click the Tags button in the toolbar.

5.8.4 Activity

EagleFiler can do many operations—such as adding files and URLs to the library, indexing,
verifying—in the background. This window shows a list of the tasks that EagleFiler is currently
working on for each library.
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A shortcut for opening the Activity window is to click the progress spinner at the bottom of a
browser window.

5.8.5 Drop Pad

The Drop Pad tells you which library is active. You can drag files onto the Drop Pad to import them
into the active library. You can use the pop-up menu on the Drop Pad to change the active library
(without introducing window clutter). The Drop Pad also provides information about whether
EagleFiler can capture from the current application.
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You can control the number of recent libraries shown in the Drop Pad window via the General
pane in System Preferences.

5.8.6 Errors

This window shows a list of errors that have occurred since you launched EagleFiler. You can select
errors and copy them to the clipboard.

5.9 The Help Menu

This menu provides access to the full EagleFiler documentation (in Apple Help or PDF format) as
well as a link to the technical support Web site.

5.10 The Dock Menu

To access the Dock menu, right-click or hold down the Control key when clicking on EagleFiler’s
Dock icon.

The Open Recent commands let you access EagleFiler libraries that might not currently be open.
The Capture From <Application> command is equivalent to pressing the capture key. The
Import Clipboard command will import any text on the clipboard as a new rich text file. The
New Record commands let you create new files in the current library.

83



6 Preferences
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6.1 Capture key

You can always import into EagleFiler using Import URLs. . ., Import Files. . ., or drag and drop.
However, if you are already viewing the information that you want import, it’s much easier to just
press the capture key.

When you press the capture key, EagleFiler automatically determines what you’re currently viewing
(or what you have selected) and imports it into the current library. If no library is currently open,
EagleFiler opens the Capture with options window so that you can pick a library.

There are many applications that support capture. EagleFiler will play a camera sound, bounce
its Dock icon once, and show a camera icon in its Dock tile to let you know that the capture has
started. When it’s finished, if you have Growl68 installed, you’ll see a notification bubble.

By default, the capture key is F1. If you have a notebook or an aluminum Apple keyboard, you’ll
need to hold the fn key to type F1 unless you’ve checked Use all F1, F2, etc. keys as standard
function keys in the Keyboard & Mouse preferences pane or are using FunctionFlip69. You
can also change the capture key to a different key or key combination if you prefer.

If you’d rather import just the selected text instead of the entire Web page or document, you can
use drag and drop or the EagleFiler: Import service (Command%) instead of the capture key.

EagleFiler must be running in order for the capture key to work. Thus, you may wish to add
EagleFiler to your Login Items in the Accounts pane of System Preferences. You can easily do
this by clicking on the EagleFiler icon in the Dock and choosing Open at Login.

6.2 Capture with options

This works like the capture key: you press it while in one of the applications that support capture,
and EagleFiler imports the “current item” into your library. The difference is that you can specify
which library to import into, and which folder within that library. You can also set the title, from
name, label, tags, and notes:

68http://growl.info
69http://kevingessner.com/software/functionflip/
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EagleFiler remembers this metadata (except the title and notes) for each library, so it’s easy to
quickly capture a bunch of related items. Pressing the Reset button clears the metadata and sets
the folder so that EagleFiler once again imports into the Unfiled source.

There are keyboard shortcuts for choosing the library (Command-1), folder (Command-2), Label
(Command-3), Reset (Command-K), Cancel (Command-. or Escape), and Capture (Enter or
Command-Return). Once the folder menu is open, you can select a folder by typing the first few
letters of its name.You can switch between the Metadata and Source tabs using Command-{ and
Command-}.

6.3 Quick entry

Press this hotkey to bring up a dialog for creating a new file. You can enter the text content of
the file and set the metadata (label, tags, notes, etc.). The Format pop-up menu lets you choose
whether to create a Rich text (RTF or RTFD) or plain text (UTF-8) file.
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Pressing the Reset button clears the metadata and sets the folder so that EagleFiler once again
imports into the Unfiled source.

There are keyboard shortcuts for choosing the library (Command-1), folder (Command-2), La-
bel (Command-3), Reset (Command-K), Cancel (Command-. or Escape), and Save (Enter or
Command-Return). Once the folder menu is open, you can select a folder by typing the first few
letters of its name. You can switch between the Metadata and Text tabs using Command-{ and
Command-}.

6.4 Web page format

When you import an entire Web page, EagleFiler can save it using the following formats:

Bookmark

A .webloc file that stores the URL and page title. This does not save the contents of the
page, thus conserving disk space but restricting your search options. You can also edit (and
update) the URL in a bookmark.
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PDF

PDF files preserve the text, formatting, clickable links, and images. Web pages containing
HTML frames cannot be saved as PDF files; when importing such pages, EagleFiler will save
them as Web archives.

PDF (Single Page)

As above, except that the PDF is formatted as a single page and with tighter margins for
easier on-screen viewing. For best results, set EagleFiler or your PDF viewer to display in
“Single Page Continuous” mode. Printing PDFs in this format can be a problem, however,
because the PDF page will generally be much larger than a sheet of paper.

Plain Text

Plain text files include the text content of the page, with no formatting or images. Thus,
they make very efficient use of disk space.

Rich Text

RTF files preserve the text, formatting, and clickable links, but not the images.

Rich Text With Images

An RTFD package that preserves the text, formatting, clickable links, and images.

Web archive

Web archives preserve the entire page contents in its original format (HTML, CSS, images).
They’re slower to display than PDFs, but you can resize the window to change the displayed
width, and you can adjust the font size (often more useful than zooming a PDF). Web archives
can be viewed on Macs (using Safari) and iPhones, but currently there are no Windows or
Linux applications to display them.

You can use bookmarklets70 to temporarily override the format chosen in the preferences.

6.5 Spotlight comments

This setting controls what happens to a file’s Spotlight comments when you import it into Eagle-
Filer.

Ignore

EagleFiler preserves the Spotlight comments.

Import as notes and tags

EagleFiler extracts tags (prefixed by & or marked using Punakea’s format) and assigns them
as EagleFiler tags. It imports the remaining comments text as notes.

70http://c-command.com/eaglefiler/bookmarklets
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Import as tags

Each word in the comments is imported as a tag.

EagleFiler always imports tags that are stored in the file’s extended attributes under com.apple.metadata:kOMUserTags
by applications such as Tags, TagIt, and Default Folder X.

6.6 Fonts

Sources

Used in the source list in browser windows.

Lists

Used in the records list in browser windows and in the list of tags in the tags inspector.

Rich text

Used for e-mail header information, HTML messages, and as the default font for notes.

Plain text

Used for plain text e-mail messages and text files.

The fonts for Web archives are mostly controlled by the Web archives themselves.

6.7 Search highlight color

This is the color that EagleFiler uses to emphasize the search terms in the records list and record
viewer.

6.8 Quoted Text Colors

EagleFiler colors plain text e-mail messages according to the number of quote characters at the
start of each line. The pop-down menu lets you choose a preset coloring scheme.

6.9 Remember open libraries between launches

If this is checked, EagleFiler will remember which libraries were open when you quit it, and it will
re-open them the next time EagleFiler is launched.

In addition, you can put aliases to your favorite libraries in the folder:
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/Users/<username>/Library/Application Support/EagleFiler/Startup Items

so that EagleFiler will always open them at launch. (To open the Library folder under Mac OS X
10.7 Lion, go to the Go menu in the Finder and hold down the Option key.) You can hold down
the Shift key at launch to prevent it from re-opening the libraries or opening the startup items.

6.10 Copy tags to Spotlight comments

If this is checked, EagleFiler will set the Spotlight comments for each file to the names of the tags
that it’s been assigned. This enables you to search for a file using Spotlight by typing tag names
as part of the query. Any existing comments will be lost. If this is not checked, EagleFiler will
preserve the existing Spotlight comments when importing files.

EagleFiler will automatically copy the tags to the comments when a library is opened and pe-
riodically thereafter. You can force it to update the comments by using the Backup Metadata
command.

There is an esoteric preference to control the tag prefix that’s added to each tag name in the
comments. The default prefix is “&”.

As of version 1.4.7, EagleFiler supports OpenMeta71, which is much more efficient than Spotlight
comments. Thus, the Copy tags to Spotlight comments option is no longer recommended
except for interoperability with non-OpenMeta applications.

6.11 Allow duplicate files in library

Normally EagleFiler will prevent you from importing a file if a file with the same contents (in the
data fork) is already in the library. You can check this option if you prefer to import every file,
even duplicates. In order for duplicate detection to work, your files’ checksums must be up-to-date.
For more information, please read about the Verify and Update Checksum commands.

When you import via Scan for New Files, EagleFiler does not check for duplicates. This is because
you have specifically put the files in EagleFiler’s library folder.

To remove duplicates after the files are already in the library, see the Remove Duplicate Files
script72.

Duplicate URLs

Archived Web pages with the same source URL will generally contain different data, so EagleFiler
71http://openmetainfo.org
72http://c-command.com/scripts/eaglefiler/remove-duplicate-files
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will not treat them as duplicates. However, there is a script73 for removing duplicates by URL if
that’s what you want to do.

Duplicate E-mail Messages

EagleFiler checks for duplicates at the file level. Thus, when you import a mailbox file containing
a bunch of e-mail messages, EagleFiler checks for a duplicate mailbox but does not check the
individual messages within that mailbox file for duplicates. To remove duplicate e-mails, see the
Remove Duplicate Messages74 script.

6.12 Esoteric Preferences

You can set esoteric EagleFiler preferences by clicking the links on this page. Unlike with regular
preferences, you must generally quit and re-launch EagleFiler in order for an esoteric preference to
take effect.

Note: The links aren’t clickable in the Help window in EagleFiler. Click here75 to open the page
in your browser, or Control-click on a link, choose Copy Link, and paste the link into Safari’s
location bar.

AutomaticallyBackupMetadata

EagleFiler automatically backs up your libraries’ metadata (and, at the same time, copies
tags to the Spotlight comments, if you’ve asked it to do that), but you can turn this feature
off for a slight speed increase.

CalculateFolderSizes

This controls whether EagleFiler calculates folder sizes to display them in the records list.
Turning off this feature will increase EagleFiler’s responsiveness.

CaseSensitiveTagCompletion

Normally, tag auto-completion is case-insensitive so that you see as many matching tags as
possible. You can also set it to be case-sensitive so that it is easier to type new tag names
that are similar to existing tags but with differing case.

ClearSearchWhenChangingSources

Normally EagleFiler clears the search so that clicking on a different folder takes EagleFiler
out of search mode and shows you all the records. You can also set EagleFiler to preserve
your search query (like in OmniFocus) when you view different sources, so that you can easily
search different folders without retyping the query.

73http://c-command.com/scripts/eaglefiler/remove-duplicate-urls
74http://c-command.com/scripts/eaglefiler/remove-duplicate-messages
75http://c-command.com/eaglefiler/manual-ah/esoteric-preferences
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CommandOToOpenRecord

Normally EagleFiler uses the keyboard shortcut Command-Shift-O for Open With Exter-
nal Viewer. You can also set it to use Command-O (swapping the shortcut with Open
Library. . .).

DefaultMessageEncoding

When a message doesn’t specify which text encoding it uses, EagleFiler has to guess. An
incorrect guess may cause the message to display using strange accents or garbage characters.
By default EagleFiler guesses MacRoman, but you can change it to guess ISO Latin 1 instead.

EnableJavaScript

Normally, EagleFiler will use JavaScript to help display HTML files and Web archives. How-
ever, you can also disable JavaScript, which may make the pages less distracting to view.
EagleFiler always enables JavaScript when importing Web pages.

EnableWebPlugIns

Normally, EagleFiler will show content from Web plug-ins (such as Flash) when displaying
an HTML file or Web archive. However, you can also disable plug-ins if you don’t want to
see this content.

ErrorsOpenForDuplicates

Normally, EagleFiler will open the Errors window when a file has been skipped during an
import because it’s a duplicate. However, you can also set EagleFiler to log the error without
opening the window, for example if you expect there to be duplicates and don’t care to see
them.

EvernoteCaptureFormat

Normally, EagleFiler will capture from Evernote in HTML format. Any attachments will be
imported in a folder next to the HTML file. You can also set also set EagleFiler to only
import a bookmark file that links back to the Evernote application. In this case, attachments
will be ignored.

ExcludeIndexesFromBackup

EagleFiler’s index files are normally included in Time Machine backups. This way, you can
immediately search your library after restoring it from backup. To save space on the backup
device and speed up your backups, you can set EagleFiler to exclude the indexes from backups.
The downside to this is that, as with Spotlight, you’ll have to wait for the files to be re-indexed
after restoring.

FindPanelDiacriticInsensitive

EagleFiler’s Find panel normally works like TextEdit’s. Searching for “e” does not find “é”.
You can also make EagleFiler’s Find panel diacritic-insensitive so that “e” matches “é”, “ü”
matches “u”, etc., as always happens with EagleFiler’s library search and Spotlight. This
feature does not work in Web or PDF views.
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FolderMailboxTitleSeparateFromFilename

Normally EagleFiler will keep the titles of folders and mailboxes in sync with their filenames.
You can also set it to allow the titles to be distinct from the filenames. This is potentially
useful if you need to manage a folder structure using fixed filenames but you want to have
longer, more descriptive titles in EagleFiler.

HighlightSearchMatches

Normally EagleFiler will highlight in the record viewer the words that match your search
query. Disabling this feature will provide a speed increase.

ImportLoneMessageAsMailbox

Normally EagleFiler will import a single e-mail message as a .eml file. This makes it easier
to view the message directly in the records list; multiple .eml files can later be merged into
a mailbox if desired. You can also set EagleFiler to import a lone message as a mailbox file
containing a single message. This makes it easier to merge it with existing mailboxes.

ImportSpotlightKeywords

EagleFiler normally ignores Spotlight keywords when importing files to avoid cluttering your
tags list with irrelevant or incorrect entries. You can also set EagleFiler to import Spotlight
keywords as tags if you generally like the keywords that are assigned to your files.

ImportTextAsWebArchive

When importing the selected text from a Web view (via drag and drop, the Service menu,
or the Import Clipboard command), EagleFiler normally uses the Web archive format, as
this preserves all of the original information. You can instead set it to import in RTF(D)
format for easier editing.

InvisibleMetadataFiles

This controls whether EagleFiler Metadata.plist files are visible or invisible.

MarkNewRecordsAsUnread

Normally EagleFiler will mark newly imported records as unread, but you can also tell it to
leave them untagged. This does not affect the Capture With Options window, since that
always suggests the tags from the previous capture.

MaxEditableTextFileSizeInMB

Normally EagleFiler will display the entire contents of a text file, even if it’s many megabytes.
This can take a long time. You can speed it up by setting EagleFiler to only show the first
10 MB of a text file.

MediaStyle

If a Web page includes multiple stylesheets, you can choose whether EagleFiler displays it
using the print stylesheet or the default stylesheet.
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MediaStylePDF

If a Web page includes multiple stylesheets, you can choose whether EagleFiler creates a PDF
using the print stylesheet or the default (screen) stylesheet.

MJTUpdaterDeleteDiskImage

Normally, the Software Update. . . feature will clean up after itself after downloading a new
version. You can also set it to leave the disk image file in your Downloads folder.

OldApplicationIcon

If you prefer, you can use the old application icon from EagleFiler 1.0 through 1.4 rather than
the new photo-realistic one.

OpenEagleFilerURLsInNewWindow

Normally EagleFiler opens x-eaglefiler URLs in a an existing browser window. You can
also set it to create a new browser window.

PDFWebBackgrounds

When you import a Web page in PDF format, EagleFiler usually preserves the background
so that the page looks like it does in the browser. You can also set EagleFiler to use a blank
page background. This is especially useful in combination with setting the MediaStylePDF
to print.

PlayCaptureSound

When you press the capture key, EagleFiler can either play a sound or be silent.

PrefersRichText

Normally when you create a new file via the EagleFiler: Import service, Import From
Clipboard, or New Record . From Clipboard EagleFiler creates an RTF or RTFD file. You
can instead set it to create plain text files.

RecordsListHasAlternatingBackground

This controls whether EagleFiler uses a solid white background or blue-and-white alternating
row background colors in the records list.

RespectImageDPI

When displaying images and rich text files, EagleFiler normally uses the resolution specified
in each image file. Some images have an incorrect resolution setting (e.g. set to 300 DPI
but intended to be 72 DPI), which can make them appear very small on screen. Therefore,
EagleFiler lets you override the image’s resolution to display all the pixels. This can “fix”
the display for incorrect image files, however it will make legitimately high-resolution images
appear much too large. The best solution is to fix the resolution in the image files themselves.

RevealInLibraryNewWindow

Normally the Reveal in Library button in the Errors window selects the record in an
existing window, which can be a lot faster if you’re going through lots of “Missing File”
errors. You can also set it to open a new window, so that you don’t lose your place.
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ScanForNewFilesOnOpen

EagleFiler normally scans for new files when the library is opened. You can turn this off so
that it only scans for new files when you use the menu command.

SendsWholeSearchString

Normally EagleFiler updates the search results as you type. If you are a slow typer, it may do
this after each letter, causing the search to take a long time. You can instead set EagleFiler
to only do the search once, when you press Return.

ShowImagesInMessages

Normally EagleFiler will show images in HTML e-mails, but you can also tell it to not load
them if you’re concerned about Web bugs.

TagCommentPrefix

If a record is tagged unread and flagged EagleFiler will normally set the Spotlight comments
to &flagged &unread. This allows for integration with other applications that follow this
convention, and it lets you use Spotlight to search for files with particular tags. You can set
it to use no prefix so that it instead sets the comments to flagged unread or set the prefix
to “&” to go back to the default.

TextInspectorBarStayOpen

Normally EagleFiler shows and hides the text editing toolbar as needed. You can also set
it to stay visible if you prefer not to see the window resize when you view different types of
records.

UseOpenMetaRecentsForCompletion

Normally EagleFiler keeps a global list of recently used tags to use for auto-completion.
You can also turn this off so that only tags in the current library are offered as suggested
completions.

7 Extending EagleFiler

7.1 AppleScripting EagleFiler

EagleFiler has extensive support for AppleScript so that you can automate it and integrate it with
other applications. The EagleFiler AppleScripts76 page has a collection of sample scripts that are
useful in their own right and that can also be used as templates for developing your own scripts.

Running AppleScripts From EagleFiler’s Script Menu

By using Mac OS X’s script menu, you can make AppleScripts available from inside EagleFiler as if
they were built-in commands. To enable the script menu, open the AppleScript Editor application

76http://c-command.com/scripts/eaglefiler/
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in the Utilities folder. In the preferences window, make sure that Show Script menu in menu
bar is checked.

The menu will appear at the right side of your menu bar, near the clock. To add commands to
the menu, switch to EagleFiler and choose Open Scripts Folder . Open EagleFiler Scripts
Folder. This will open a special folder in the Finder; every script file that you put in this folder
will show up in EagleFiler’s script menu.
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To run a script, just select the menu command with your mouse. If you need additional script
menu features such as keyboard shortcuts, try Red Sweater Software’s FastScripts77.

Leaning AppleScript

For more information about AppleScript, see Apple’s AppleScript Language Guide78, AppleScript:
The Definitive Guide79 by Matt Neuburg, or AppleScript 1-2-380 by Sal Soghoian and Bill Cheese-
man.

7.2 Applications That Support Capture

EagleFiler’s capture feature lets you import the current window or items from the frontmost ap-
plication, just by pressing a key. The capture key and capture with options key work in these
applications:

77http://www.red-sweater.com/fastscripts/
78http://developer.apple.com/library/mac/#documentation/AppleScript/Conceptual/AppleScriptLangGuide/introduction/ASLR intro.html
79http://oreilly.com/catalog/9780596102111
80http://www.peachpit.com/store/product.aspx?isbn=0321149319

97

http://www.red-sweater.com/fastscripts/
http://developer.apple.com/library/mac/#documentation/AppleScript/Conceptual/AppleScriptLangGuide/introduction/ASLR_intro.html
http://oreilly.com/catalog/9780596102111
http://oreilly.com/catalog/9780596102111
http://www.peachpit.com/store/product.aspx?isbn=0321149319


Contacts

Captures a vCard file for the selected contacts.

BBEdit

Captures the file of the first document of the front window.

Camino

Captures the URL of the current tab of the front window.

Cocoalicious

Captures the URLs of the selected posts, preserving the tags, description, and extended
description.

Cruz

Captures the URL of the current tab.

Cyndicate

Captures the URLs of the selected articles, preserving the label and flagged status.

DEVONagent

Captures the URL of the front browser window.

DEVONthink Pro

Captures the selected items, preserving the comments.

Endo

Captures the selected news items as Web archives, preserving their tags and importing the
excerpts as notes.

Entourage

Captures the selected messages or mailbox, preserving the message flags, categories, and
projects. If you want EagleFiler to skip a message, you can assign it the category “OmitFro-
mArchive”.

Evernote

Captures the selected notes, along with their tags and attachments. The source URL stores
a link to the note in the Evernote app, and the notes store the original source URL (if any).

Excel (2004 and later)

Captures the file of the front window (make sure that it’s saved to disk).

Finder

Captures the selected files in the front window.
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Firefox

Captures the URL of the current tab. (For some users, Firefox 3 and later will report an error
when EagleFiler asks it for the URL. If this happens, you can import the page by dragging
and dropping the URL into EagleFiler. To make it easier to drag URLs from Firefox, see this
page81.)

Flock

Captures the URL of the current tab.

Google Chrome

Captures the URL of the current tab.

Hibari

Captures the URL of the selected tweet. (Direct messages are not supported.)

iCab

Captures the URL of the front window.

Journler

Captures the selected documents, preserving the tags, category, comments, and label.

Keynote

Captures the file of the front window.

Mail

Captures the selected messages in the front viewer window. Tags, projects, and annotations
from MailTags82 are preserved, as are the unread/flagged/replied/etc. flags from Mail itself.
If Growl83 is installed, it will report on the progress of the capture.

Mailsmith

Captures the selected messages or mailboxes, preserving the message status, label, and notes.
You may find it helpful to use Email Archiver84 to separate messages by age before importing
them into EagleFiler.

MarsEdit

Captures the text of current post window or the selected posts, preserving the permalink and
the published date.

MindManager

Captures the file of the front window.
81http://support.mozilla.org/en-US/questions/879926
82http://www.indev.ca/MailTags.html
83http://growl.info
84http://www.garrison.com.au/freeware/emailarchiver.html
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Netflix Freak

Captures the URLs of the selected movies.

NetNewsWire

Captures the URL of the current tab, or the URL of the selected headline (if no tab is
selected). If text is selected in a Web page, EagleFiler adds it as a note.

NewsRack

Captures the URL of the current tab and puts the selected text in a note.

Nisus Writer Express

Captures the file of the front window.

OmniGraffle

Captures the file of the front window. For best results, set OmniGraffle to save its documents
with a Quick Look preview.

OmniWeb

Captures the URL of the current tab.

Opera

Captures the URL of the current tab.

Outlook

Captures the selected messages or mailbox, preserving the message flags, read status, and
categories. If you want EagleFiler to skip a message, you can assign it the category “Omit-
FromArchive”.

Pages

Captures the file of the front window.

Path Finder

Captures the selected files in the front window.

PDFView

Captures the file of the front window.

PowerMail

Captures the selected messages or mailboxes, preserving the message status and label

Preview

Captures the frontmost document.

Pukka

Captures URL being added, along with the title, tags, and description.
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Safari

Captures the URL of the current tab and puts the selected text in a note. Some Web pages
(e.g. some sites that require logging in) cannot be captured by loading the URL shown in
Safari’s location bar. You can import such pages into EagleFiler by using Safari’s File .
Save As. . . command to save the page as a Web archive (perhaps into the To Import folder
of an EagleFiler library), or by choosing File . Print and then selecting Save PDF to
EagleFiler from the PDF button menu.

Skim

Captures the file of the front window.

SubEthaEdit

Captures the file of the front window.

TextEdit

Captures the file of the front window.

TextMate

Captures the file of the front window.

TextWrangler

Captures the file of the first document of the front window.

Together

Captures the selected files, preserving the tags, comments, labels, and ratings.

Vienna

Captures the URL of the last selected post.

WebKit Nightly

See description for Safari.

WebnoteHappy

Captures the selected URLs as Web archives, preserving the tags and notes.

Word (2004 and later)

Captures the file of the front window (make sure that it’s saved to disk).

Yojimbo

Captures the selected items, preserving the tags, labels, flagged state, and comments.

For applications that are not listed here, there are many other ways to import. For applications
that support AppleScript, you can add EagleFiler capture support by writing capture scripts.

101

http://www.apple.com/macosx/features/safari/
http://skim-app.sourceforge.net
http://www.codingmonkeys.de/subethaedit/
http://www.apple.com/support/mac101/work/23/
http://macromates.com/
http://www.barebones.com/products/textwrangler/
http://reinventedsoftware.com/together/
http://www.vienna-rss.org
http://nightly.webkit.org
http://www.happyapps.com/webnotehappy/
http://www.microsoft.com/mac/products/Word2008/default.mspx
http://www.barebones.com/products/yojimbo/


7.3 Writing Capture Scripts

You can extend EagleFiler’s capture key to support additional applications by adding capture
scripts to the folder:

/Users/<username>/Library/Application Support/EagleFiler/Capture Scripts/

(To open the Library folder under Mac OS X 10.7 Lion, go to the Go menu in the Finder and hold
down the Option key.) A capture script is an AppleScript saved in compiled format. The name of the
file is of the form <bundle identifier>.scpt, e.g. com.apple.Safari.scpt. You can determine
an application’s bundle identifier by finding the CFBundleIdentifier in the Info.plist file inside
the application’s package (which you can open using the Show Package Contents command
when Control-clicking on the application).

The script should have a handler called capture that returns a list of AppleScript records. Each
record in the list should have a |url| key (for a remote http URL) or a |path| key (for a full
POSIX path). If no items are available for capture, the script can return the empty list, or it can
return a record with a |error| key that provides an application-specific error message.

Other, optional, keys are:

|deleteWhenDone|

If the script creates a temporary file for the capture, it can include this key with value true
so that EagleFiler will delete the temporary file after it has finished importing the file.

|fromName|

Overrides the From name that would be extracted from the file.

|note|

A string for the note text.

|sourceURL|

The URL that the document was downloaded from.

|tags|

A list of tag names.

|tagsString|

A Unicode string of space-separated tag names, which EagleFiler will parse.

|title|

Overrides the title that would be extracted from the file.

|creationDate|

Sets the creation date of the file.
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|modificationDate|

Sets the modification date of the file.

|webPageFormat|

Overrides the format chosen in EagleFiler’s preferences. Must be one of: pdf, pdfSinglePage,
rtf, rtfd, txt, webarchive, webloc.

Example: NetNewsWire

The NetNewsWire capture script looks like:

on capture()
tell application "NetNewsWire"

set tabIndex to index of selected tab
set tagNames to {}
set title to ""
set note to ""
if tabIndex is 0 then

if exists selectedHeadline then
set url to URL of selectedHeadline
set title to title of selectedHeadline
try

get title
on error

set title to ""
end try
if isFlagged of selectedHeadline then

set tagNames to {"flagged"}
end if

else
return {{|error|:"No URL is available to be captured."}}

end if
else

set urls to URLs of tabs
try

set url to item ( tabIndex + 1) of urls
set titles to titles of tabs
set title to item ( tabIndex + 1) of titles
try

set note to do JavaScript "window.getSelection().toString()"
end try

on error
return {{|error|:"EagleFiler could not access the current tab due to a bug in NetNewsWire. Please try closing any blank tabs."}}

end try
end if
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end tell
return {{|url|: url, tags: tagNames, title: title, |note|: note}}

end capture

Example: Finder

The capture script for the Finder demonstrates how to capture multiple items at once:

on capture()
tell application "Finder"

set theSelection to selection as list
set theResult to {}
repeat with theFile in theSelection

set theFile to theFile as alias
copy {|path|:POSIX path of theFile} to end of theResult

end repeat
return theResult

end tell
end capture

7.4 Writing Stationery Scripts

The New Record . Open Stationery Folder section describes the basics of EagleFiler’s stationery
feature. You can also write stationery AppleScripts to set the filename and metadata. This provides
more control—for example, you can set a title that’s distinct from the filename. It also lets you
set the metadata dynamically—that is, it can be determined when making new records from the
stationery rather than when the stationery is first created. Therefore, the metadata can be based on
the current date, the current user, the current iTunes track or chat status, or any other information
that’s accessible via AppleScript.

Where to Put Stationery Scripts

To set the metadata via AppleScript, create a compiled script file next to your stationery file. If the
stationery file is Journal Entry.rtf, the script should be called Journal Entry.efmeta.scpt.
EagleFiler will automatically run the script when you create a new record from the Journal
Entry.rtf stationery.

Example Stationery Script

Here’s an example script:

on metadata( context)
set title to "Blog Entry"
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set base to do shell script "date ’+%A, %B %d, %Y’"
set systemInfo to system info
set from to long user name of systemInfo
set tags to {"journal", "draft"}
return {|title|: title, |basename|: base, |fromName|: from, |tags|: tags}

end metadata

This would set the title to “Blog Entry”, the filename would be based on the current date (e.g.
“Tuesday, October 21, 2008.rtf”), the from would be the name of the user logged into the Mac (e.g.
“John Appleseed”), and the tags would be “journal” and “draft”.

Stationery Script Details

The script should contain a handler called metadata with a single context parameter.

The context is an AppleScript record containing the following keys: |folderName|, |libaryPath|,
|stationeryBasename|, |stationeryName|, and |stationeryPath|. The script can ignore the
context, or it can use it to find out about the stationery file and where the record will be created.

The metadata handler should return an AppleScript record containing one or more of the following
keys: |basename|, |fromName|, |note|, |sourceURL|, |tags|, |title|.

8 Frequently Asked Questions

8.1 How can I access my library from multiple Macs?

There are several different ways of sharing an EagleFiler library among multiple Macs. The general
guideline is that you should only open the library in one copy of EagleFiler at a time, although you
can access the individual files (and add new files) from multiple computers simultaneously (using
the Finder and other applications). Most of these techniques will also work for sharing your files
with a Windows PC or iPhone OS device. For more information, please see the How can I put my
library on my iPhone? page.

Portable Drives

EagleFiler library folders can be stored wherever you want. You can take a library with you
by keeping it on a USB keychain drive, iPhone, iPad, iPod, or external hard drive.

Dropbox

Dropbox85 is a free service for sharing files between Macs and accessing them from the Web or
an iPhone or iPad. It is the recommended cloud storage for use with EagleFiler. After editing
your library with one Mac, make sure that both it and the second Mac have fully synced with

85http://www.dropbox.com
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the Dropbox server (that is, the icon in the menubar no longer shows spinning arrows) before
opening the library on the second Mac. To make sure that your files’ metadata86 is synced,
use Dropbox 1.0 or later87. If you don’t want to put your whole library on Dropbox, you can
create a symbolic link inside the Dropbox folder that links to the EagleFiler folder that you
want to store on Dropbox.

OmniPresence

OmniPresence88 is a Dropbox-like service that can also work with your own WebDAV server.
Like Dropbox, you must wait for it to finish syncing before opening a library or shutting down
your Mac. OmniPresence does not preserve file metadata such as colored labels or extended
attributes.

Google Drive

Google Drive is a Dropbox-like service. In our testing, it was slow, unreliable, and did not
preserve file metadata. Thus, it is not recommended for use with EagleFiler.

SugarSync and Dropbox Prior to 0.8

SugarSync89 is a free service for sharing files between Macs and accessing them from the Web
or an iPhone or iPad. After editing your library with one Mac, make sure that both it and
the second Mac have fully synced with the server before opening the library on the second
Mac.

Note: SugarSync currently has limited support for Mac files. It do not support90 resource
forks, extended attributes, bundle bits, or other HFS metadata. SugarSync does not support
filenames containing : at the Unix level (/ in the Finder). EagleFiler does not require support
for this metadata. However, you should be aware that if you set file labels or custom icons,
these will be lost when syncing with Dropbox or SugarSync. Additionally, if you use EagleFiler
to organize files that contain resource forks (such as some sound or font files, old NisusWriter
files, etc.) they will become unusable after syncing. If you have detailed knowledge of what
kind of metadata your files have, and whether it needs to be preserved, you can decide for
yourself whether or not this is a problem for you. If in doubt, you should use an encrypted
library (see below).

File and Web Sharing

Mac OS X’s built-in file sharing and Web sharing can be used to make your library available
on other Macs. Just make sure that the library folder is stored in a folder that’s set up for
file sharing (e.g. Public) or Web sharing (e.g. Sites) and that sharing is enabled in System
Preferences.

Note: Accessing a library over the network via file sharing is generally slower than using an
Dropbox or SugarSync.

86http://forums.dropbox.com/topic.php?id=17226&replies=188
87http://blog.dropbox.com/?p=581
88http://www.omnigroup.com/omnipresence/
89http://www.sugarsync.com
90http://support.sugarsync.com/ics/support/default.asp?deptID=4579&task=knowledge&questionID=361
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Encrypted Libraries

If you use the New Library. . . command create an encrypted EagleFiler library, EagleFiler will
wrap up your library and all its files into a disk image that preserves all the metadata. Be sure
to eject the disk image after closing the library in EagleFiler. This causes the OS to save all the
information to disk so that it can be synced properly. (You can use the Close & Lock command to
do this in one step.)

Note: Encrypted libraries can only be accessed from a Mac, not from the Web or an iPhone or
iPad.

8.2 How can I put my library on my iPhone?

EagleFiler stores your files in standard formats, and the iPhone OS can read most of them. There
are several different ways to store your library so that it can be shared between a Mac, iPhone,
iPad, and iPod touch.

Cloud Storage and Provider

You can store your EagleFiler library on your Mac, sync it with the cloud, and then access it
from one of these apps:

• Dropbox91. Recommended. The syncing is simple and fast. Free for up to 2 GB. Please
see the notes about using Dropbox with EagleFiler.

• SugarSync is a cloud service that’s similar to Dropbox but with a few drawbacks.

Cloud Storage Access

These apps let you access cloud storage from another provider such as Dropbox or MobileMe:

• Notesy92 supports editing of text files on Dropbox. Recommended.

• PlainText93 supports editing text files on Dropbox, with TextExpander touch support.

• Quickoffice Connect Mobile Suite94. Supports editing of Microsoft Word and Excel files.

• Office295 and Office2 HD96. Supports editing of Microsoft Word and Excel files.

• Droptext97 supports editing text files on Dropbox.
91http://www.dropbox.com/iphoneapp
92http://notesy-app.com
93http://www.hogbaysoftware.com/products/plaintext
94http://www.quickoffice.com/quickoffice connect suite iphone/
95http://itunes.apple.com/us/app/id364361728?mt=8
96http://itunes.apple.com/us/app/id350399839?mt=8
97http://itunes.apple.com/us/app/droptext/id371880635?mt=8
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• Elements98 supports editing text files on Dropbox, with Markdown and TextExpander
touch support.

• Air Sharing Pro99 and Air Sharing HD100

• Good Reader101

• ReaddleDocs102 and ReaddleDocs for iPad103

• Mobile Disk104

• MobileFiles105

• OneDisk106

• Quickword107

Device Storage

You can store your EagleFiler library on an iPhone and share it with your Mac (via Wi-Fi)
using one of these apps:

• Air Sharing108, Air Sharing Pro109, and Air Sharing HD110. Recommended. Great in-
terface, and EagleFiler can directly work with libraries that are stored on the device.

• Good Reader111 Recommended. Nice PDF reader, and EagleFiler can directly work
with libraries that are stored on the device.

• Quickword112 Recommended. Supports editing of plain text and Microsoft Word files.

• ReaddleDocs113 and ReaddleDocs for iPad114

• DataCase115

• Files116

• FileMagnet117

• MobileStudio118

98http://www.secondgearsoftware.com/elements
99http://avatron.com/apps/air-sharing-pro/

100http://avatron.com/apps/air-sharing-hd/
101http://www.goodreader.net/goodreader.html
102http://readdle.com/products/readdledocs
103http://readdle.com/products/readdledocs ipad
104http://itunes.apple.com/WebObjects/MZStore.woa/wa/viewSoftware?id=295923448&mt=8
105http://www.quickoffice.com/mobilefiles/
106http://readdle.com/products/onedisk
107http://www.quickoffice.com/quickword iphone/
108http://avatron.com/apps/air-sharing/
109http://avatron.com/apps/air-sharing-pro/
110http://avatron.com/apps/air-sharing-hd/
111http://www.goodreader.net/goodreader.html
112http://www.quickoffice.com/quickword iphone/
113http://readdle.com/products/readdledocs
114http://readdle.com/products/readdledocs ipad
115http://www.veiosoft.com
116http://www.olivetoast.com/Files/
117http://www.magnetismstudios.com/filemagnet/
118http://www.pixiotech.com/Pixio - en/MobileStudio.html
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Other

• SyncBook119 is a pair of Mac and iPhone apps for viewing and editing notes. It can
integrate with EagleFiler via a symlink120.

8.3 How can I encrypt my files?

EagleFiler supports encryption at the library level. You can have multiple libraries, each of which is
either encrypted or not encrypted. An encrypted library works just like a normal library except that
all aspects of it (the files, notes, metadata, search indexes, and temporary files) are unreadable until
the proper passphrase has been entered. Each encrypted library can have a different passphrase.

When creating a New Library. . ., the Encrypt library using passphrase option lets you store
the library on an encrypted disk image. The entire library (including all the files, notes, and
indexes) will be stored in a disk image file that is encrypted using AES-128 or AES-256121.

You can choose the format and encryption level of the disk image:

Sparse Disk Image

Creates a .sparseimage file that’s compatible with Mac OS X 10.4 and later.

Sparse Bundle Disk Image

Creates a .sparsebundle package that requires Mac OS X 10.5 or later, but which is much
more efficient for backups. Note: Mac OS X does not support sparse bundle disk images on
certain volume types, so in those cases you would need to use a sparse disk image even if you
have a recent version of Mac OS X.

128-bit AES Encryption

Compatible with Mac OS X 10.4 or later. The U.S. National Security Agency (NSA) has
announced that it may be used for SECRET level documents.

256-bit AES Encryption

Requires Mac OS X 10.5 or later. It is slower but even more secure than AES-128. The NSA
has announced that it may be used for TOP SECRET level documents.

Maximum Library Size

An encrypted library will only consume the amount of disk space needed to hold its files, indexes,
and temporary files. However, you must set a maximum library size that controls how large the
library can grow. The larger the maximum size, the more overhead there is for encryption. For

119http://itunes.apple.com/us/app/syncbook/id290800829?mt=8
120http://c-command.com/forums/showpost.php?p=8635&postcount=3
121http://en.wikipedia.org/wiki/Advanced Encryption Standard#Security of AES
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example, a library with a 1 GB maximum size will have about 26 MB of overhead, while a library
with 500 GB maximum size will have about 111 MB of overhead. If your library reaches the
maximum size, you can create a new, larger library and copy all of the files to it by dragging the
Records source from the old library to the new one.

Opening an Encrypted Library

To access the library, double-click the disk image file and enter the library’s passphrase. The library
will appear as a white icon on your desktop, and you can double-click the .eflibrary file to open
it in EagleFiler. (You can also access all the files in the library directly from the Finder.) When
you’re done with the library, close it in EagleFiler and eject the library from your desktop to lock
it again. Now it can only be accessed by people who know the passphrase. For more information,
please see the Open Library. . . section.

When you’re done using an encrypted library, choose Close & Lock from the File menu.

Changing the Passphrase

To change the passphrase of an encrypted library, eject the library, then open Disk Utility. Drag
the library’s disk image file into Disk Utility’s device list, at the left of the window. Select the disk
image in the list and choose Images . Change Password.

8.4 How can I run optical character recognition (OCR) on my PDFs?

If you’re trying to run a paperless office, the first step is getting your papers scanned into your
Mac. We recommend Fujitsu ScanSnap122 scanners as the easiest way to create a multi-page PDF
from a stack of papers.

The second (optional) step is to use optical character recognition (OCR)123 to make the text in
the scanned PDFs searchable and selectable. The easiest way to do this is to use Smile Software’s
PDFpen124 to add a text layer to your PDF. You can do this directly in PDFpen, but it’s easier
to automate the process via AppleScript. To do this, download the OCR With PDFpen125 script
in compiled format. There are several ways you can use this script:

EagleFiler’s script menu

Follow the instructions on the AppleScripting EagleFiler page, then save the script file into
the the folder to add the OCR With PDFpen command to the script menu. Then you can
simply select PDF files in EagleFiler and choose OCR With PDFpen.

Drag and drop
122http://www.fujitsu.com/us/services/computing/peripherals/scanners/scansnap/scansnap-s1500m.html
123http://en.wikipedia.org/wiki/Optical character recognition
124http://www.smilesoftware.com/PDFpen/
125http://c-command.com/scripts/eaglefiler/ocr-with-pdfpen
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Use AppleScript Editor to save the script as an application. Then drag and drop PDF files
onto it to OCR them and then import them into EagleFiler.

Direct from ScanSnap

Save the script as an application and set it as the target of your scanner’s software. For
example, go to the Application tab of the ScanSnap Manager’s settings, click Add or
Remove, and choose the script application. The scanned files will be run through OCR and
then imported into EagleFiler.

Folder action

Attach the script to a folder as a folder action and save files into that folder.

8.5 How can I move messages between mailboxes?

In order to improve performance and make more efficient use of disk space, EagleFiler prefers to
store e-mail messages in mailbox files (using the standard “mbox” format), and it does not allow
them to be moved from one mailbox to another. Thus, it is best to organize messages into the
mailboxes that you want (and to delete messages that you don’t want to save) before importing
them into EagleFiler. Nevertheless, several organization options are available once your messages
are in an EagleFiler library:

1. You can merge multiple mailboxes into one. For example, if each month you import
mailbox A into EagleFiler, you’ll end up with lots of A mailboxes in the library, each
containing one month’s worth of messages. By merging all of the A mailboxes into one,
you can reduce visual clutter and make EagleFiler run more efficiently.

2. You can drag messages from mailboxes to folders. This deletes the messages from the
mailbox and stores the messages as individual .eml files in the folder. This is not as
efficient as storing one file per mailbox, but it allows for more flexible organization.

3. You can organize messages (from different mailboxes) into tag sources. As with playlists
in iTunes, each message can be in more than one tag source at a time.

4. The easiest way to avoid storing duplicate messages is to delete messages in your mail
program after you’ve imported them into EagleFiler. You can also delete individual
messages from an EagleFiler mailbox, although this will not save disk space; it will only
hide the messages from view.

8.6 How can I copy my tags to another library?

Once you’ve created some tags and set them up the way you want, it’s easy to use them in another
library:
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1. Create a new RTF file and select it.

2. Open the Tags window and assign the desired tags to the file.

3. Drag the file into the other library.

EagleFiler will transfer the tags (along with their abbreviations, colors, and hierarchy) to the other
library. This is really just a special case of a general EagleFiler feature that metadata (tags, notes,
titles, etc.) are preserved when copying files between libraries.

8.7 Why does EagleFiler import the wrong Web page when I press the capture
key?

Some Web pages cannot be loaded only by URL. These pages require session state, e.g. entering a
password, logging in, and then clicking a link to get to the page. When you try to capture one of
these pages, EagleFiler will import the site’s login page, since that’s what the server produces when
EagleFiler requests the URL. (An easy way to see that this has happened is to install Growl126;
EagleFiler will then show a thumbnail preview of each Web page that you capture, so you can see
whether it looks right.)

To import these types of pages, see the Private Web Pages section.

8.8 How can I speed up EagleFiler?

Getting a faster Mac, a faster hard disk (or SSD), or more RAM would of course make everything
faster, but there are also some less expensive ways to speed up EagleFiler:

1. EagleFiler is designed to perform best when it is kept running, with a library open. It
will be faster to leave it running (perhaps hidden) in the background than to open and
close it each time you add a file to the library. You can easily hide EagleFiler by holding
down the Option key as you click to switch to another application. Additionally, leaving
EagleFiler running will allow you to use its capture key.

2. Importing files by dragging them directly into the library’s Files folder and then using
Scan for New Files is faster than other methods because it avoids copying the files. Also,
this method (as well as the To Import folder) do not require you to wait for EagleFiler
to launch and the library to open.

3. EagleFiler is designed to support multi-gigabyte libraries with many thousands of files.
However, as with all software, viewing a library (or folder) with fewer files in it will
generally be faster than viewing one with many. (The sizes of the files don’t have much
effect on EagleFiler’s performance.) EagleFiler lets you create multiple libraries, so one

126http://growl.info
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way to increase performance is to use several smaller libraries instead of one huge one.
This can also provide an additional level of organization.

4. Fewer large mailboxes are generally faster than many small ones. You can combine
multiple mailboxes using the Merge Mailboxes command.

5. Leave e-mail messages in their mailboxes rather than dragging them out into folders
(which converts them to individual files). You can merge .eml files back into a mailbox
using the Merge Message Files command.

6. Emptying EagleFiler’s trash will reduce the number of records in the library, and thus
speed it up.

7. Importing files is faster when nothing is selected in the source list and the Activity
window is closed.

8. In order to enable quick searching, EagleFiler maintains indexes of all the files and
e-mail messages in a library. By default, EagleFiler indexes for phrase searches. This
allows the most flexible searching, but indexing can take a lot of time and disk space.
If you don’t need to do phrase searches, you can rebuild the indexes for word searching.
This will reduce the size of the indexes and speed up indexing going forward.

9. Viewing search results in large documents will be faster if you turn off search match
highlighting.

10. When EagleFiler opens a library, it checks to make sure all of the files are present, backs
up the metadata, and copies the tags to the Spotlight comments. You can hold down
the Shift key when opening the library to skip these steps, or click the × buttons in the
Activity window to cancel them.

11. Displaying and scrolling the records list will be faster if you tell EagleFiler not to
calculate folder sizes.

12. Opening a library will be faster if the selected source (when you closed the library) does
not contain many files. For example, if you had Records selected, and it was sorted by
modification date, EagleFiler would have to load all the files (and possibly all the e-mail
messages) and look up their modification dates. If a subfolder (or no source at all) were
selected, the library would open more quickly because EagleFiler would initially only
have to load the contents of that folder.

13. When creating a smart folder, put the most restrictive criteria higher in the list. Use the
Search inside pop-up menu and checkboxes to restrict the search as much as possible.

14. Searching is faster if you tell EagleFiler to search for whole words rather than partial
words.

15. Searching is faster if EagleFiler’s index files (the .efindex files inside the .eflibrary
package) have been defragmented using a utility such as iDefrag127.

16. Uncheck Copy tags to Spotlight comments.
127http://www.coriolis-systems.com/iDefrag.php
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8.9 Why doesn’t my serial number work?

You need to enter the serial name and serial number exactly as they appear on your order confir-
mation e-mail. If you no longer have this e-mail, you can look up the name and number. Launch
EagleFiler and choose Purchase from the EagleFiler menu. Then click the Look Up My Serial
Number button.

8.10 What information should I include when I report a problem?

It will be faster and easier to help you if your e-mail includes the following information:

The version of Mac OS X that you are using

Click on the Apple menu and choose About This Mac.

The version of EagleFiler that you are using

Click on the EagleFiler menu and choose About EagleFiler. (Please do not say “the latest
version,” as this is ambiguous.)

Do you have the Mac App Store version?

Click on the EagleFiler menu and choose About EagleFiler. It will say “Mac App Store”
at the bottom of the window.

Specific error information

Please see Sending in an Error Report.

If something isn’t working as you expect

Please describe what you did, what happened, and what you expected to happen instead. If
possible, take a screenshot or two that illustrate the problem (see Sending in Screenshots).

If EagleFiler hangs or freezes

Please see Sending in a “Sample” Report.

8.10.1 Sending in an Error Report

If an error window appeared on your screen, please include the exact text of the error message in
your e-mail. (It may help to use Copy and Paste.)

Please also send in any errors that were reported in the system log:

1. Click on Finder in the Dock.

2. From the Go menu, choose Utilities.
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3. Double-click the Console application.

4. Click on All Messages at the left of the window.

5. If it shows any recent error messages, select them (or choose Edit . Select All).

Note: You may need to click the Earlier button at the bottom of the window to find
errors that did not occur recently.

6. Choose File . Save Selection As. . . and save the file as My Log.log on your desktop.

7. Drag this file into your e-mail message to attach it.

8.10.2 Sending in Screenshots

To take a screenshot, hold down the Apple and Shift keys and press the number 4. Then use the
mouse to select the area of the screen that you want to take a picture of. This will create a file
called Picture 1 on your desktop. Pressing the keys again will create Picture 2, etc. You can
drag these into the e-mail window to attach them to your message. If you’re using Apple Mail, be
sure to set the Image Size pop-up menu at the bottom of the message window to Actual Size.

8.10.3 Sending in a “Sample” Report

If a program is slow, hangs, or freezes, a “sample” report can record what your Mac was doing in
order to locate the source of the problem.

1. Click on Finder in the Dock.

2. From the Go menu, choose Utilities.

3. Double-click the Activity Monitor program.

4. Select EagleFiler in the Activity Monitor window.

5. Do whatever it is in EagleFiler that causes the slowness, hang, or freeze. Immediately,
click on Activity Monitor in the Dock and choose Sample Process from the View
menu.

6. After Activity Monitor has finished taking the sample, click the Save. . . button in the
“Sample of EagleFiler” window. Save the file to your desktop and then include it in
your e-mail message as an attachment. (Please do not copy and paste the text from the
Activity Monitor window.)
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9 Legal Stuff

Distribution

Please distribute the unmodified EagleFiler-1.6.dmg file on the Web, LANs, compilation CD-
ROMs, etc. You may not charge for it (beyond a reasonable cost for media) or distribute the
contents of the disk image file in isolation. You may not distribute your serial number.

Limited Warranty

The software is provided “as is,” without warranty of any kind, express or implied, including but not
limited to the warranties of merchantability, fitness for a particular purpose and noninfringement.
In no event shall the authors or copyright holders be liable for any claim, damages or other liability,
whether in an action of contract, tort or otherwise, arising from, out of or in connection with the
software or the use or other dealings in the software.

License

A license for EagleFiler is good for one person or one computer. You may install it on one Mac,
and everyone sharing that Mac may use it (on that Mac). Alternatively, you may install it and
use it on multiple Macs (e.g. your desktop Mac and your laptop); then you (and no one else) may
use it on any of those Macs. For multiple users on multiple Macs, you should purchase multiple
licenses.

Copyright and Trademarks

EagleFiler and this manual are copyright c© 2002–2013 by C-Command Software128. All rights
reserved.

EagleFiler is a trademark of C-Command Software. Mac is a registered trademark of Apple Com-
puter. All other products mentioned are trademarks of their respective owners.

Components

The following open-source components are used in EagleFiler:

• Regular expression support is provided by the PCRE129 library package, which is open source
software, written by Philip Hazel, and copyright by the University of Cambridge, England.

• Core Foundation130 is available under the terms of the Apple Public Source License131.

• Growl132 is Copyright c© The Growl Project, 2004-2007 All rights reserved.
128mailto:mjt@c-command.com
129http://www.pcre.org
130http://www.opensource.apple.com/darwinsource/10.4.10.x86/CF-368.28/
131http://www.opensource.apple.com/apsl/
132http://growl.info
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Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. Neither the name of Growl nor the names of its contributors may be used to en-
dorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBU-
TORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, IN-
DIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHER-
WISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

• Thanks to Allan Odgaard for some code snippets that are used in the Software Update
installer.

• libffi133: Copyright c© 1996-2003 Red Hat, Inc.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the “Software”), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT. IN NO EVENT SHALL CYGNUS SOLUTIONS BE LIABLE FOR ANY
CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CON-
TRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION
WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.

133http://sourceware.org/libffi/
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• PTHotKey134: Copyright (c) 2003-2004 Rogue Amoeba Software LLC, Quentin D. Carnicelli,
Finlay Dobbie, Vincent Pottier

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the “Software”), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so.

THE SOFTWARE IS PROVIDED “AS IS,” WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

• PyObjC135: Copyright 2002, 2003 - Bill Bumgarner, Ronald Oussoren, Steve Majewski, Lele
Gaifax, et.al.

Permission is hereby granted, free of charge, to any person obtaining a copy of this software
and associated documentation files (the “Software”), to deal in the Software without restric-
tion, including without limitation the rights to use, copy, modify, merge, publish, distribute,
sublicense, and/or sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, subject to the following conditions:

The above copyright notice and this permission notice shall be included in all copies or
substantial portions of the Software.

THE SOFTWARE IS PROVIDED “AS IS”, WITHOUT WARRANTY OF ANY KIND,
EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONIN-
FRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS
BE LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN
CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE
SOFTWARE.

• Python136:

1. This LICENSE AGREEMENT is between the Python Software Foundation (“PSF”),
and the Individual or Organization (“Licensee”) accessing and otherwise using this
software (“Python”) in source or binary form and its associated documentation.

2. Subject to the terms and conditions of this License Agreement, PSF hereby grants
Licensee a nonexclusive, royalty-free, world-wide license to reproduce, analyze, test,
perform and/or display publicly, prepare derivative works, distribute, and otherwise

134http://www.rogueamoeba.com/utm/posts/Random/Homegrown Developer Tools-2004-07-14-12-00
135http://pyobjc.sourceforge.net/
136http://www.python.org/
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use Python alone or in any derivative version, provided, however, that PSF’s License
Agreement and PSF’s notice of copyright, i.e., “Copyright c© 2001, 2002, 2003,
2004, 2005, 2006 Python Software Foundation; All Rights Reserved” are retained
in Python alone or in any derivative version prepared by Licensee.

3. In the event Licensee prepares a derivative work that is based on or incorporates
Python or any part thereof, and wants to make the derivative work available to
others as provided herein, then Licensee hereby agrees to include in any such work
a brief summary of the changes made to Python.

4. PSF is making Python available to Licensee on an “AS IS” basis. PSF MAKES
NO REPRESENTATIONS OR WARRANTIES, EXPRESS OR IMPLIED. BY
WAY OF EXAMPLE, BUT NOT LIMITATION, PSF MAKES NO AND DIS-
CLAIMS ANY REPRESENTATION OR WARRANTY OF MERCHANTABIL-
ITY OR FITNESS FOR ANY PARTICULAR PURPOSE OR THAT THE USE
OF PYTHON WILL NOT INFRINGE ANY THIRD PARTY RIGHTS.

5. PSF SHALL NOT BE LIABLE TO LICENSEE OR ANY OTHER USERS OF
PYTHON FOR ANY INCIDENTAL, SPECIAL, OR CONSEQUENTIAL DAM-
AGES OR LOSS AS A RESULT OF MODIFYING, DISTRIBUTING, OR OTH-
ERWISE USING PYTHON, OR ANY DERIVATIVE THEREOF, EVEN IF AD-
VISED OF THE POSSIBILITY THEREOF.

6. This License Agreement will automatically terminate upon a material breach of its
terms and conditions.

7. Nothing in this License Agreement shall be deemed to create any relationship of
agency, partnership, or joint venture between PSF and Licensee. This License
Agreement does not grant permission to use PSF trademarks or trade name in a
trademark sense to endorse or promote products or services of Licensee, or any
third party.

8. By copying, installing or otherwise using Python, Licensee agrees to be bound by
the terms and conditions of this License Agreement.

• Shortcut Recorder137:

Copyright (c) 2006, contributors to ShortcutRecorder. (See the contributors138.)

All rights reserved. Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are met:

– Redistributions of source code must retain the above copyright notice, this list of condi-
tions and the following disclaimer.

– Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

– The name of the contributors may not be used to endorse or promote products derived
from this software without specific prior written permission.

137http://wafflesoftware.net/shortcut/
138http://wafflesoftware.net/shortcut/contributors/
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THIS SOFTWARE IS PROVIDED BY THE CONTRIBUTORS “AS IS” AND ANY EX-
PRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IM-
PLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE CONTRIBUTORS BE LI-
ABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCURE-
MENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS;
OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LI-
ABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

• SkimNotes139:

Copyright (c) 2008, Christiaan Hofman and contributors

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions
and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of con-
ditions and the following disclaimer in the documentation and/or other materials provided
with the distribution.

Neither the name of Christiaan Hofman nor the names of any other contributors may be
used to endorse or promote products derived from this software without specific prior written
permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBU-
TORS “AS IS” AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT
NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FIT-
NESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL
THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, IN-
DIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES
(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CON-
TRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHER-
WISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF
ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

• vobject140: Copyright (c) 2004-2006 Jeffrey Harris. All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permit-
ted provided that the following conditions are met:

139http://skim-app.sourceforge.net
140http://vobject.skyhouseconsulting.com/
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1. Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright notice, this
list of conditions and the following disclaimer in the documentation and/or other
materials provided with the distribution.

3. The end-user documentation included with the redistribution, if any, must include
the following acknowledgment: “This product includes software developed by the
Apache Software Foundation (http://www.apache.org/141).” Alternately, this ac-
knowledgment may appear in the software itself, if and wherever such third-party
acknowledgments normally appear.

4. The names “Apache” and “Apache Software Foundation” must not be used to
endorse or promote products derived from this software without prior written per-
mission. For written permission, please contact apache@apache.org142.

5. Products derived from this software may not be called “Apache”, nor may “Apache”
appear in their name, without prior written permission of the Apache Software
Foundation.

THIS SOFTWARE IS PROVIDED “AS IS” AND ANY EXPRESSED OR IMPLIED WAR-
RANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE APACHE SOFTWARE FOUNDATION OR ITS CONTRIB-
UTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEM-
PLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THE-
ORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (IN-
CLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

This software consists of voluntary contributions made by many individuals on behalf of the
Apache Software Foundation. For more information on the Apache Software Foundation,
please see http://www.apache.org/143.

Portions of this software are based upon public domain software originally written at the
National Center for Supercomputing Applications, University of Illinois, Urbana-Champaign.

10 Version History

1.6—August 2, 2013

Highlights
141http://www.apache.org/
142mailto:apache@apache.org
143http://www.apache.org/
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• The user interface is now optimized for Retina displays. Most of the icons have been
enhanced or replaced.
• There are new toolbar buttons for creating plain text files, creating new files from

stationery, setting a file’s label, opening the Tag Cloud window, and accessing the
system Share menu. Various toolbar buttons have been combined into pairs.
• Made a variety of improvements so that the operations that happen after you open a

library are faster and have less impact on foreground responsiveness. This includes
loading file metadata, checking whether the indexes are up-to-date, checking for
missing files, and copying tags to OpenMeta and Spotlight comments.
• Improved the display of the following file types: Microsoft Excel, Microsoft Power-

Point, Keynote, Numbers, Pages, OmniOutliner, podcasts, chats, SVG files, Pear
Note documents, .emlx files, images, and more.
• When searching a selected folder or tag, EagleFiler now also searches the folders

and mailboxes inside that folder, or the subtags of that tag. (The old behavior of
only searching one level can be restored by unchecking Search Contained Fold-
ers/Mailboxes/Tags in the search field menu.)
• Added support for negative tag searches via the - or ! syntax. For example, you

can do a Tags search for unread -flagged to find the unread records that are not
flagged. Or you can do an Anywhere search for tag:!apple steve to find records
containing the word apple that do not have the tag steve.
• When you create a new file inside a smart folder, EagleFiler now applies the smart

folder’s actions to it (e.g. to assign tags, set the label, or move it to a particular
folder).

Importing

• EagleFiler’s capture key now works in Evernote144. You can use the EvernoteCaptureFormat
esoteric preference if you only want to capture a link to the Evernote items.
• The New Record . From Clipboard command now works when the clipboard con-

tains an image. In this case, it creates a PNG file instead of an RTF/RTFD file.
• The user interface no longer blocks while EagleFiler checks the To Import folder.
• When importing, EagleFiler will now correct PDF files that are missing their exten-

sion.
• EagleFiler will now detect if Microsoft Outlook doesn’t export the body data for

a message, which can happen with messages imported from the Windows version
of Outlook. You can choose to import just the message’s headers or to skip the
message and import it in another way.
• Added support for AudioNote145 files.
• When importing a Web page fails, EagleFiler is better at reporting which resource

was the problem.
• When fetching a URL that’s redirected (e.g. via a feed proxy) EagleFiler now stores

the final URL as the source URL, as this is more meaningful.
144http://evernote.com
145http://luminantsoftware.com
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• The Importing Web Pages and URLs section of the manual now explains how you can
set EagleFiler to process Web pages using the Instapaper Mobilizer before importing
them.
• Updated the instructions for making Preview scriptable146.
• When importing, files with title “Untitled” are now treated as having no title, so

that the title is linked to the filename.

Mail

• When you capture a single selected e-mail message, EagleFiler now imports it as
a .eml file, rather than as a mailbox containing only one message. This can be
changed via the ImportLoneMessageAsMailbox esoteric preference.
• The Remove Duplicate Messages script147 lets you remove duplicate e-mail messages

from a mailbox.
• EagleFiler can now open e-mail messages with Sparrow148.
• EagleFiler now shows a warning if you ask it to extract a large number of messages

from a mailbox file to individual .eml files (as this is inefficient).
• If you capture a selection of messages that includes (exact) duplicates within the

same mailbox, EagleFiler now skips them. (Since recent versions of Apple Mail hide
duplicates, it may not be evident that you had any selected.)
• Improved the speed of capturing from Outlook, Entourage, Mailsmith, and Power-

Mail.
• When displaying a mailbox imported from a Mailman149 archive, EagleFiler can

now undo Mailman’s anti-spam measures to display the proper e-mail addresses.
• Added the Import From Outlook150 script.
• If there’s an error importing the tags for a message in Outlook, EagleFiler now offers

to option to skip the tags and import just the message itself.

Viewer

• EagleFiler is much more responsive when you’re typing.
• The record viewer now restores its state (scroll position and insertion point location)

if you edit the file in another application and then switch back to EagleFiler.
• EagleFiler can now repair certain damaged Apple Mail messages so that they display

properly.
• The keyboard shortcut for highlighting text is now Command-Control-H (to match

Preview).

Source List

• Updated the source list appearance, added Show/Hide buttons for the groups, etc.
• The Records icon now shows whether or not your library is encrypted.
• The source list contextual menu now has a Paste Icon command to more easily set

custom icons for folders.
146http://c-command.com/blog/2009/12/28/capture-from-preview/
147http://c-command.com/scripts/eaglefiler/remove-duplicate-messages
148http://sparrowmailapp.com
149http://www.gnu.org/software/mailman/
150http://c-command.com/scripts/eaglefiler/import-from-outlook
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• Added NetNewsWire-style arrow key support: press Right Arrow in the source list
to go to the records list; press Left Arrow in the records list to go to the source list.

Records List

• Dragging a record to another application now drags the record’s file rather than a
link; if you need a link, use the Copy Record Link command.
• Icon thumbnails for images are now loaded in the background and cached for better

performance.
• Added support for LaunchBar’s Instant Send151 feature.
• The File column can now accommodate longer filenames.
• When a window is in the background, EagleFiler no longer draws the label color for

selected rows across the entire row.
• Added the CommandOToOpenRecord esoteric preference, which lets you swap the

keyboard shortcuts for Open External Viewer and Open Library. . . so that.

Errors

• If a file is missing after a Verify, you can now click the Trash button in the Errors
window to delete it, without having to first reveal the record in the library.
• The Errors window now shows the full relative path for files that are missing.
• EagleFiler now reports separate errors for missing vs. damaged notes, and for a

missing note it can now show and reveal the file where the note was expected to be.
• If there are records in the trash whose files are missing, EagleFiler will now offer to

auto-delete them when opening the library.
• EagleFiler now updates the paths in the Errors window when you move a record.
• It’s now possible to Trash multiple records at once from the Errors window. You

can no longer move files to the trash that are already in the trash.
• The crash reporter can now make recommendations for you based on the contents

of the crash log.

AppleScript

• If you import via AppleScript with no library open, EagleFiler will now report an
error back to the script instead of just logging it.
• Capture scripts can now override the Web page format. (See Writing Capture

Scripts.)
• Documents now have an element for their windows.
• Tag objects now have an element for the records with that tag. This is much faster

than using an AppleScript whose clause.
• Querying the scripting properties of large numbers of records is much faster now.
• Added the create temporary folder script command, to make it easier to write

scripts that process files.
• Added the add folder script command, which makes it easier to create a new,

empty folder in a library.

Miscellaneous
151http://www.obdev.at/resources/launchbar/help/InstantSend.html

124

http://www.obdev.at/resources/launchbar/help/InstantSend.html


• EagleFiler now requires Mac OS X 10.6.8 or later.
• EagleFiler now tells the system that it can use the integrated GPU, which should

reduce battery use on newer MacBook Pros.
• The progress bar for loading the library is now determinate. Eliminated the delay

between when the progress bar was removed and the window was ready for use.
• Added preliminary support for tags on Mac OS X 10.9 Mavericks.
• When opening a library, EagleFiler now checks for missing note files, rather than

just missing files.
• If you have a file that’s troublesome or slow for EagleFiler to read, you can tag

it ef noindex to prevent EagleFiler from trying to index it. There’s also a new
UnindexedAttachmentNames default.
• When backing up metadata, the Activity window now shows the relative path of

each folder, rather than just the name.
• When displaying folder names in menus, EagleFiler now colors them according to

their labels.
• EagleFiler no longer changes a file’s modification date when you only modify the

metadata.
• EagleFiler now remembers which type of date was selected in the Info window.
• EagleFiler now displays file sizes using the system standard style (requires Mac OS

X 10.8 or later), and the file sizes themselves are more accurate.
• If an indexing process gets stuck, you can now see in Activity Monitor which file it

was working on.
• Quick Look and scanning for new files work better with symlinks.
• The Read and Flag toolbar items now have a fixed width so they don’t cause the

other buttons to move when the label changes.
• The Purchase window now shows a user icon that indicates whether it’s a single-

or multi-user purchase.
• The disk image is now optimized for Retina displays.
• Made various improvements to the manual.
• Added a link to the forum in the Help menu.
• Improved the localizations.

Bug Fixes

• Fixed a bug with the quoted text coloring for e-mails containing DOS-style line
breaks.
• Worked around an OS bug that could cause EagleFiler to freeze when selecting a

Web archive if a search was active.
• Fixed a bug importing from Apple Mail where EagleFiler would sometimes complain

that no viewer window was open when the Mail Perspectives152 plug-in was installed.
• Fixed a bug capturing from Contacts.
• Fixed a bug where the Highlight button was enabled when it shouldn’t have been.

152http://www.indev.ca/MailPerspectives.html
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• Fixed a bug where the PDF toolbar buttons weren’t always enabled correctly.
• Worked around an OS bug that could cause various operations to fail if a folder

contained a very large number of files.
• Fixed a bug where some information in the About EagleFiler window was dis-

played incorrectly.
• Fixed a bug where sometimes EagleFiler was unable to capture local Apple Mail

messages when running on Mac OS X 10.8.
• Worked around a bug in Mac OS X 10.8 that could prevent EagleFiler from import-

ing a large batch of messages from Entourage, Mailsmith, Outlook, or PowerMail.
• Automatic software updates no longer fail if Hazel153 is set to move files in the
Downloads folder.
• Fixed a bug where the Spotlight importer would report errors when running on OS

X 10.8.
• Fixed a bug where some OmniOutliner154 documents displayed as garbled text.
• Worked around a problem where Apple Mail could time out when importing lots of

messages at once.
• Worked around a bug in Mac OS X 10.8.2 that could cause EagleFiler to freeze

when importing a file or changing a tag.
• Fixed a bug where EagleFiler sometimes would not delete temporary files promptly

when importing from Apple Mail.
• Fixed a bug where error logging didn’t always work properly on Mac OS X 10.8.
• Fixed a bug in reporting errors when opening a library.
• Worked around an OS bug that could cause Spotlight comments to be lost when

using the To Import folder.
• Fixed a bug where it was possible to end up with two equivalent tags whose names

had different Unicode normalizations.
• Worked around an OS bug that could cause EagleFiler to capture the wrong file

from the Finder.
• Worked around some PDF and icon display bugs that were introduced in Mac OS

X 10.7.4.
• Fixed a bug handling errors if the software update failed; if it succeeded, the .dmg

file is now deleted.
• Fixed a bug where an error message when displaying a text or RTF file could be

editable.
• Fixed a bug pasting tags into the fields in the Actions tab of the Edit Smart

Folder. . . window.
• Fixed a bug where “Tags contains all” in smart folders could incorrectly find a record

that was missing one of the tags (if that tag was not assigned to any records).
• Worked around an OS bug that could cause the records list to lose focus when hiding

and showing EagleFiler.
153http://www.noodlesoft.com/hazel.php
154http://www.omnigroup.com/products/omnioutliner/

126

http://www.noodlesoft.com/hazel.php
http://www.omnigroup.com/products/omnioutliner/


• Fixed a bug where the source list sometimes had focus when using the contextual
menu in the records list.
• Worked around an OS bug that could cause errors when auto-completing tag names.

1.5.10—May 9, 2012

• The contextual menu Set Filename/From/Title commands are better at handling
line breaks.

• It is now possible to move records to the trash by pressing Delete when multiple tags
are selected in the source list.

• The text fields in the smart folder editor make better use of the available window width.

• Improved the Importing Mail From Outlook section of the manual.

• Added the Importing Mail From MailMate section of the manual.

• Improved the What information should I include when I report a problem? section of
the manual.

• Documented the TextInspectorBarStayOpen and UseOpenMetaRecentsForCompletion
esoteric preferences.

• Added the Check for News. . . command to the EagleFiler menu of the Mac App
Store version.

• Worked around a WebKit bug that could cause freezes when highlighting matching search
terms.

• Worked around a bug in Apple Mail that could lead to importing two copies of certain
messages.

• Worked around a problem where broken Mac OS X installations couldn’t report full
error information.

• Fixed a bug that could cause uncommitted changes in the tags bar to be lost.

• Fixed a bug that could cause an error when the Quick Look window was open.

• Fixed a bug where an incorrect error message could be displayed when capturing from
Apple Mail.

• Reduced the memory use of the Spotlight importer.

• Improved the reporting of file permissions errors.

• Worked around an OS bug that could cause a crash in Curio.

• Worked around bugs in Mac OS X 10.7.4 that could cause smart folders and PDFs to
not display properly.

1.5.9—February 21, 2012

• Improved the error message that EagleFiler displays if you try to capture from Apple
Mail when it’s busy. You can now click Capture Anyway if you’re sure that Mail is
not busy with the messages you’ve asked EagleFiler to import.

• EagleFiler can now capture from Hibari155.
155http://hibariapp.com
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• EagleFiler is now code-signed using a Developer ID certificate156 for Gatekeeper.

• When printing a text or RTF file, fixed the font size and fixed a bug that could result
in an extra blank page being printed.

• Fixed a slowdown and crash that could occur when opening a library with lots of tags.

• Fixed an error when using the Quick Look panel if the toolbar had been collapsed into
a menu.

• Fixed a bug where EagleFiler would report an internal error if there was a problem
reading a text attachment.

• Fixed a bug where the Info and Tags toolbar buttons would be disabled under rare
circumstances.

• Fixed a regression that could lead to logged error messages about setting OpenMeta tags
on a non-existent note file.

• Fixed a bug where sometimes EagleFiler would rename the main thread.

1.5.8—January 24, 2012

• EagleFiler can now import rich text copied or dragged from Firefox and Google Chrome.

• Made various optimizations to improve the responsiveness of the user interface, partic-
ularly when resizing the main browser window.

• Searches by Filename, Title, From, and To/Cc, as well as matching in smart folders,
are now diacritic-insensitive. For example, you can now search for resume and find
résumé. (Anywhere and Notes searches have always been diacritic-insensitive.)

• Added the Copy Filename157, Copy File Path158, and Copy File URL159 AppleScripts.

• Added support for Growl notifications via GNTP (requires Mac OS X 10.7 or later).

• When printing an image, EagleFiler will now center it and scale it down, as necessary,
to fit the paper.

• The Import From Apple Mail160 script now works in Full Screen mode on Mac OS X
10.7 Lion.

• EagleFiler now skips importing temporary files for Microsoft Excel and invisible files
from IntegrityChecker161.

• Tried to work around a bug in Mac OS X 10.6 that could cause EagleFiler to open
multiple copies of the same library.

• The update checksum script command is now synchronous, and it gains an optional
for parameter that takes a list of records. This is much faster for bulk operations.

• When rebuilding a library, EagleFiler now restores all the tags, not just the ones that
were in use.

156http://www.apple.com/macosx/mountain-lion/security.html
157http://c-command.com/scripts/eaglefiler/copy-filename
158http://c-command.com/scripts/eaglefiler/copy-file-path
159http://c-command.com/scripts/eaglefiler/copy-file-url
160http://c-command.com/scripts/eaglefiler/import-from-apple-mail
161http://diglloydtools.com/integritychecker.html
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• EagleFiler is better at checking fallback locations when reading OpenMeta tags.

• EagleFiler is better at handling errors when setting OpenMeta tags.

• Fixed a bug where EagleFiler could crash after a token field malfunction.

• Fixed a bug importing the selected Web text from newer versions of Safari Reader.

• Fixed a bug displaying e-mail messages when the Source URL column was shown.

• Fixed a bug where the color of newly created tags could be set to white instead of black.

• Fixed a bug where the wrong tag could be applied if you clicked a checkbox in the Tags
inspector while renaming a tag.

• Fixed a bug that could lead to a tag temporarily not showing in the source list after
changing its position in the hierarchy.

• EagleFiler’s reporting of unexpected errors is now more detailed and more robust.

• The Importing Mail From Outlook section of the manual now explains how to use a
smart folder to capture mail from multiple Outlook folders at once.

• The manual now specifically recommends telling iWork applications to include previews
with their documents.

• The direct build of EagleFiler is now code-signed, too.

• Cache folders for EagleFiler’s helper tools now have a reverse domain name prefix.

• The preferences for the Apple Mail capture script are now stored in the main EagleFiler
preferences file.

• Launched applications no longer inherit EagleFiler’s Python environment variables,
which could cause problems if they also used Python.

1.5.7—December 7, 2011

• Added support for Growl 1.3162.

• Added support for importing hierarchies of mailboxes from Apple Mail on Mac OS X
10.7 via drag and drop from the Finder.

• The Import From Instapaper via NetNewsWire163 script lets you quickly import all your
new Instapaper164 articles into EagleFiler.

• The Replace in Filenames (Regex)165 script lets you batch-rename files using regular
expressions.

• On Mac OS X 10.7, EagleFiler supports emoji tag abbreviation pictures.

• Various operations, such as arrow-keying through the records list, are faster and more
responsive.

• EagleFiler can now display previews for OmniGraffle documents that are internally com-
pressed.

162http://growl.info
163http://c-command.com/scripts/eaglefiler/import-from-instapaper-via-netnewswire
164http://www.instapaper.com
165http://c-command.com/scripts/eaglefiler/replace-in-filenames-regex
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• Added the PrefersRichText esoteric preference, which can be used if you want the
EagleFiler: Import service, Import From Clipboard, and New Record . From
Clipboard to create plain text files instead of rich text files.

• The commands in the Go menu now bring the focus to the source list for more predictable
keyboard navigation.

• Improved capturing of large batches of messages from Microsoft Outlook.

• The Info inspector can now be opened via Command-I as well as Command-Option-I.

• Records now have a universal type identifier scripting property, which should
make certain kinds of AppleScripts much easier to write.

• Pressing the Esc key will now cancel editing in the source list or records list (for consis-
tency with Finder).

• Clarified the error message when importing non-standard-format archive mailboxes from
Apple Mail.

• You can now use the ImportSkipFilenamePattern default to specify a regular expres-
sion. When EagleFiler imports a folder, any files whose names match the pattern will
be skipped.

• EagleFiler no longer maintains the same default note text between multiple invocations of
Capture with options. This behavior can be reversed via the RememberCaptureNotesState
default.

• Fixed a bug where, in rare cases, files imported via the To Import folder were incorrectly
thought to be duplicates if they had the same names as files that had been previously
imported and recently moved.

• Fixed a bug where an AppleScript would hang if it tried to start a scan for new files
while another scan was already in progress.

• Fixed a bug where EagleFiler sometimes thought that files whose names ended with a
period were missing.

• Fixed a bug reporting Spotlight importer errors.

• Fixed a bug where the contents of the Quick Look window weren’t always updated before
it was shown, leading to flicker.

• Fixed a bug importing locally stored Web pages.

• Fixed a problem with saved view state and Full Screen mode.

• Fixed a bug that could cause a crash if there was an internal error launching a helper
tool.

• Fixed a bug where the = character wasn’t always treated as a word separator in phrase
searches.

• Added logging to help track down tag completion errors.

• Updated the French localization.

• Added a 1024×1024 application icon.

1.5.6—October 2, 2011
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• Adjusted the fonts, styles, and colors in the Tag Cloud window so that it’s easier to read.

• EagleFiler’s viewer displays more information for vCard files: categories, notes, pho-
netic/maiden/related names, related dates, social network profile URLs, etc.

• Added the Remove Duplicate Files166 script.

• Added the Import From Scanner167 script. Save this script as an application and set
it as the target of your scanner software (e.g. the Fujitsu ScanSnap Manager). When
you scan a file, EagleFiler will prompt you to enter a title and other metadata and then
import the scan into your library.

• EagleFiler’s capture key now works with Opera 11.50.

• It is now possible to empty a library’s trash via AppleScript.

• When editing plain text or RTF files on Mac OS X 10.7, EagleFiler no longer uses atomic
(a.k.a. safe) saving because this exposes bugs in Lion’s file versioning feature, causing
interoperability problems with applications such as TextEdit if you’re editing the same
file in more than one application at a time.

• EagleFiler now takes you out of search mode when you click on a different source.
You can restore the old behavior via the ClearSearchWhenChangingSources esoteric
preference if desired.

• Added the PDFWebBackgrounds esoteric preference, which can be used to prevent Ea-
gleFiler from drawing colored backgrounds when importing a Web page in PDF format.

• Added the ErrorsOpenForDuplicates esoteric preference. Normally, EagleFiler will
open the Errors window when a file has been skipped during an import because it’s
a duplicate. However, you can also set EagleFiler to log the error without opening the
window, for example if you expect there to be duplicates and don’t care to see them
reported.

• Added the TextToolSkippedNames esoteric preference so that it’s now possible to skip
indexing of files that cause Core PDF to hang.

• EagleFiler is better at closing a library while operations are in progress.

• Worked around an OS bug so that EagleFiler is once again able to capture from smart
mailboxes in Apple Mail.

• EagleFiler’s Spotlight importer plug-in works better with FoxTrot168.

• The default plain text font is now Menlo 11 rather than Monaco 10.

• Fixed a problem where the window title would be too long if you had a large number of
sources selected.

• Fixed a bug where the update checksum scripting command did not work recursively
on folders.

• Fixed a bug that could in rare circumstances cause EagleFiler to create two records for
a single file.

166http://c-command.com/scripts/eaglefiler/remove-duplicate-files
167http://c-command.com/scripts/eaglefiler/import-from-scanner
168http://www.ctmdev.com/foxtrot/
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• Fixed a bug importing a legacy/archive Apple Mail .mbox package via Scan for New
Files.

• Fixed a bug where EagleFiler wouldn’t give up on rebuilding a mailbox when the file
didn’t exist.

• Updated various screenshots and documentation.

1.5.5—August 4, 2011

• Fixed some bugs that could prevent EagleFiler from capturing messages from Apple Mail
under Mac OS X 10.7 Lion (particularly if Mail contained a large number of messages
or an IMAP path prefix was in effect).

• Added text editing toolbar for setting the font, style, size, etc. when editing rich text
documents (requires Mac OS X 10.7 Lion).

• EagleFiler is now able to capture from Apple Mail when it’s in Full Screen mode. How-
ever, due to limitations of the OS, capturing will not work in Full Screen mode if you
have multiple Mail viewer windows open.

• Updated the Using EagleFiler’s Capture Key From Preview169 instructions for Mac OS
X 10.7 Lion.

• Added the Refetch Web page170 script, which can be used to convert bookmarks to Web
archives (or other formats), to download the latest versions of pages that may have been
updated, and more. Any existing metadata that you’ve added is transferred to the new
files.

• The Word Count171 script now shows the number of words in the current selection, as
well as the total number of words in the document.

• Added the MediaStylePDF esoteric preference so that it is now possible to override the
stylesheet that EagleFiler uses when saving a Web page as a PDF.

• It is now possible to replace a library’s Files folder with an alias to redirect it to another
location.

• When opening a large batch of files in Preview, they now appear in a single window,
and this also avoids a -1712 error that Preview would report when told to open the files
individually.

• The Import Bookmarks. . . command now works with format-html files from Pinboard
that have no file extension when downloaded by certain browsers.

• When creating a new mailbox file, EagleFiler now assigns it HFS type ’TEXT’ so that
Entourage and Outlook will know that they can import it.

• Updated the Export. . . instructions for Outlook.

• Removed NOT from the documented search syntax, since it doesn’t work with Match
Partial Words. Instead, you should use - or ! to exclude matches that contain a
particular word.

169http://c-command.com/blog/2009/12/28/capture-from-preview/
170http://c-command.com/scripts/eaglefiler/refetch-web-page
171http://c-command.com/scripts/eaglefiler/word-count
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• When using Reveal in Library in the Errors window, the relevant browser window is
now brought to the front.

• EagleFiler no longer adds a list of recent libraries to its Dock menu when running under
Mac OS X 10.7 Lion, since this is now a built-in feature of the Dock.

• Improved the indexing of Microsoft Office documents.

• Improved various error messages when capturing.

• Fixed a bug where the Import Bookmarks. . . feature would create a tag with a blank
name if the bookmarks did not have any tags.

• Fixed a bug where the contextual menu in the Tags window didn’t work under Mac OS
X 10.7 Lion.

• Fixed a bug where capturing from NetNewsWire didn’t work if the item had no title.

• Fixed a bug with smart folders that use source URL criteria.

• Reduced EagleFiler’s memory usage by removing a workaround for a PDF bug that
seems to have been fixed in the final release of Mac OS X 10.7 Lion.

• The manual now explains how to open the Library folder on Mac OS X 10.7 Lion.

• Fixed a bug where EagleFiler’s Spotlight importer for .eml files didn’t work properly
under Mac OS X 10.7 Lion. Now, it works, although its functionality is limited due to
sandbox restrictions.

• Fixed a bug with re-personalizing via an x-eaglefiler URL.

1.5.4—June 23, 2011

• Added the Import Bookmarks. . . feature, for importing from Delicious, Pinboard, and
browsers such as Safari. EagleFiler will preserve the tags, titles, and descriptions that
you’ve set, as well as the original bookmarking date.

• EagleFiler can now capture from the Cruz172 Web browser.

• EagleFiler can now capture the current tab from the NewsRack173 RSS reader. It saves
the selected text in a note.

• When capturing from NetNewsWire174, the selected Web page text is now saved in a
note.

• EagleFiler now works in full screen mode on Mac OS X 10.7 (Lion).

• When importing from Safari Reader (via drag and drop or the service), EagleFiler can
now detect the proper URL for the original page.

• Made some changes so that Web pages imported as PDFs no longer have duplicate copies
of certain dynamic elements such as ads.

• Importing Web pages as PDFs is faster.

• You can now type Command-Return (or Enter, as before) to dismiss the Capture with
options, Quick entry, and Batch Change. . . dialogs.

172http://itunes.apple.com/us/app/cruz/id402357089?mt=12
173http://www.omz-software.de/newsrackmac/
174http://netnewswireapp.com/mac
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• Added keyboard shortcuts for switching between the tabs in the Capture with options
and Quick entry windows.

• When dragging from the records list or the source list to the Finder, EagleFiler now
copies the file by default. You can hold down the Command and Option keys before
starting the drag in order to create an alias (the old behavior); this can be useful when
assembling a burn folder.

• Added instructions for importing individual messages from Postbox and Thunderbird.

• Added the Rename for Dropbox/Windows script175.

• Wrote the Change Rich Text Font script176 for changing the font across multiple existing
RTF or RTFD documents.

• The Scan for New Files feature now supports the UnscannedFilenames default so that
you can set certain filenames that will always be ignored by scans.

• Pressing Return in the source list now edits the name of the selected item, rather than
opening it in a new window.

• Added the RespectImageDPI esoteric preference, which can be used to improve the
display of images that do not have the correct resolution set, thus making them appear
way too small.

• The Reveal in Library button in the Errors window now selects the record in an
existing window instead of opening a new one. This makes it much faster to deal with
“Missing File” errors. The RevealInLibraryNewWindow esoteric preference is available
for those who prefer the old behavior.

• The viewer pane now displays custom icons for bookmarks, which is useful if you’ve used
setWeblocThumb177.

• It is now possible to set the Date Added via AppleScript.

• It is now possibly to specify the Web page format when importing a URL via AppleScript.

• EagleFiler now caches file attributes for longer, which should speed up some smart folders
and sorting operations.

• Improved compatibility with Mac OS X 10.7 (Lion).

• Improved responsiveness when dragging and dropping text into EagleFiler.

• EagleFiler now allows the colon character in tag names.

• Improved the display of messages that erroneously declare themselves to be both HTML
and plain text by treating them as HTML.

• It is now possibly to exclude certain filenames and extensions from indexing if this
is necessary to work around buggy Spotlight importer plug-ins. This is controlled
by the SpotlightImporterSkippedNames and SpotlightImporterSkippedExtensions
defaults.

175http://c-command.com/scripts/eaglefiler/rename-for-dropbox-windows
176http://c-command.com/scripts/eaglefiler/change-rich-text-font
177http://hasseg.org/setWeblocThumb/
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• If there is a crash while importing a folder from the To Import folder, EagleFiler will
now “resume” importing it into the same folder the next time the library is opened.
Previous versions would instead import the remaining files into a second folder, leaving
you with two partial hierarchies instead of one complete one.

• Made various improvements to EagleFiler’s error logging.

• If you try to move a file into a folder that no longer exists, EagleFiler now reports a
regular “Missing File” error for the folder, rather than an internal error.

• Adjusted the help page titles to fit better in the menu and search results.

• Made an optimization so that menus pull down more quickly. (More work in this area
is in progress.)

• Worked around a WebKit bug that could (in rare cases) cause EagleFiler to save the
content of a Web page before it had completely finished loading.

• When capturing from Apple Mail, EagleFiler now reports a better error when no mes-
sages are selected.

• Fixed a problem where EagleFiler would not detect certain captured messages in a
mailbox if Entourage or Outlook had exported them with malformed headers.

• Fixed a bug where the Close & Lock command sometimes mentioned the name of a
library that had already been closed.

• Fixed a small memory leak when indexing .eml files.

• Fixed a bug where the EagleFiler: Import With Options service would sometimes
import as plain text instead of rich text.

• Fixed a bug where EagleFiler sometimes didn’t completely close a library after its last
window was closed.

• Made various changes to try to work around a crash that could occur when there’s an
error emptying the trash.

• Fixed a bug where the Info window might not load correctly if it had been open the
last time EagleFiler quit and no library was open.

• Fixed a bug where the browser window was sometimes not brought to the front when
re-opening recent libraries.

1.5.3—March 17, 2011

• Choosing Print now always prints the contents of the record viewer, even if it doesn’t
have focus, since this what most people want most of the time. To print the source list
or records list, hold down the Option key.

• Improved EagleFiler’s responsiveness when indexing e-mail attachments.

• Optimized various operations when selecting and dragging large numbers of records.

• When importing a hash-bang URL178, EagleFiler is better able to save the dynamically
loaded content into the Web archive.

178http://www.tbray.org/ongoing/When/201x/2011/02/09/Hash-Blecch
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• Improved the display of Web archives that use JavaScript to load and format their
content.

• Improved compatibility with pre-release versions of Apple Mail.

• Improved the speed and accuracy of searching large numbers of mailboxes.

• Added the EnableJavaScript esoteric preference, which can be used to turn off JavaScript
when displaying Web pages.

• The Verify section of the manual now has some advice for how to recover from errors.

• EagleFiler now logs its errors to the system log database rather than a separate log file.

• Added another workaround to prevent crashes when importing or indexing due to a bug
in Mac OS X 10.6.

• To avoid duplicates and infinite loops, EagleFiler no longer follows folder symlinks when
importing.

• Fixed a bug where multiple copies of a library could be loaded if you clicked several
x-eaglefiler links before EagleFiler had launched.

• Fixed a bug where Scan for New Files could start importing a folder and growl before
all of its contents had been imported.

1.5.2—January 25, 2011

• Made some optimizations so that typing in the viewer and in text fields is more respon-
sive.

• Made some changes to hopefully work around a bug in Mac OS X 10.6 that, for some
users, had been causing intermittent crashes when importing lots of files.

• When importing due to Scan for New Files or the To Import folder, EagleFiler now
skips symlinks. This prevents accidentally referencing files outside the library folder.

• Added the Reload OpenMeta Tags179 AppleScript.

• Worked around a problem with the eDrawings Viewer Spotlight importer plug-in that
could cause indexing to hang.

• Added accessibility titles to the Preferences window.

• Improved the German localization.

• EagleFiler is now code-signed.

• Fixed a bug where changes in the tags bar could be lost if you were viewing a Web
archive and moused over a link.

• Fixed a bug where file sizes in the records list were not displayed using base-10 megabytes
when running on Mac OS X 10.6.

• Fixed a bug where setting the basename property via AppleScript wasn’t undoable.

• Fixed a regression where EagleFiler could not import a file whose name contained a
colon unless it was running on Mac OS X 10.6.

179http://c-command.com/scripts/eaglefiler/reload-openmeta-tags
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• Fixed a bug where the scan for new files script command returned before it was
actually possible to close the window.

• Fixed a bug where EagleFiler would let the JavaScript in a Web archive close the window.

• Fixed a bug where clicking on a tag toolbar button or in the Tag Cloud discarded
changes made in the Info window’s tags field.

• Fixed a bug where the tagging toolbar buttons didn’t work if certain fields in the Info
window were in edit mode.

• Fixed a regression where fields in the Info window could be incorrectly enabled when
there was a multiple selection.

• EagleFiler will now note in the log if a file was modified in the future, as this can prevent
indexing from completing.

• Common types of errors when setting OpenMeta tags are now logged more concisely.

• No longer logs errors when Quick Look fails to generate a preview.

• If a damaged index file prevents a search from completing, EagleFiler now shows the
search results that are available and logs an error, rather than confusingly making it
look as though you weren’t searching at all.

• The build number is now available as a tooltip on the version number in the about box.

• Fixed a bug where the Spotlight indexer didn’t work for .eml files with CRLF linebreaks.

• Worked around a Finder problem that could prevent capturing from MarsEdit.

• Fixed a bug where the Open With contextual menu item didn’t work when EagleFiler
was in the background.

• Fixed a regression where capturing didn’t work with Safari 3.

1.5.1—December 15, 2010

• EagleFiler no longer tries to import cache folders created by beta versions of Dropbox.

• Fixed a bug where tag winnowing didn’t work properly with no folder selected.

• The progress text field below the source list now has a tooltip so that you can read it
when the text is truncated.

• Fixed a bug where uncommitted changes to the Info window’s tags field weren’t saved
when switching to another application, if multiple records were selected.

• Fixed a bug where changing the tags sometimes didn’t take effect if you were concurrently
editing in a tags field.

• Fixed a bug where tag changes in the Info window didn’t take effect if you closed the
inspector before doing anything else.

• Fixed a bug where tag auto-completion in the Info window didn’t work when multiple
records were selected.

• Fixed a bug that could prevent renaming to a long filename containing a period.

• Added a warning log message if the CTLoader haxie is installed, as it can cause imports
to freeze.
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• Fixed a bug where EagleFiler would always show the introductory help if you had created
exclusively encrypted libraries and none were accessible when launching the application.

• Fixed a bug where an AppleScript would hang if you asked it to show the options dialog
and then clicked the Cancel button.

• Fixed a regression where the Batch Change. . . window sometimes didn’t set the tags
properly.

• Worked around changes in Together so that it’s once again possible for EagleFiler to
import tags and notes via the capture key.

• EagleFiler now skips importing InDesign lock files (.idlk), so it no longer complains
about them being missing when InDesign releases the lock.

• Fixed a bug where invalid Spotlight URL metadata from SiteSucker could prevent Ea-
gleFiler from importing a file.

1.5—November 22, 2010

Highlights

• The new Quick entry hotkey lets you create a new RTF or text file from from within
any application. You can enter the contents of the file, choose which library and
folder it’s saved in, and set metadata such as the tags, label, and notes.
• When importing via drag and drop or Save PDF to EagleFiler, you can now hold

down the Option key to have EagleFiler show the options dialog (which was previ-
ously only available when capturing). This lets you set the destination folder, tags,
label, notes, etc. There is also a new EagleFiler: Import (Ask for Options)
system service, which presents the options dialog when importing the selected text
or file from another application, and the options dialog is also available for book-
marklets.
• You can now perform quick tag “searches” by selecting multiple sources (folders,

smart folders, mailboxes, tags) at once (holding down the Command key). Previ-
ously, EagleFiler displayed the union of all the records in the selected sources. Now
it displays the union of the records, but only those that have all of the selected tags.
This makes it possible to easily winnow records by tag without typing a search query.
For example, to see the flagged files in a folder, select the folder and the flagged
tag. To see the records that are both flagged and unread, select both the flagged
and unread tags.
• The main window now displays much better previews for iWork documents than

what Quick Look provides. For Keynote, Numbers, and Pages documents that were
saved with an embedded preview, EagleFiler can now display full-size previews with
multiple pages and highlighted search result text. This also works for OmniGraffle
documents, and it works on Mac OS X 10.4 (where Quick Look is not available).
• Double-clicking a folder or mailbox in the records list now opens it in the same

window rather than making a new window. This should make browsing faster. If
you do want a new window, you can Option-double-click or use the Open in New
Window command.
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• There’s a new Move To command in the Record menu and the contextual menu,
which lets you quickly move records to a different folder.
• You can now add files directly to EagleFiler’s library folder (or a subfolder) in the

Finder. When EagleFiler scans for new files (which it does when you open the library
or use the Scan for New Files command), it will automatically import any files that
it did not previously know about. You can turn off the ScanForNewFilesOnOpen
esoteric preference if you don’t want EagleFiler to automatically scan when the
library is opened.
• EagleFiler can now index and search files that are attached to e-mail messages. This

includes text, RTF, PDF, and Word files, as well as file types that have Spotlight
importers.
• Smart folders that search for “contains any/all tags” are about 10 times faster than

in EagleFiler 1.4.
• There’s a new Web page format called PDF (Single Page), which creates PDF

files that are optimized for on-screen viewing in a single, continuous page.
• Added the OCR With PDFpen180 and OCR using UNPDF181 scripts, which let

you perform optical character recognition on PDF files in EagleFiler. For more
information, see the How can I run optical character recognition (OCR) on my
PDFs? section.
• The tags bar can now be used to assign (or remove) tags from multiple selected

records at once. This also works in the Info inspector. (If the records have differing
tags, EagleFiler shows the Batch Change. . . button, as before.)
• Add the Close & Lock command, which closes an encrypted library and also locks

it (by ejecting the disk image) so that accessing library’s contents requires the
passphrase.

Source List
• The Go menu contains new commands to quickly jump to Records (to search the

whole library), the built-in smart folders, flagged, and unread, along with some
commands that were previously in the the View menu.
• You can now use Copy Record Link to create URLs that, when clicked, select par-

ticular folders, smart folders, or tags in the source list.
• Choosing Select All while the source list has focus now selects all the records,

which is more useful than the previous behavior of selecting all the sources.
Records List

• The new Open With submenu lets you view a file or mail message using a particular
application rather than the default. You can use Always Open With to change
the default application that’s used when you double-click.
• The New Record . From Clipboard command lets you create new files in EagleFiler

by “pasting” (the shortcut is Command-Shift-V) text snippets into the records list.
• You can now drag and drop onto individual folders in the records list. This works

for importing files from other applications, moving records within a library, and
copying files from other EagleFiler libraries.

180http://c-command.com/scripts/eaglefiler/ocr-with-pdfpen
181http://c-command.com/scripts/eaglefiler/ocr-with-unpdf

139

http://c-command.com/scripts/eaglefiler/ocr-with-pdfpen
http://c-command.com/scripts/eaglefiler/ocr-with-unpdf


• You can now three-finger swipe left or right on a multi-touch trackpad or Magic
Mouse to go to the previous or next record in the list.
• There are new columns for Notes, Source URL, flagged, and unread.
• Tooltips now show more information: the kind, size, relative path, source URL,

tags, and notes.
• The icon column now has a title in the hiding/showing menu.

Mail

• The new Merge Message Files command lets you recombine e-mail messages stored
as individual .eml files into a single mailbox file. This lets EagleFiler store the
messages more efficiently and allows for interoperation with other applications that
can read mbox files.
• When importing a .eml file, EagleFiler now changes the file’s dates to match those

of the contained e-mail message.
• Apple Mail is pickier than it used to be about which mbox files it will import.

When importing and exporting messages, EagleFiler is now more aggressive about
normalizing the message formats so that Apple Mail will accept them.
• EagleFiler can now import mailboxes that were exported by Apple Mail’s Archive

Mailbox. . . command. However, it’s still best to capture the messages directly
from Mail. The archive mailboxes use a non-standard mbox format, and EagleFiler
cannot read the message status flags or MailTags metadata from them.
• When merging mailboxes, the date added is now set to that of the newest mailbox

instead of the current date.
• When converting e-mail messages to .eml format, EagleFiler now exports the tags

to OpenMeta.
• If you’ve set Entourage or another mail program as the default opener for .eml files

(rather than Apple Mail), EagleFiler now shows the appropriate application name
and icon in the Record menu when an e-mail message is selected.
• EagleFiler can now import .rssmbox folders from Apple Mail. Capturing RSS

messages from Mail does not work, however, due to limitations of Mail’s AppleScript
support.

Viewing and Editing

• You can now open the Quick Look window by pressing the Spacebar or clicking a
toolbar button.
• The new Slideshow command (and toolbar button) opens a full-screen Quick Look

view of the selected record or records.
• Added Replace, Replace All, and Replace and Find commands to the Edit

. Find menu. The menu commands are probably less convenient than opening
the Find panel, however you can use System Preferences to assign them keyboard
shortcuts, to make text editing much faster.
• Added to the Edit . Spelling and Grammar menu: Check Grammar With

Spelling and Correct Spelling Automatically. EagleFiler remembers these
settings per-window.
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• Added commands in the Edit . Transformations submenu: Make Upper Case,
Make Lower Case, and Capitalize.
• Added options in the Edit . Substitutions menu: Show Substitutions, Smart

Copy/Paste, Smart Quotes, Smart Dashes, Smart Links, Data Detectors,
and Text Replacement. EagleFiler enables these features by default when editing,
and it remembers per-window how you’ve configured them.
• Added the Strikethrough command to the Format menu.
• Improved the quality of the thumbnail images when EagleFiler displays a record in

the inline viewer using Quick Look.

Searching

• Added a Spotlight importer plug-in so that the contents of .eml files (messages
that you’ve dragged out of their mailboxes into folders) can be searched outside of
EagleFiler.
• Indexed searches can now find text from additional e-mail header fields such as

Bcc and various sender and mailing list fields. This change takes effect for newly
imported mail, or if you hold down the Command and Option keys when opening a
library and tell EagleFiler to rebuild its indexes.
• Added label text to the smart folder editor that explains how to create new Any/All/None

criteria.
• Note files are now given the associated record’s tags so that they can be searched

by tag via Spotlight.
• EagleFiler is now able to search invisible content in Web archives: link titles, image

alt text, and hidden elements (e.g. spoiler text). Previously imported Web archives
will be reindexed the next time you open the library.
• EagleFiler is much faster at indexing Web archives.

Capture

• When capturing a Web page from Safari, EagleFiler now stores the selected text in
a note.
• EagleFiler can now capture from Google Chrome, DEVONthink Pro 2, and Mi-

crosoft Outlook 2011.
• When capturing from Journler, EagleFiler now preserves the category (as an Eagle-

Filer tag) and assigns tags to any subsidiary resource files that it imports (rather
than just to the main file).
• EagleFiler now plays the capture sound after running the script, rather than before,

so you can use the sound as an indicator that it’s OK to close your Safari window
or NetNewsWire tab.
• The source items for a capture are now displayed on a separate tab, since they

usually didn’t fit in the single-line text field.
• Improved the error reporting when capturing from Entourage and Firefox 3.6.
• Added the PlayCaptureSound esoteric preference so that it is now possible to make

EagleFiler silent when you press the capture key.

Documentation
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• Added the “How can I run AppleScripts from EagleFiler’s script menu?” and How
can I run optical character recognition (OCR) on my PDFs? sections to the manual.
• If you’re launching EagleFiler for the first time or it looks like you don’t have any

libraries, EagleFiler will open the (revised) Basics section of the manual to help you
get started.
• Added an About Stationery and Scripts item to the New Record submenu to

make it easy to open the relevant documentation.
• Updated the How can I put my library on my iPhone? and How can I access my

library from multiple Macs? sections of the manual with additional information
about Dropbox and other sharing software.
• Updated the Importing Mail section of the manual with instructions for importing

IMAP mail from Postbox and Thunderbird.
• Added a warning that SugarSync does not support filenames containing : at the

Unix level (/ in the Finder).
• Added commands to the Help menu for displaying the keyboard shortcuts, example

AppleScripts, and opening the bookmarklets information page.

AppleScript

• You can now get the viewer’s selected text via AppleScript.
• Added the asking for options argument for the import script command so that

you can show EagleFiler’s options dialog when importing.
• It is now easier to set the source URL when importing via AppleScript.
• Added the basename property for records, which should simplify many common

AppleScripts.
• Added the text content property for records, which is useful in circumstances

where AppleScript’s contents doesn’t work.
• You can now initiate a capture or capture with options via AppleScript.
• Changing the source URL of a bookmark via AppleScript now writes the new URL

into the bookmark file.
• Tag abbreviations are now settable.
• Added the load OpenMeta tags command, which lets you write AppleScripts that

bring changed tags from OpenMeta to EagleFiler, rather than the reverse (which
EagleFiler does automatically).

Interface Tweaks

• EagleFiler now shows the spinning progress indicator for all types of activity (not
just imports and merges), and next to the spinner it describes one of the more
important things it’s currently doing. This should make it much easier to see what’s
happening without having to open the Activity window, although you can still do
that by clicking the progress indicator.
• The notes text view now accepts click-through, so it’s smoother to switch to it and

begin typing.
• You can now Tab (and Shift-Tab) between the source list and the records list without

having to hold the Control key.
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• When running on Mac OS X 10.6 or later, EagleFiler now displays file sizes using
base-10 megabytes (to match the Finder).
• The default behavior is now to open x-eaglefiler links in an existing window

if possible. You can use the esoteric preferences to make it create a new window
instead.
• The Info inspector now shows a proxy icon in its title bar for the file being inspected,

and you can Command-click on it to show a path menu.
• The new Edit Notes menu item (Command-Shift-E) opens the Info inspector and

gives the notes keyboard focus. This makes it easier to quickly add notes to a record.
• When importing a single record, EagleFiler’s Growl notification now shows a thumb-

nail of it instead of the EagleFiler icon. This can help you see whether a Web page
was imported correctly or whether it depends on session state that is not available
to EagleFiler (requires Mac OS X 10.5 or later).
• The text view options (e.g. whether Check Spelling While Typing is enabled)

are now synchronized between the viewer and the Notes view in the Info inspector.
• Added the CaseSensitiveTagCompletion esoteric preference, which makes it easier

to type new tag names that are similar to existing tags but with differing case.
• Removed Contents of Record from the default toolbar because most of its function-

ality is now available by double-clicking.
• Enabled undo in various text fields (this requires Mac OS X 10.6 due to a bug in

previous OS versions).
• To reduce clutter, the Activity window is now hidden by default. (If you open it via

the menu or by clicking the progress spinner, EagleFiler will remember to re-open
it.)
• Moved the Close commands higher in the File menu.
• Improved the design of the Software Update. . . and Purchase. . . windows.
• Improved the progress icon for metadata backups.
• Updated the disk image layout.

Miscellaneous

• When importing a file that it downloaded itself, EagleFiler has always stored the
source URL. Now it also tries to store the source URLs for files downloaded by other
applications.
• EagleFiler is better at displaying and opening alias files.
• Various non-downloadable URLs are now always imported as bookmarks.
• EagleFiler’s metadata backup files now use relative rather than absolute paths. This

makes syncing libraries between multiple Macs more efficient.
• The date added is now restored from metadata backups.
• EagleFiler does a better job of cleaning up the title when importing a file.
• Added ! as an allowed tag character.
• Added � and � as allowed tag name characters.
• Improved EagleFiler’s error reporting when opening search index files.
• Improved EagleFiler’s error reporting when a mailbox file is missing.
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• EagleFiler is faster at creating bookmarks from non-Web URLs.
• Made some improvements to the crash reporter.
• EagleFiler can now import plain text notes from metadata backup files that are

missing the RTFD data.

Bug Fixes

• EagleFiler now reports an error rather than hanging when you ask it to import an
x-eaglefiler URL.
• Made a change to prevent Zooom/2 from causing an internal error when resizing

the source list.
• Fixed a bug where EagleFiler would sometimes quit when coming out of trial mode.
• Fixed a bug in which EagleFiler would let you try to rename a file using an invalid

name.
• Fixed an internal error when formatting file sizes.
• Fixed a bug where setting the title/filename/from/tags from the selection in the

viewer didn’t work if the field in question was currently being edited in the Info
inspector.
• Fixed a bug where changing a the filename in the Info inspector didn’t update a

linked title.
• Fixed a bug where EagleFiler would sometimes report an error when displaying an

e-mail message.
• Fixed a bug with tag auto-completion and non-ASCII characters.
• Fixed a bug where EagleFiler could hang when importing non-Web URLs.
• Worked around a bug in Firefox that could prevent EagleFiler from importing

dragged images.
• Fixed a bug where EagleFiler stripped a trailing period from the name when im-

porting a folder.
• Worked around some OS bugs that caused slowness and prevented EagleFiler from

displaying Web archives created from Safari Reader.
• Fixed a bug where a smart folder that searched for an empty From didn’t work.
• Fixed a bug where PDF files that are unreadable by Preview could not be imported

into an EagleFiler library.
• Worked around an OS bug that could cause crashes when indexing Web archives.
• Fixed scaling when printing PDF files.
• Fixed a bug where choosing Actual Size when viewing a PDF didn’t make the

change stick.
• Fixed a bug where EagleFiler would re-save metadata property list files that hadn’t

changed, which could lead to incorrect folder modification dates and sorting.
• Fixed a bug displaying non-Roman Finder label names (requires Mac OS X 10.6 or

later).
• Fixed a bug where the scroll position of a .eml file could get reset when switching

applications.
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• Fixed a bug where certain long filenames would be imported with hexadecimal
abbreviations.

1.4.14—January 22, 2010

• Fixed a regression that sometimes caused errors when opening a library window when
running on Mac OS X 10.4 or 10.5.

1.4.13—January 21, 2010

• Improved EagleFiler’s responsiveness with libraries containing many files.

• Updated the instructions182 for how to make EagleFiler’s capture key work with Preview
on Mac OS X 10.6. EagleFiler will automatically show this when you try to capture
from Preview.

• Google Chrome183 does not have sufficient AppleScript support to work with EagleFiler’s
capture key, so EagleFiler will now display a message that tells how you can add an
EagleFiler button to Chrome’s toolbar.

• Added the Convert Plain Text to Rich Text184 script.

• Added # as a word character for indexing, so that you can search for preprocessor
directives and hashtags. This will take effect for new libraries or if you rebuild your
indexes by holding the Command and Option keys when opening a library.

• Added the Drag and Drop section of the manual and expanded the Importing Mail and
The Edit Menu sections.

• Improved the styling of the Apple Help.

• Fixed a bug searching for certain terms with Match Partial Words enabled.

• Fixed a regression where EagleFiler wouldn’t launch on a PowerPC G3–based Mac.

• Fixed a bug dragging iChat files.

• Fixed a bug where messages didn’t sort properly by Date Created.

• Fixed a bug where some closed windows still showed up via AppleScript.

• Fixed a bug where EagleFiler would crash when processing certain invalid URLs.

• Worked around a bug in Mac OS X 10.6 that could cause inconsistent font sizes in the
contextual menus.

1.4.12—December 8, 2009

• EagleFiler is faster at building a mailbox’s table of contents after importing it.

• You can now use the characters []{}=#. in tag names.

• The Date Created for e-mail messages now shows the date from the message’s headers
rather than the creation date of the mailbox file.

• Added the ViewEMLOnTiger esoteric preference, which is useful for people who want to
use Microsoft Entourage as their external mail viewer on Mac OS X 10.4.

182http://c-command.com/blog/2009/12/28/capture-from-preview/
183http://www.google.com/chrome
184http://c-command.com/scripts/eaglefiler/convert-plain-text-to-rich-text
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• Tweaked the spacing in the source list to match Mail.

• Tweaked the positions of the tag icons in the source list when it’s set to large icon mode.

• The New Record . Open Stationery Folder command now opens the folder instead of
revealing it.

• EagleFiler is now more robust with respect to errors when importing mail from En-
tourage, Mailsmith, and PowerMail.

• Fixed a bug where read records might be tagged as unread when restoring from a meta-
data backup.

• Fixed a bug where, in some circumstances, EagleFiler could display an error message or
crash when undoing too many times in the record viewer.

• Fixed a bug where the Tag Cloud didn’t immediately update after changing the font
in the preferences.

• Fixed a bug where Command Up/Down didn’t move the insertion point in a text docu-
ment when the viewer had keyboard focus.

• Fixed a bug opening files in MacVim.

• Fixed a bug where EagleFiler didn’t show the alternating row background colors after a
failed search.

• Fixed a bug capturing from Flock185 when using Mac OS X 10.4.

• Fixed a bug capturing large amounts of mail from PowerMail at once.

• Fixed a regression where some icons in sheets were drawn as dimmed.

• Fixed a bug where New Record . Open Stationery Folder and Reveal in Finder didn’t
work if TableText or another old application was running.

1.4.11—November 12, 2009

• The EagleFiler: Import service (for importing the selected text, URL, or files) is now
enabled by default on Mac OS X 10.6. You may still need to log out and log back in for
the system to recognize it, however.

• Worked around a change in Mac OS X that could make EagleFiler report an error when
opening a library.

• Fixed a regression where sometimes EagleFiler didn’t open files in the proper external
viewer/editor application.

1.4.10—November 10, 2009

• EagleFiler can now capture from Microsoft Exchange mailboxes in Apple Mail.

• Updated the How can I put my library on my iPhone? section of the manual with a link
to the Dropbox iPhone application.

• You can now double-click an embedded file in the viewer or notes to open it in a separate
window for viewing.

185http://www.flock.com
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• Improved the instructions for importing mail from Thunderbird.

• The script186 for quickly creating new text files from LaunchBar will now let you enter
tags as well.

• If a bug in Mac OS X 10.6 has erased the OpenMeta tags for a file that EagleFiler
is importing, it will now look under kMDItemOMUserTags, which Spotlight may have
preserved.

• Deleting a tag now removes it from the shared list of recent tags, so that it doesn’t
appear to still be hanging around.

• Worked around a change in Flock187 so that EagleFiler can capture from it again.

• EagleFiler now displays image files according to the orientation information in their
metadata (requires Mac OS X 10.6 or later).

• EagleFiler now writes the tags to kMDItemOMUserTags (and sets kMDItemOMUserTagTime)
for compatibility with newer versions of OpenMeta.

• EagleFiler now gives priority to the org.openmetainfo extended attributes if they’re
present and have more recent timestamps. This will make it possible to transition away
from keys in Apple’s domain.

• Added the RecordsListHasAlternatingBackground esoteric preference for people who
prefer a solid white background color in the records list.

• When you ask it to create a new file, EagleFiler no longer replaces / in the filename with
-.

• To avoid confusion with the single-selection case, pressing Return in the records list no
longer opens multiple selected records externally.

• Fixed a bug where the keyboard shortcut for New Record . Plain Text File didn’t work
under non-English localizations.

• Fixed a bug in the URL colorer that prevented some message bodies from being dis-
played.

• Fixed a bug that could result in empty tag names after renaming.

• Worked around a suspected bug in Mac OS X that could prevent EagleFiler from restor-
ing the correct window position and size when opening a library.

• Fixed a bug where some individual message files didn’t sort properly by title.

• Fixed a bug with the French localization when creating a new file.

• Changed the way the Software Update. . . feature finds the downloads folder on Mac OS
X 10.5 and later because sometimes the one that Internet Config returned would be
invalid or unwanted.

• Improved EagleFiler’s error handling when it can’t read a metadata backup file due to
a disk error.

• Modernized the code.

1.4.9—September 4, 2009
186http://c-command.com/scripts/eaglefiler/launchbar-import-text
187http://www.flock.com

147

http://c-command.com/scripts/eaglefiler/launchbar-import-text
http://www.flock.com


• When using Mac OS X 10.6, you can use the Keyboard pane in System Preferences to
add EagleFiler’s import service to contextual menus in your other applications.

• Added the OpenEagleFilerURLsInNewWindow esoteric preference, which can be used to
make EagleFiler open record links in an existing window rather than creating a new one.

• When dragging from the records list, EagleFiler now makes x-eaglefiler URLs avail-
able (instead of titles) when the receiving application expects plain text. This makes it
possible to, e.g. drag and drop to Things188 to create a link to an EagleFiler record.

• EagleFiler now preserves the flagged state when capturing from Yojimbo.

• Updated the How can I put my library on my iPhone? section of the manual to reference
Quickword, which allows editing of plain text and Microsoft Word documents from the
iPhone.

• Added a note saying that accessing EagleFiler’s Dock menu (e.g. to open a recent
library) requires a right-click or a Control-click under Mac OS X 10.6.

• Added a workaround for an error logging bug in the OS.

• Improved number entry in the smart folder editor.

• Fixed an appearance glitch when dragging from the records list.

• Worked around a bug in Mac OS X 10.6 that could cause EagleFiler to crash when
indexing.

• Worked around a bug in Mac OS X 10.6 that could prevent some files from being indexed.

1.4.8—August 24, 2009

• Capturing a bookmark from NetNewsWire, OmniWeb, Safari, and WebKit Nightly is
much faster because EagleFiler no longer goes online to download the contents of the
page.

• The records list now supports click-through. This means that it no longer takes two
clicks to select a different record when one of the inspector windows has focus.

• Added an optimization so that image files with custom icons can be displayed in the
records list without having to ask Quick Look to generate a thumbnail.

• Improved the library opening speed by reducing the time spent building the action menu.

• The How can I access my library from multiple Macs? and How can I put my library
on my iPhone? sections of the manual now discuss SugarSync.

• Updated the How can I put my library on my iPhone? section of the manual to add a
link to Apple’s new MobileMe iDisk app.

• The Errors window now appears on all spaces.

• EagleFiler no longer auto-opens the Errors window at launch if it was open at quit.

• The crash reporter works better with pre-release versions of Mac OS X 10.6 (Snow
Leopard).

• The software updater now supports two-digit version numbers like “1.4.10”—just in case.
188http://culturedcode.com/things/
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• Made the progress window wider so that the text fits better.

• Updated the links for Mailsmith’s new home.

• Fixed a bug where EagleFiler’s auto-conversion from an RTF file to RTFD (e.g. when
you pasted in an image) could overwrite a pre-existing RTFD file.

• Fixed a bug where the Reply to Message command didn’t work properly with Entourage.

• Fixed a bug where EagleFiler sometimes didn’t let you type a space in the Capture with
options window.

• Fixed a bug where the fields and text view in the Info inspector would lose keyboard
focus when switching to another application.

• Fixed a bug where editing in the records list wasn’t committed before switching to an
inspector.

• Fixed a bug where importing a .webloc file via drag and drop didn’t set the proper
source URL.

• Fixed a bug where the record viewer would not remain collapsed when resizing the
window.

• Fixed a bug where double-clicking on a column header in the records list would open
the selected records.

• Fixed a bug where, for the first Capture with options for a library, EagleFiler would
suggest the “unread” tag even if the preferences were set not to mark new records as
unread.

• Fixed a bug where EagleFiler would report an error when importing an empty message
from Apple Mail.

1.4.7—July 28, 2009

• EagleFiler now copies tags into the extended attributes for Spotlight searchability and
interoperability with applications189 that use OpenMeta190 (requires Mac OS X 10.5 or
later). EagleFiler also integrates with OpenMeta’s list of recent tags and (since version
1.4.5) imports tags that were assigned using OpenMeta. As with previous versions,
EagleFiler’s primary tag store is its database, so you won’t lose any metadata if you
store, edit, or copy files in a manner that discards extended attributes, or if you restore
from a Time Machine backup. Once a file is in EagleFiler, the tags must be edited
using EagleFiler. The Copy tags to Spotlight comments option still works, but since
OpenMeta support makes it largely redundant it is no longer recommended except for
use on Mac OS X 10.4 and for interoperability with non-OpenMeta applications.

• EagleFiler now displays thumbnail icon previews of image files (requires Mac OS X 10.5
or later).

• Improved EagleFiler’s capture support for Journler191. It now preserves the tags, com-
ments, images, and resources, and it omits the entry header.

189http://code.google.com/p/openmeta/wiki/OpenMetaApplications
190http://openmetainfo.org
191http://www.journler.com
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• Revealing a message in the Finder now reveals a .eml file instead of an .emlx file. You
can use File . Get Info on this file to make Entourage the default message viewer.

• When exporting messages, EagleFiler now adds a .mbox file extension so that Entourage
will recognize that it can import from the file.

• Improved the Web archives that EagleFiler imports from pages served as XML.

• Now shows Growl192 notifications when using drag and drop to copy files from one library
to another.

• EagleFiler now shows a library’s spinning progress indicator for all types of user-initiated
operations, not just imports.

• Improved the parsing of invalid e-mail addresses.

• Increased the default capacity of encrypted libraries.

• Fixed a bug where EagleFiler allowed editing of locked files and then didn’t save them
properly (due to a suspected OS bug).

• Fixed a bug where some auxiliary frame content wasn’t saved into Web archives.

• Fixed a bug where tags and notes were not preserved when dragging a bookmark from
one library to another.

• Fixed a bug where Control-Tab didn’t work with Web views.

• Fixed a bug where certain Web pages wouldn’t import from Safari via the bookmarklets193.

• Fixed a bug where the search field lost focus after pressing Return/Enter.

• Fixed a bug updating the search field label.

• Fixed a bug where some file URLs wouldn’t import via bookmarklets.

• Fixed a bug creating Web PDFs from non-conforming URLs.

• Fixed a bug importing messages with X-From headers.

• Fixed a bug importing messages from Entourage with Mac linebreaks and unescaped
“From ” lines.

• Fixed a bug indexing notes for libraries inside non-ASCII-named folders.

• Fixed a bug where EagleFiler highlighted search operators in the viewer.

• Removed a Web archive workaround that’s no longer needed due to a bug fix in Safari
4.

• Updated the French localization.

1.4.6—June 1, 2009

• The Drop Pad window now appears on all spaces.

• When creating a Web archive, EagleFiler now uses the proper page title for Web sites
such as gmane.org that change the title using JavaScript.

• Added +$*/~()|%^& as characters allowed in tag names.
192http://growl.info
193http://c-command.com/eaglefiler/bookmarklets
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• The search fields are now scrollable.

• The ruler is now shown by default for editable rich text files.

• Added keyboard shortcuts for showing, copying, and pasting the ruler.

• Updated to version 1.1.7 of the SkimNotes framework.

• Updated the instructions for changing an encrypted library’s passphrase to work around
a bug in Disk Utility.

• Improved the display of messages containing invalid Base64 content.

• No longer adds a useless x-msg URL to the bottom of text imported from mail messages
as RTFD.

• Worked around a bug in the Safari 4 beta that could cause some images not to be saved
into Web archives.

• Fixed a bug where the search wasn’t cleared when opening a folder in a new window
with the ClearSearchWhenChangingSources esoteric preference enabled.

• Fixed a bug where changing the plain text font didn’t change the font of newly typed
text.

• Fixed a bug where the raw source for a message would sometimes show one extra char-
acter.

• The crash reporter works better with pre-release versions of Mac OS X 10.6 (Snow
Leopard).

• The crash reporter now warns before sending a report without an e-mail address.

• You can now press Enter to click the Send Report button in the crash reporter.

• Updated Korean localization.

1.4.5—March 24, 2009

• When capturing from Apple Mail, EagleFiler can now directly import messages that are
selected in smart mailboxes and in special “merged” mailboxes such as Inbox.

• When you do a library search for a phrase, EagleFiler now removes the quotation marks
when transferring the query to Preview or Skim.

• EagleFiler now imports tags that are stored in a file’s extended attributes under com.apple.metadata:kOMUserTags
by applications such as Tags, TagIt, and Default Folder X.

• Improved compatibility with pre-release versions of Mac OS X 10.6 (Snow Leopard).

• Added the assigned tag names AppleScript property, which can make writing scripts
less verbose.

• Added the ExcludeIndexesFromBackup esoteric preference to exclude EagleFiler’s index
files from Time Machine backups.

• Added the FindPanelDiacriticInsensitive esoteric preference.

• Worked around bugs in Microsoft Excel and Word that could cause EagleFiler to import
the wrong document.

• EagleFiler’s temporary files are now excluded from Time Machine backups.
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• Worked around a bug in the Safari 4 beta that could make Convert For Editing not
preserve images.

• Worked around a change in Safari 4 that could cause problems when displaying or
indexing Web archives.

• EagleFiler now closes files immediately after you’re done viewing them.

• Fixed a bug where the Errors window did not transform filenames for display.

• Fixed a bug where EagleFiler didn’t show Growl notifications after importing certain
files via AppleScript.

• Fixed a bug where sometimes changes to a text or RTF document were not saved before
opening the file in an external editor.

• Fixed a bug with the date format in mbox files.

• Fixed a bug where EagleFiler did not follow aliases in the Stationery folder.

1.4.4—February 11, 2009

• Streamlined capturing from Apple Mail. EagleFiler no longer asks whether you want
to capture the selected mailboxes or the selected messages; now it always captures the
selected messages. Also made other changes to reduce the number of dialog boxes.

• You can now use Command-Down-Arrow (Reveal in Container) with a message or
file selected to have EagleFiler select it inside its containing mailbox or folder in the
source list. This is useful if you had originally selected the message or file in Records,
a tag source, or a smart folder and you want to see it in its original context.

• When you ask EagleFiler to import a file (e.g. by dropping it onto EagleFiler’s Dock icon
or choosing Open With . EagleFiler) that’s already in the current library, EagleFiler
now opens the file for viewing rather than complaining that it’s already in the library.

• EagleFiler now uses non-modal notification windows (Growl, where available) to display
the progress when capturing from a mail program.

• EagleFiler now uses its own Find panel everywhere, not relying on the system Find
panel, in order to avoid having two separate windows and to improve the interaction
with the search field.

• Added the SendsWholeSearchString esoteric preference, which lets you control whether
EagleFiler updates search results as you type.

• When you search for a phrase, EagleFiler now tries to highlight the whole phrase in the
viewer, rather than the constituent words.

• The Find panel works better with Spaces.

• Items in the Services menu can now read the selection from EagleFiler’s records list.

• You can now use the capture key to import New York Times Web pages that are in
printer format, without having EagleFiler download the screen format instead.

• When importing Web pages as RTF(D), EagleFiler now stores the URL in the file’s
Subject field.

• When you do a library search for a phrase, EagleFiler removes the quotation marks when
transferring the query to the Find panel.
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• When creating PDFs from Web pages, EagleFiler no longer inserts your username into
the PDF metadata.

• When you press the capture key, EagleFiler now bounces its Dock icon once. This
makes it easier to see that the capture has begun if the Dock was hidden or the sound
was turned down.

• When creating a new plain text file with the File column hidden, if you enter a filename
with an extension into the sheet, EagleFiler uses that extension instead of .txt.

• When merging mailboxes that are selected in the source list, EagleFiler no longer main-
tains the selection when the mailboxes are moved to the trash.

• Deleting multiple errors at once is much faster.

• You can now use Page Setup to change the orientation and scaling when printing.

• When printing a text view, no longer scales down the width unless it’s necessary to fit
it on the page.

• The print job title now shows the title of the document being printed, rather than the
name of the library.

• If a file wasn’t downloaded from the Internet, its source URL is now empty rather than
being a file: URL.

• If there’s an error capturing from Firefox, EagleFiler now suggests uninstalling Default
Folder X to work around a bug in Firefox.

• Tooltips in the Errors window now show the full path rather than just the name of the
file.

• Worked around an OS bug that could cause problems when importing text from Apple
Mail via services.

• Better error reporting when EagleFiler encounters an AppleScript bug in NetNewsWire.

• Improved handling of long library names.

• Improved the error reporting when capturing from DEVONthink.

• Fixed a bug where EagleFiler would start importing a file that was copied into the To
Import folder while the copy was still in progress.

• Fixed a bug where indexing could hang if analyzing the file produced a large number of
errors.

• Fixed a bug where some Boston Globe Web pages were downloaded as HTML files
instead of as Web archives.

• Fixed a regression that could prevent MailTags from being imported from Apple Mail if
the message also had annotations.

• Fixed a bug where files that didn’t have notes could be imported with the note tag if it
was in the Spotlight comments.

• Fixed a bug where the URL wasn’t properly set when importing Web page text as RTFD
via drag and drop.

• Fixed a bug where, when importing IMAP messages from Apple Mail, EagleFiler would
sometimes incorrectly report that attachments were missing.
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• Fixed a bug where the tags bar was hidden when it shouldn’t have been.

• Fixed a bug where the scroll arrows for the notes text view didn’t work.

• Fixed a bug handling errors when importing Web archives.

• Tried to work around a URL cache problem that could cause imports to stall.

1.4.3—November 20, 2008

• EagleFiler can now display Skim194 notes attached to PDF files.

• Added an esoteric preference to make EagleFiler import the selected text from a Web
view in RTF(D) format rather than as a Web archive.

• Added an esoteric preference to control whether EagleFiler displays images in HTML
e-mails, for those concerned about Web bugs.

• The color list tab is now available in the color panel.

• In the records list, pressing Return now edits the filename rather than opening the file.

• EagleFiler now preserves filesystem metadata when editing a smart folder’s .plist file.

• PDF annotations are now indexed for searching.

• The metadata backup files are no longer touched unnecessarily, for more efficient backups
and syncs.

• Improved error reporting when emptying the trash.

• Fixed a regression where some files couldn’t be deleted.

• Fixed a bug where tag searches with partial word matching didn’t work with non-
lowercase tag names.

• Fixed a bug where EagleFiler did not report unexpected errors when viewing files.

• Fixed a bug displaying property list files that were not dictionaries.

• Fixed a bug in the German localization for smart folders.

• Fixed a bug where text could be truncated when printing.

• Fixed a bug displaying Web archives created from Mail.

1.4.2—October 30, 2008

• Fixed a regression where the + button in the source list didn’t work.

• Fixed a regression where phrase searches found records that didn’t match.

1.4.1—October 28, 2008

• The Tag Cloud window now supports tagging/untagging multiple records at once.

• You can now setup a stationery file’s Spotlight comments so that new records created
from that stationery have certain tags and/or notes.

• EagleFiler now supports metadata AppleScripts to customize what happens when you
create a new record from stationery. For example, for a journal entry a script could set
the From to the name of the current user and set the filename based on the current date.
This is described in the New Record . Open Stationery Folder section of the manual.

194http://skim-app.sourceforge.net
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• The Quick Look window now works more like in the Finder. Instead of multiple windows,
there’s now a single window whose content changes depending on what’s selected.

• Added some toolbar shortcuts: Option-click the New RTF button to create a new plain
text file, and Option-click the Tags button to open the Tag Cloud window.

• EagleFiler can now display Scalable Vector Graphics (SVG) images.

• EagleFiler now displays XHTML files as rendered HTML rather than as XML source.

• Faster tag searching in Anywhere searches.

• EagleFiler now understands .url files.

• Made some AppleScript improvements: creation and modification dates are now settable,
the import command now has an option for importing a named stationery file, you can
update record checksums, and you can set the contents of the search field. An example
script195 shows how to initiate an EagleFiler search from LaunchBar.

• When you click to edit in the File column, EagleFiler no longer selects the file extension.
(Previously, this only worked when pressing Enter.)

• When importing a selection of text via the Services menu, EagleFiler now stores the
source URL if the text was in a WebKit-based view (requires Mac OS X 10.5). Due to
a bug in Mac OS X 10.4, dragging and dropping text onto EagleFiler’s Dock icon now
requires Mac OS X 10.5.

• For consistency with the Finder, the Label column of the records list now shows “–”
instead of “None” and sorts by name instead of number.

• Now uses “&” as the default prefix when copying tags to the Spotlight comments.

• Improved reporting of unexpected errors.

• Undo now works when the Tag Cloud window is in the front.

• Changed the zooming keyboard shortcuts so as not to conflict with the ones for Universal
Access. (You can still use Command– and Command-+.)

• Fixed spacing of Set Title in contextual menu.

• Added Help button to the Software Update window.

• Removed extra space in contextual menu.

• Fixed a bug trying to open the Find panel when EagleFiler was displaying an image.

• Fixed a bug where some toolbar icons didn’t load if you weren’t running under an
administrator account.

• Fixed a bug where the Find panel didn’t always pick up the query from the search field.

• Fixed a regression where messages in mailboxes could not be opened in Apple Mail when
running on Mac OS X 10.4.

• Fixed a regression where Spotlight comments on files weren’t preserved when importing,
if you had Copy tags to Spotlight comments unchecked.

1.4—October 14, 2008
195http://c-command.com/scripts/eaglefiler/launchbar-search
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Highlights

• You can now create custom smart folders, which can contain an unlimited number of
criteria, optionally using nested Any/All/None criteria. Creating and editing smart
folders requires Mac OS X 10.5; however, once created, the smart folders can be
used with Mac OS X 10.4.
• Smart folders can now be organized into folders.
• You can define actions to occur when you drag a record onto a smart folder. For ex-

ample, you could make a smart folder that shows records with a certain combination
of tags, and that will assign those tags to dragged records.
• You can now create any type of new file from within EagleFiler. To do this, choose

New Record . Open Stationery Folder from the File menu. Whichever files you put
in the Stationery folder become available as templates in the File . New Record
menu.
• You can now drag messages out of mailboxes to convert them to freestanding .eml

files. It’s less efficient to store messages individually rather than in mailbox files,
but there are also several advantages: the messages can be stored alongside other
types of files, they can be freely moved between folders, and they are searchable by
Spotlight.
• Added a Tag Cloud window, which shows a compact listing of all the tags. You can

click on a tag to toggle whether it’s assigned to the selected record.
• Added a Find panel for searching within PDFs and Web archives.
• Added a preference to control which format Web pages are imported in. The sup-

ported formats are: Bookmark, PDF, Plain Text, Rich Text, Rich Text With Images,
and Web Archive (the default).
• Added a preference to control what happens to Spotlight comments when importing.

This is useful, e.g. if you had already used another application to tag your files or
if you had entered notes from the Finder. If you tell EagleFiler to Import as
tags, each word is imported as a tag. If you tell it to Import as notes and
tags, EagleFiler extracts tags (prefixed by & or marked using Punakea’s format)
and imports the remaining comments text as notes.
• Added commands to the contextual menus (Assign Tag, Set Filename, Set

From, Set Title) so that you can quickly turn the selected text into metadata.

File Formats

• Added New Record . Plain Text File command.
• EagleFiler can now display Microsoft Word 2007 (.docx) files (requires Mac OS X

10.5).
• EagleFiler can now display and edit OpenDocument Text (.odt) files (requires Mac

OS X 10.5).
• EagleFiler can now display and search XML and binary property list (.plist) files.
• Now imports .webloc files as-is rather than converting them to Web archives.
• EagleFiler now imports .eml files as-is rather than converting them to single-message

mailboxes.
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• Bean196 documents are now imported as a separate file type rather than as RTFD.

Interface

• Added Quick Look command, which opens a Quick Look preview of the selected
records in a separate window (requires Mac OS X 10.5).
• Added an Enclosing Record command in the View menu. Replaced the Select

Source command with the similar but more useful Contents of Record command in
the View menu. As a result, you can now use Command–Up Arrow and Command–
Down Arrow to navigate up and down the hierarchy of folders and mailboxes.
• Added Search for Selection contextual menu command.
• When you mouse over a link in a Web view, EagleFiler now shows the URL at the

bottom of the window.
• Revised the toolbar icons and simplified the default toolbar configuration.
• If there are no matches for a search, EagleFiler draws the records list background

in yellow.
• Adjusted the unread and flagged menu item titles and toolbar labels for consistency

with Mail.
• Increased the resolution of the Dock badges.
• The viewer now shows some helpful text describing the “note” tag.
• Moved Show Inspector and Show Tags from the Record menu to the Window

menu and renamed Show Inspector to Show Info.

Capture

• Can now capture from Entourage197, and preserves the message flags, categories, and
projects. If you want EagleFiler to skip a message, you can assign it the category
“OmitFromArchive”.
• Can now capture from PowerMail198, and preserves the message status and label.
• Can now capture from Preview199, if you make it scriptable200.
• Can now capture from Together201, and preserves the tags, comments, labels, and

ratings.
• When capturing from Mailsmith202, EagleFiler can now import individual messages

(before, only mailboxes were supported), and it now preserves the message status,
label, and notes.
• When capturing from Camino203, EagleFiler now reads the URL of the current tab

rather than the first tab.
• In the Capture With Options window, if you edit the tags and then choose a different

library, EagleFiler no longer overwrites the tags with the default ones for the new
library.

196http://www.bean-osx.com
197http://www.microsoft.com/mac/products/entourage2008/default.mspx
198http://www.ctmdev.com/powermail5.html
199http://www.apple.com/macosx/features/pdf/
200http://www.macworld.com/article/53391/2006/10/previewscript.html
201http://reinventedsoftware.com/together/
202http://www.mailsmith.org
203http://www.caminobrowser.org
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Importing

• You can now import Web pages using bookmarklets204.
• Empty files and files that contain only a resource fork (such as font suitcases) no

longer count as duplicates.
• Added an esoteric preference for importing Spotlight keywords as tags.
• When you try to import a file that’s already inside of the library folder, EagleFiler

can now reveal the file in the browser window.
• If a connection times out while EagleFiler is importing a Web page, it will now retry

twice.
• When importing bookmarks from a Web browser, EagleFiler now uses the titles

you’ve assigned rather than fetching them from the Web.

Miscellaneous

• Encrypted libraries can now be created as sparse bundle images, for more efficient
Time Machine backups (requires Mac OS X 10.5).
• Encrypted libraries can now use 256-bit rather than 128-bit encryption (requires

Mac OS X 10.5).
• You can now type tag names directly into an Anywhere search.
• You can now view messages in Microsoft Entourage instead of Apple Mail (requires

Mac OS X 10.5). To do this, Get Info on a .eml file in the Finder, choose Entourage
from the Open with pop-up menu, and click Change All.
• The Copy Record Link command now creates links using persistent IDs so that they

will still work if you delete EagleFiler’s database and import the files into a new
library.
• Added How can I put my library on my iPhone? section to the manual.
• Added Shortcuts section to the manual.
• Added an esoteric preference to clear the search field when you select a different

source.
• You can now double-click a smart folder to open it in a new window.
• EagleFiler now indexes a file’s Spotlight keywords for searching.
• Improved auto-generated titles.
• Improved the display of improperly encoded message headers.
• Worked around a bug in Mac OS X 10.4 when highlighting matching search terms

in the records list.
• Removes stray index files when opening the library.
• If there’s an error getting the downloads folder for a software update, EagleFiler

now defaults to Downloads rather than Desktop.
• No longer shows the deleted tag in the records list.
• The Untagged source now shows records that only have the “note” tag.
• Improved parsing of invalid mbox files.
• Improved error reporting when downloading Web pages.

204http://c-command.com/eaglefiler/bookmarklets
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• Rewrote filesystem code to improve performance and error reporting.
• Made various changes to improve interface responsiveness.
• Note files now include a relative URL to the file that they’re attached to, so that

you can easily find the file if EagleFiler isn’t installed.
• Added placeholder text to the Purchase. . . window.
• No longer lets Web pages steal focus from the records list.
• You can now bring up the Find panel when the source list or records list has focus.
• EagleFiler now saves damaged index files for possible future analysis of why Search

Kit couldn’t open them. It also tries multiple times to open indexes, since Search
Kit sometimes changes its mind about which indexes are valid.

Bug Fixes

• If an unexpected error occurs while EagleFiler is emptying the trash, it no longer
leaves the library in an inconsistent state. Also, EagleFiler will now detect and
repair this sort of damage when opening a library.
• Fixed a bug where a duplicate “From ” line could be inserted when generating an

mbox file from an Apple Mail mailbox. This was harmless but unsightly.
• Fixed a bug where, in rare cases, two messages imported from Apple Mail could be

joined into one, so that it looked like some had been skipped.
• Fixed a bug where EagleFiler changed the selection if you tried to delete a source

and then canceled.
• Fixed a bug where Reveal in Finder didn’t work when KeePassX was running.
• Fixed a bug where you could, via the contextual menu, open a different page when

viewing a Web archive.
• Fixed a bug where EagleFiler could freeze when revealing a non-existent file in the

Finder.
• Fixed a bug where EagleFiler’s Web fonts would not be consistent with Safari’s if

you’d never changed the fonts in Safari’s preferences.
• Fixed a bug where, when capturing multiple items with notes, some records without

notes would be assigned the notes from one of the other records.
• Fixed a bug where certain errors when creating a new library were not correctly

reported.
• Fixed a bug where the PDF viewer state wasn’t always preserved.
• Fixed a bug where the title of text records wasn’t linked to the filename by default.
• Fixed a bug where newly added tags weren’t selected if you had been renaming

another tag.
• Fixed a bug where EagleFiler could crash when closing a browser window.

1.3.8—July 23, 2008

• Fixed a regression where capturing from Firefox didn’t work.

1.3.7—July 22, 2008

• Fixed a regression where editing a keyboard shortcut could cause EagleFiler to crash.
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1.3.6—July 22, 2008

• Opening the Capture With Options window is faster and uses much less memory.

• When capturing a headline from NetNewsWire205, EagleFiler now preserves the flagged
status.

• Improved the error message when capturing from Firefox206 3 fails due to a bug in
Firefox.

• Fixed some small memory leaks.

• Fixed bug where .eml files converted to mbox format weren’t From-escaped.

• Moved .nib files that don’t need localization out of the English.lproj folder. This
should make it easier to run EagleFiler in a language other than English without changing
the default language on your Mac.

• Fixed bug truncating filenames containing decomposed characters.

• Improved the French localization.

1.3.5—July 2, 2008

• Made various performance optimizations to the browser and activity windows.

• If you click on a mailbox in the source list whose table of contents has not yet been
built, EagleFiler now reports this in the viewer so that it’s more clear why no messages
are shown yet.

• Dropping between folders in the source list no longer targets the containing folder, since
this made the subfolder drop targets too small.

• Improved the way EagleFiler handles special “merged” mailboxes when capturing from
Apple Mail.

• Added EnableWebPlugIns to the esoteric preferences, so that you can prevent Web
plug-ins (e.g. Flash) from loading in EagleFiler’s viewer.

• Capturing a mailbox in Apple Mail no longer captures its submailboxes, unless they’re
also selected.

• Fixed bug extracting the metadata from files during import.

• Fixed a bug where, in rare cases, EagleFiler would end up with two internal database
records for the same file. This could happen with Web archives in the To Import folder.

• Fixed the title of the Copy Image command when Control-clicking on an image in the
viewer.

• Fixed bug where EagleFiler would clear the display of the selected Web archive when
using Capture With Options.

• Fixed regression where AppleScripting a browser window didn’t work.

• Reduced the delay before showing the Capture With Options window.

• The font-chooser text fields now draw the text centered.
205http://netnewswireapp.com/mac
206http://www.mozilla.com/en-US/firefox/
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• Single-click editing in table and outline views now requires Mac OS X 10.5, since it now
relies on the standard OS functionality.

• In certain circumstances, auto-updating no longer requires authentication.

• Fixed bug where some operations in the Activity window would hang if the OS hung
while setting a Spotlight comment.

• Worked around suspected OS bug, which sometimes caused a file’s creation date to
change when you changed the modification date.

• Fixed bug where the Capture With Options window would be shown even if there were
no items to capture.

• Fixed bug editing filenames with no extension in the records list.

1.3.4—June 3, 2008

• Fixed regression where parts of the Drop Pad didn’t accept dropped files.

• Fixed regression where source list titles sometimes would be truncated prematurely.

• Fixed regression where the top of the viewer was cut off in the German localization.

• Fixed regression where changes to the tags weren’t saved if you closed the window before
pressing Return/Tab or clicking elsewhere.

• The default search scope is now Anywhere.

• The divider in the Info inspector now remembers its position.

• The Tags field in the Info inspector can now be made shorter.

• Improved launching speed.

• Added Importing Mail section to the manual.

• Added FolderMailboxTitleSeparateFromFilename to the esoteric preferences.

• Improved error reporting when capturing from Microsoft Word.

• Fixed bug importing Apple Mail messages when running under certain non-English
locales.

• Worked around a framework bug that could cause errors when closing a library.

• Removed logging of invalid URLs.

• Updated the German localization.

1.3.3—May 20, 2008

• Improved the speed of displaying large numbers of files or messages for the first time.

• Can now capture from Opera207.

• Added New Rich Text File command to the Dock menu.

• The Drop Pad is now resizable.

• Worked around Mac OS X bug that prevented EagleFiler from indexing certain docu-
ments for searching.

207http://www.opera.com
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• The Capture With Options window no longer suggests the title from the previous cap-
ture, since that wasn’t very useful.

• If a mailbox’s messages are not yet ready for display (because EagleFiler is rebuilding
the table of contents), the mailbox name is now shown in gray in the source list.

• Added placeholder text to the tags bar so that it’s more clear that it’s editable.

• Expanded the documentation for the Verify command.

• On Mac OS X 10.4, the viewer pane now shows custom rather than generic icons for
files that it doesn’t know how to display. (On Mac OS X 10.5, it continues to use Quick
Look.)

• When searching, EagleFiler now ignores trailing meta characters in the query string,
rather than returning no results.

• The Drop Pad menu command now hides the Drop Pad if it was already visible.

• Reorganized the Dock menu so that the fixed commands are easier to find with the
mouse.

• Improved error reporting when capturing from a “merged” mailbox in Mail.

• Adjusted spacing in source list.

• Added “raised” background style to the label in the tags bar.

• Skips importing .git folders.

• Improved error logging.

• Fixed bug where the Tags palette sometimes showed the tags for the wrong library.

• Fixed bug where the Tags field in the Batch Change. . . window didn’t become checked
when you started typing tags in it.

• Fixed bug with text color of non-highlighted text in selected rows of the records list,
when it didn’t have keyboard focus.

• Fixed error resizing the browser window.

• Fixed importing of Word documents with blank titles.

• Fixed bug where the command in the Window menu said Activity Viewer instead of
Activity.

1.3.2—April 24, 2008

• Faster indexed searches when lots of results are found.

• Faster at displaying large text files when running on Mac OS X 10.5.

• The Title and From fields in the Capture With Options window will now try to clean
up any text that you paste in, e.g. removing linebreaks and coalescing multiple spaces
into one.

• Enlarged the Title field in the Capture With Options window.

• Some errors now have a tooltip that shows which library they pertain to.

• Preserves more file metadata when editing documents within EagleFiler.

• EagleFiler can now import URLs that contain the | character.
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• Adjusted mail-related icons when running on Mac OS X 10.5.

• Added MaxEditableTextFileSizeInMB esoteric preference, which lets you set EagleFiler
to only show the first few megabytes of large text files, so that they display more quickly.

• Disabled undo in the Title and From fields in the Capture With Options window to
work around a bug in Cocoa.

• Fixed bug where the viewer could lose keyboard focus when using Previous/Next Record.

• Fixed bug where mailbox names were not indexed for Anywhere searches.

• Fixed bug editing text or RTF documents that were stored on non-HFS volumes.

• Fixed bug where indeterminate progress bars didn’t animate when running on Mac OS
X 10.5.

• Fixed bug importing messages from Apple Mail that claimed to be sent in the year 2038
or later.

• Fixed mbox separator-line dates for imported IMAP messages.

• Fixed regression where files and messages didn’t sort together properly by modification
date.

• Updated the .sdef file to the latest format.

• Updated to Python 2.5.2.

• Renamed the Activity Viewer window to Activity for consistency with Mail and Safari.

• Fixed color of non-highlighted text in selected rows of the records list.

1.3.1—April 9, 2008

• When searching the Tags scope (or using tag:<name> with another search scope), Ea-
gleFiler now lets you type incomplete tag names if Match Partial Words is checked.

• The @ character is now allowed in tag names.

• When using Capture With Options, any tags or notes that you set are now used in
addition to rather than instead of any tags or notes suggested by the capture script.

• Changes to notes are now undoable.

• Improved responsiveness by limiting the number of simultaneous file copy operations.

• Fixed regression where Copy tags to Spotlight comments didn’t work.

• Fixed regression editing files in the viewer whose path contained non-ASCII characters.

• Fixed regression deleting notes.

• When you delete the selected sources, EagleFiler now selects the next source in the list
and maintains the scroll position.

• Canceling a Capture With Options now brings you back to the application that you were
in.

• The tag abbreviation column now sorts by the actual tag names, rather than by the
abbreviation symbols.

• Worked around a Web Kit bug saving certain pages as Web archives.
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• Worked around OS bug that could cause a crash when resizing a browser window.

• Tried to work around OS bug revealing files in the Finder.

• After revealing a file in Path Finder208, brings Path Finder to the front.

• Re-positioned Format menu for consistency with Mail.

• Fixed a rare crash when searching a PDF.

• Fixed bug where dragging records in the list sometimes required an extra click.

• Fixed sorting of sources, records, and tags whose names contain combining marks.

• Fixed bug where the contextual menu sometimes had duplicate Highlight commands.

• Fixed bug where sometimes the original title of a document (stored in the file) wasn’t
indexed if you’d set a custom title in EagleFiler.

• Fixed bug where .plist files were sometimes imported as text.

• Fixed bug where a displayed Web archive could auto-open a window in the user’s Web
browser.

• Fixed bug remembering the PDF zoom level.

• Updated German localization.

1.3—March 11, 2008

Highlights

• Added Capture with options command (Option-F1 by default), which lets you set
the library, destination folder, tags, and other metadata right when you press the
capture key.
• Added Batch Change. . . menu command and button in the tags bar. This lets you

set the title, from name, label, tags, and notes of the selected records all at once.
• Now uses Quick Look to display file types that EagleFiler doesn’t natively under-

stand (e.g. Pages, Keynote, OmniGraffle, fonts). This feature requires Mac OS X
10.5.
• Added Untagged smart folder to the source list.
• Added Date Created and Tag Names columns to the records list.
• Added Set Label submenu and contextual menu.
• Added specialized viewing and indexing support for iCalendar (.ics) and vCard

(.vcf) files.
• Now indexes Skim209 notes attached to PDF and PDFD files so that you can search

for them within EagleFiler.
• Revised the icons and layout throughout the user interface.
• Made various optimizations so that EagleFiler is faster and more responsive.

Browser Windows
208http://www.cocoatech.com
209http://skim-app.sourceforge.net
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• When creating new rich text files or notes, EagleFiler now creates RTF files instead of
RTFD ones when possible. RTF files are more compatible and faster. Additionally,
when editing files in the viewer, EagleFiler automatically converts between RTF and
RTFD depending on whether RTFD is required.
• When using the Record . Tag command to jump to the tags bar, EagleFiler now

moves the insertion point to the end of the tags, rather than selecting all of them.
• When you create a New Rich Text File within EagleFiler, it’s no longer marked

as unread.
• The Open With External Viewer toolbar button now shows which application will

be used to open the file.
• Added Update Checksum toolbar button.
• Now shows tag colors in the source list.
• You can now tab from editing the File column in the records list into the record

viewer, which makes creating new RTF files smoother. (Requires Mac OS X 10.5.)
• When you open a library on a smaller screen than it was previously opened on,

EagleFiler now overrides the OS and shrinks the window so that it fits on the
screen.
• Added Select Source to the contextual menu.
• Added a custom drag image for the records lists.
• Added ellipsis-truncation to column headers in the records list.
• Increased the maximum width of the date columns.
• Holding down Option to skip the confirmation when emptying the trash now works

from the contextual menu.
• When displaying Usenet messages from mbox files, EagleFiler now shows the name

of the newsgroup in the To area of the viewer.
• You can now copy an image file that EagleFiler’s displaying to the clipboard.
• Now remembers between launches if you’ve set the PDF view to display continuous

or facing pages.
• You can now press Command-Delete to delete the selected record(s) when the viewer

has focus.
• You can now double-click the drag strip to collapse the source list.
• Increased the font size in the tags bar.

Capture

• If no library is open when you press the capture key, instead of showing an error
alert, EagleFiler now opens the Capture with options dialog, which lets you open
or create a library to complete the capture.
• Can now capture from Address Book, Flock210 1.0, iCab211 4, Keynote212, Mind-

210http://www.flock.com
211http://www.icab.de
212http://www.apple.com/iwork/keynote/
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Manager213, Pages214, OmniGraffle215, and TextMate216.
• Revised the user interface for setting the capture key.
• While EagleFiler is in the process of capturing (i.e. running the capture script or

showing the capture options dialog), it now badges the Dock icon with a picture of
a camera.
• Added |creationDate| and |modificationDate| options for capture scripts.
• Improved preservation of modification and creation dates when capturing from DE-

VONthink Pro217, MarsEdit218, Journler219, and Yojimbo220.
• Improved the reliability when capturing from WebnoteHappy221, e.g. if it returns

invalid tag, note, or title information.
• EagleFiler now creates the user Capture Scripts folder for you.

Miscellaneous

• If EagleFiler is busy when you ask it to close a library, it now stops any existing
operations (except when doing so would cause data loss), so you no longer have to
wait and/or stop them yourself.
• When dealing with “Bad Checksum” errors in the Errors window, you can now

update the checksums for multiple errors at a time, and after updating a checksum
EagleFiler removes the error from the window.
• Reduced EagleFiler’s RAM use for large libraries.

Importing

• Text dragged from a Web page is now imported as a Web archive instead of an RTFD
file. (If you want an RTFD file, you can use the Convert For Editing command.)
• In addition to checking periodically, EagleFiler nows checks the To Import folders

when it becomes the active application. This should get new files imported sooner.
• Now shows a single Growl notification for each batch of files imported, rather than

for each individual one.
• Now shows a progress spinner next to the action menu while EagleFiler is busy

importing.
• Changed the Dock icon indicator that shows when EagleFiler is importing. Instead

of a red circle, it now shows a downward pointing arrow.
• Improved EagleFiler’s recovery when WebKit runs into an internal error while saving

a Web archive file.

Info Inspector

• Added URL field.
213http://www.mindjet.com/us/products/mindmanager 7 mac/
214http://www.apple.com/iwork/pages/
215http://www.omnigroup.com/applications/omnigraffle/
216http://macromates.com/
217http://www.devon-technologies.com/products/devonthink/index.html
218http://www.red-sweater.com/marsedit/
219http://www.journler.com
220http://www.barebones.com/products/yojimbo/
221http://www.happyapps.com/webnotehappy/
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• Enlarged the Title field and Notes text view.
• Now displays three dates—Created, Added, and Modified—and the creation and

modification dates are editable.
• Fields that are unavailable are now disabled rather than just marked as uneditable.

Search

• Now shows the search scope beneath the search box so that it’s clear which parts of
the records you’re searching.
• When searching, you can now use OR as a synonym for |, and you can use -word as

a synonym for !word.
• EagleFiler is better at estimating how long indexing will take when some of the

records in the library are already indexed.

AppleScript

• The import command now returns a list of the imported records. This makes it
easier to set the properties of the new records. Additionally, import now waits
until the records have been imported before returning, so the script knows when the
import has finished.
• The import command now supports a deleting afterwards option, which makes

EagleFiler delete the source file after successfully importing it.
• You can now use the import command outside of a tell library document block;

it will then target the frontmost library.
• The source URL property is now settable.

Bug Fixes

• The order in the labels pop-up menu now matches the Finder.
• Now remembers the sorted column of the Tags inspector between launches.
• Fixed bug where the source URL wasn’t set if you imported a URL of a file that

wasn’t a Web page.
• No longer shows the Rebuild dialog when opening a library if you hold down other

modifier keys in addition to Command-Option.
• If EagleFiler was unable to capture due to a bug in the Finder, the error message now

suggests using drag and drop, updating to Mac OS X 10.5, or disabling FileVault.
• Now preserves the creation date when editing files within EagleFiler and when saving

notes.
• Fixed bug where the Import Files. . . command didn’t let you import items that were

next to the library folder.
• Fixed bug where certain Apple Mail mailboxes (typically those imported from an-

other mail program) weren’t imported as mailboxes.
• Fixed bug where the Reveal button in the Errors window didn’t work properly

for duplicate files that came from the To Import folder.
• Fixed bug where the Highlight command didn’t work properly when no text was

selected.
• Fixed bug where the Highlight toolbar button in the main browser window would

be enabled when editing a note.
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• Fixed bug where EagleFiler would add a uniquing number if you renamed a file/folder
to a name that differed only by case (and you were using a case-insensitive filesys-
tem).
• Worked around a Cocoa bug that could, in rare cases, lead to an infinite loop when

saving the library.
• Fixed bug where some Format . Font menu commands were enabled even though

they couldn’t be used because Allow Editing in Record Viewer was unchecked.
• Fixed bug where toggling Allow Editing In Record Viewer didn’t take effect imme-

diately.
• Fixed crash involving the tags bar.
• Fixed bug where capturing just messages from an Apple Mail mailbox with sub-

mailboxes would import empty folders for the submailboxes.
• Fixed bug where newly imported records sometimes didn’t sort properly by modifi-

cation date.
• Fixed bug where the Info inspector sometimes didn’t show the correct record.
• Fixed bug where custom icons on the To Import folder were not preserved.
• The software updater is better at handling invalid downloads folders.
• Fixed crash involving the Info inspector.
• Fixed bug where Edit . Find . Library Search. . . didn’t bring the window to

the front.
• Fixed bug hiding and showing the source list when running on Mac OS X 10.5.2.
• Fixed bug checksumming packages containing symlinks.
• Fixed bug where JavaScript was disabled in the viewer.

1.2.7—November 14, 2007

• If you create a New Rich Text File while one or more tag sources are selected, Eagle-
Filer now assigns those tags to it.

• Colored quote levels now work in HTML messages.

• You can now hold down the Option key to empty the trash without a warning.

• Now uses the proper Skim222 icon for PDFD files.

• Combined the three system services into one, which detects whether it was invoke with
a file, text, or URL(s). The keyboard shortcut can now be configured using System
Preferences rather than a separate utility.

• If you make EagleFiler a login item, set it to be hidden, and have it set to open a library
when it’s launched, EagleFiler will now re-hide itself after opening that library.

• Drag-importing from MacJournal works now.

• The system service now works properly when EagleFiler wasn’t already running.

• Control-clicking on a source group no longer selects it.

• Improved scaling of the library document icon.
222http://skim-app.sourceforge.net
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• Fixed bug where the Apple Help didn’t work on Mac OS X 10.5.

• Fixed regression where assigning/unassigning tags using the Spacebar in the Tags in-
spector didn’t always work.

• Fixed bug displaying some encoded message subjects.

• Fixed regression where the top couple pixels of the viewer could be cut off.

• Fixed bug where the icons of some types of sounds, movies, or images showed the wrong
file type.

• Fixed bug where the source list sometimes had the wrong background color.

• Fixed ellipsis truncation of selected source names.

• Updated German localization.

• Added Korean localization.

1.2.6—October 24, 2007

• Modernized the source list and buttons.

• Capturing the selected mailboxes/messages from Apple Mail now works when an IMAP
path prefix is set.

• Can now capture from MarsEdit223 (based on work by Eric Blair).

• Added support for Skim224 .pdfd bundles.

• Tags in the tag bar and inspectors now have contextual menus that let you reveal them
in the source list, to see all the records with that tag.

• Added French and German localizations.

• There are new AppleScripts for importing from LaunchBar225 and Quicksilver226.

• You can now modify capture scripts while EagleFiler is open without having to relaunch
for it to notice the changes.

• Improved import speed, particularly when the source volume is slow.

• You can now cancel an import in the middle of EagleFiler checksumming a file.

• Fixed bug where capturing from Apple Mail didn’t work on pre-release versions of Mac
OS X 10.5 Leopard.

• Capturing now works with pre-release builds of Camino 1.6.

• Select Source now preserves the selection in the records list after selecting the container
sources.

• Using the spacebar to toggle tags in the Tags inspector now interacts better with type-
selection.

• The search field now expands and contracts based on the available space in the toolbar.

• Convert For Editing now preserves the title and allows duplicates.
223http://www.red-sweater.com/marsedit/
224http://skim-app.sourceforge.net
225http://c-command.com/scripts/eaglefiler/launchbar-import-text
226http://c-command.com/scripts/eaglefiler/quicksilver-import-text
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• After deleting a record or tag, EagleFiler will now select the next item in the list.

• Clicking a link to open another EagleFiler record now gives it keyboard focus.

• Now clears Web views that aren’t in use, saving memory and silencing sounds.

• Capturing PDF files from Safari now works when the Schubert|it PDF Browser Plugin
is installed.

• Renamed the Library source to Records.

• Improved capture script error reporting.

• Metadata files are now invisible by default, and you can prevent them from being created
automatically. There are esoteric preferences to control this. Also, EagleFiler avoids
writing metadata files to disk if they haven’t changed.

• After opening a library with EagleFiler 1.2.6, it will no longer be openable in previous
versions of EagleFiler. Of course, the files and metadata are still accessible in the Finder.

• Fixed color of selected tags in inspector.

• Fixed memory leak with the Activity Viewer window.

• Fixed progress bar inaccuracy when importing a folder of files.

• Fixed bug importing .eml files exported from Thunderbird.

• Fixed bug where certain types of sound files were imported as text.

• Fixed bug displaying attachment names that used the Big5 character set.

• Choosing colors is more robust and defaults to the spectrum view.

1.2.5—August 21, 2007

• Can now capture from Cyndicate227.

• Fix bug where Flash was disabled in Web views.

• Fixed bug where the insertion point would sometimes move if you edited in the record
viewer and then manipulated the window before it had saved.

• Improved the robustness of the startup code to prevent some rare problems when launch-
ing EagleFiler.

• Improved handling of FDF files.

• Fixed rare errors importing lots of files at once.

• Verifying checksums is faster.

1.2.4—August 2, 2007

• The records list uses gentler background colors to indicate the files’ labels.

• Now shows labels in the source list.

• Added keyboard shortcuts for going to the next or previous PDF page.

• Now shows tooltips in the source list.

• The records list now has an alternating background color, like the Leopard Finder.
227http://cynicalpeak.com/cyndicate/
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• Improved the responsiveness of the user interface when highlighting search matches in
PDFs.

• Fixed incorrect outline/table row heights when using certain fonts.

• Now preserves extended attributes when copying files into the library.

• When using Copy Record Link and pasting into a rich text view, the pasted text’s font
will now match that of the surrounding text.

• Improved the Next/Previous toolbar buttons.

• Dragging from EagleFiler to a burn folder now creates a link instead of copying the file.

• If the File column is hidden, both Enter and Option-Enter will bring the Title column
into edit mode.

• After you drop a file onto a spring-loaded folder in the source list, EagleFiler will collapse
the temporarily expanded folders.

• EagleFiler no longer tries to import SketchUp files as text, and therefore it won’t try to
display them, which led to long freezes as the data overloaded Cocoa’s text system.

• Improved capture error messages.

• Fixed bug parsing tags from strings containing non-ASCII alphabetic characters.

• Fixed bug where labels were lost when editing RTF or RTFD files within EagleFiler.

• Now preserves modification dates when capturing from Yojimbo.

• If the records list is empty because nothing matched the search, this is now reported in
the viewer so that you don’t wonder why the list is empty.

• If Allow Editing in Record Viewer is off, New Rich Text File will now always bring
down a sheet for setting the text of the new file.

• Choosing Edit . Find . Library Search. . . now works when the toolbar is in Text
Only mode.

• Fixed help book icon.

1.2.3—July 2, 2007

• Calculates folder sizes and shows them in the records list.

• Added import plain text AppleScript command for when you want to import a string
as a text file rather than an RTF one.

• When you view a file, EagleFiler now makes sure that it’s up-to-date in the index, in
case you modified it outside of EagleFiler.

• When you edit a filename in the records list, EagleFiler no longer pre-selects the exten-
sion.

• The Errors window no longer auto-selects errors when they are added.

• Added progress bars when creating or opening a library.

• Rotates the log file to prevent it from growing too large.

• Changed the verification icon.

• Improved error handling when creating or opening a library.
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• Fixed bug where folder labels weren’t preserved when importing.

• Worked around OS bug that caused an internal error when pressing Option-Tab in an
empty text view.

• Errors reported from EagleFiler’s lower level frameworks are now reported in the log file
rather than on the system console.

• Fixed bug where EagleFiler would let you import the library into itself.

• Fixed regression where canceling an import sometimes didn’t work.

• Worked around suspected QuickTime bug that caused EagleFiler to not import the
proper ID3 tags from some MP3 files.

• Improved reporting of duplicate file errors.

• No longer tries to import .localized files.

• Fixed bug handling locked files and folders.

• Fixed bug where an error could be reported if you emptied the trash when a record in
it was selected.

• No longer tries to backup the metadata for missing folders.

• Fixed bug displaying e-mail messages when the chosen font was no longer available.

1.2.2—June 20, 2007

• Fixed bug where some menu commands were disabled when the record viewer had focus.

• When you view a PDF file, EagleFiler will now update the page count in the records list
in case it has changed.

• Fixed bug where PDF page counts weren’t transferred when dragging from one library
to another.

• Fixed bug importing text via drag and drop.

• Fixed PyObjC bugs that could cause various crashes and hangs.

• Fixed regression where Open in Delicious didn’t work.

• Fixed icon scaling in Activity viewer when merging mailboxes.

• Fixed regression where where changing Allow Editing in Record Viewer didn’t take effect
immediately.

• Fixed bug where EagleFiler would re-open at launch even libraries that were in the trash.

• Worked around Cocoa bug that could cause the record viewer’s scroll bars to be hidden
if you expanded the viewer when the ruler was hidden.

• Fixed bug where EagleFiler tried to import invisible metadata files.

• Fixed bug where the copy cursor was shown when dragging and dropping within the
record viewer.

• Fixed bug where the spell-checking state wasn’t remembered.

• Fixed bug with the PDF zoom-to-fit state and the contextual menu.

• Worked around PDF Kit bug where the password field wouldn’t disappear.
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• Fixed bug with To Import folders and locked files.

• Fixed bug where EagleFiler let you create a new library on top of an old one.

• Fixed bug indexing certain HTML and Microsoft Word files.

• Fixed bug with multiple backup metadata operations at once.

1.2.1—June 8, 2007

• You can now use the Export. . . command to export the selected messages in mbox
format, so that they can be imported into any mail program.

• The names of To Import folders now include the library name, so that you can tell them
apart in a Finder or open panel sidebar.

• Can now capture from Pukka228 and WebKit Nightly229. When capturing from Yo-
jimbo230, now preserves the label as an EagleFiler tag. When capturing from Cocoali-
cious231, Journler232, Yojimbo233, and WebnoteHappy234 now preserves the title rather
than extracting it from the file.

• The label colors now more closely match those in the Finder, and the pop-up menu sorts
alphabetically.

• The tooltip for the Tags column in the records list now shows the names of all the
assigned tags.

• Allow duplicate files in library is now a full preference.

• When copying tags to Spotlight comments, EagleFiler now separates the tag names with
a space instead of a comma-space, and there is an esoteric preference to set a tag prefix
such as &.

• When copying files into the library, now copies the Spotlight comments, too.

• Added tooltips to help with setting tag abbreviations in the inspector.

• The Backup Metadata command can now be used to force EagleFiler to copy the tags
to the Spotlight comments, if you don’t want to wait for this to happen automatically.

• Added esoteric preference to make EagleFiler display Web pages using their print stylesheets.

• When writing a capture script, if you obtain the tag names as a single string, you can
pass it as |tagsString| to let EagleFiler parse it into individual tag names.

• You can now select more than one error at a time in the Errors window.

• Adjusted the word characters used for indexing to make it easier to find words containing
$, @, %, and . (This will only take effect after rebuilding the indexes.)

• Made some changes to the New Library. . . interface to make it more clear that the
maximum library size only applies to encrypted libraries.

228http://codesorcery.net/pukka
229http://nightly.webkit.org
230http://www.barebones.com/products/yojimbo/
231http://www.scifihifi.com/cocoalicious/
232http://www.journler.com
233http://www.barebones.com/products/yojimbo/
234http://www.happyapps.com/webnotehappy/
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• Fixed regression where EagleFiler couldn’t open libraries inside folders with non-ASCII
names.

• Fixed regression where the Info inspector sometimes displayed information for the wrong
record(s).

• Fixed bug where .webloc files in the To Import folder were not deleted after importing.

• If EagleFiler encounters an error while importing a file in a To Import folder, it now
moves the file to the Unable to Import folder so that it won’t encounter the same error
again the next time it scans the To Import folder.

• Fixed bug importing WMA URLs.

• Worked around crash due to bug in Search Kit.

• Fixed bug where the records list lost focus when a search was active and you clicked on
a Web archive.

• Fixed bug with the foreground color of highlighted text in the records list.

• Fixed bug where EagleFiler would be slow and could run into an OS error when capturing
a large number of documents at once.

• Made various error reporting improvements.

• Improved undo in the inspectors.

• Fixed cosmetic bug with the Reveal In Library button.

• Fixed interface glitch where it looked as though EagleFiler would let you move the trash
and smart folders around.

• EagleFiler will no longer crash when opening a library on pre-release versions of Mac
OS X 10.5.

1.2—May 30, 2007

• Made a variety of changes to improve EagleFiler’s speed and responsiveness, especially
for libraries with many files.

• You can now copy from one library to another via drag and drop. All of the EagleFiler
metadata will be preserved.

• The New Library. . . command now offers the option to create an encrypted library.

• Highlights search matches in the items list and the record viewer.

• Each library now has a To Import folder in the Finder. Any files that you save into this
folder will be imported when you open the library (or within the next minute or two if
the library is already open).

• You can now delete (and undelete) individual e-mail messages.

• Uses the available Spotlight importers to index the content of many types of files that
EagleFiler doesn’t natively understand.

• Added Match Partial Words option to the search pop-up. When this is checked, you
can search for partial words without having to type wildcards (*) in the query.

• tag:<tagname> searches now work with Filename, From, To/Cc, and Title searches,
rather than just Anywhere and Notes searches.
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• Can now capture from Skim235 and Journler236 (preserving tags).

• When capturing from Cocoalicious237, EagleFiler now preserves the tags and the de-
scription and extended description.

• Added Backup Metadata command. EagleFiler will automatically backup a library’s
metadata when it’s opened (unless you have Shift held down) and also periodically after
it’s been opened. You can manually backup the metadata by holding down the Option
key and choosing Backup Metadata from the File menu. Metadata is backed up to
EagleFiler Metadata.plist files inside the library folder. If you import a file that has
backed-up metadata, EagleFiler will use the stored metadata to set the title, from name,
checksum, source URL, tags, and notes.

• Added Copy tags to Spotlight comments preference. When this is enabled, you’ll be
able to find files in your library by searching for their tag name using Spotlight.

• If you hold down the Command and Option keys when opening a library, you can access
the new Rebuild Indexes dialog. This lets you optimize or repair EagleFiler’s search
indexes, and you can choose whether it indexes for word searches or phrase searches.
Previous versions of EagleFiler always indexed for phrase searches. Switching to word
indexing will speed up EagleFiler’s indexing and substantially reduce the amount of disk
space that the indexes consume.

• Added Update Checksum command, so that it’s easier to tell EagleFiler when you’ve
modified a file using another application.

• When importing via AppleScript, you can now specify which folder to import into, e.g.
import files {theFile} container theFolder.

• It’s now possible to change filenames via AppleScript.

• When using Previous/Next Record with the Info inspector in front or the tags bar
focused, the text field will retain its focus as the selected record changes, making it
possible to quickly edit multiple tags/titles/filenames in sequence.

• You can now press Option-Delete when viewing a tag source to move the selected records
to the trash rather than unassigning the tag.

• Added Esoteric Preferences.

• When exporting messages in .emlx format, now includes the tags and notes.

• Now shows a determinant progress bar when importing a folder.

• No longer shows a progress window when opening a library.

• Improved the display of various kinds of multi-part e-mail messages.

• No longer shows the children of smart folders in the source list.

• Now shows the pointing hand cursor when you hover over a clickable link in a text view.

• From the AppleScript interface, it is now possible to access records by name, subject to
the filename being unique.

• Added backup metadata AppleScript command.
235http://skim-app.sourceforge.net
236http://www.journler.com
237http://www.scifihifi.com/cocoalicious/
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• You can now change the case of a file’s extension.

• Updated to Python 2.5.1.

• Worked around OS bug that could cause crash when viewing PDFs.

• Fixed bug where the note tag could get out of sync.

• Fixed bug where creating a link when editing in a rich text view would sometimes insert
the link after the selected text.

• Fixed crash when indexing certain QuickTime files.

• Fixed bug calculating checksums of certain document packages.

• Fixed memory leak with Activity Viewer window.

• Worked around Search Kit bug that could cause a crash when doing a phrase search.

• Fixed bug where if you drag-imported multiple folders into a folder, the second and
subsequent folders would be imported at the top level.

• Fixed bug capturing from Yojimbo 1.4.2.

• Fixed bug where the URL colorer didn’t find certain valid URLs.

• Fixed bug where EagleFiler allowed duplicate files to be added to the library.

• Fixed threading bugs when importing multiple files at once.

• When viewing a Web page, if you click on a link to another part of the same page,
EagleFiler now scrolls the window rather than opening the location in a new window.

• Modernized the crash reporter code.

• Fixed bug where EagleFiler would sometimes keep files open after a library had been
closed.

• Fixed bug where the Info inspector showed “()” for the size of a folder.

• Fixed bug in reporting library save errors.

• Fixed bug where application-level menu commands could get permanently disabled.

1.1.6—March 5, 2007

• Now supports searching by filename.

• Can now capture from Flock238.

• The interface is a bit more responsive, due to threading improvements when importing,
indexing, and merging.

• No longer hangs when indexing a movie with unresolved file references.

• No longer uses any CPU time when idle.

• Can now import malformed mbox files generated by MailSteward.

• Fixed bug where fields in the inspector could lose their focus when a background oper-
ation completed.

• Fixed bug dropping onto an item inside the Trash source.
238http://www.flock.com
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• Fixed regression displaying contents of multiple folder sources.

• Fixed regression where new rich text records weren’t auto-selected.

• Improved error handing during menu/toolbar validation.

1.1.5—February 20, 2007

• Worked around a Cocoa bug that could cause a crash when closing a window or open/save
panel.

• The Date column is now called Date Modified.

• Fixed bug where a record’s cached modified date could get stale.

• Fixed bug where closing a window or pulling down the File menu could be slow if there
were messages selected.

• Fixed regression where the same mailbox could be indexed by duplicate threads.

• Fixed bug remembering the open libraries when quitting.

• Fixed display of library names containing slashes.

1.1.4—February 16, 2007

• Added Show . Messages in Records Source option. This makes it possible to view and
search everything in the library by selecting the Records source. Previously, to search
e-mail messages you had to select one or more mailboxes; you can still do that, if you
want to restrict the search to just those mailboxes.

• The Tags inspector now sorts the assigned tags to the top.

• Added Bigger/Smaller commands for adjusting the text size for rich text documents and
Web archives.

• You can now omit the Shift key when pressing the keyboard shortcut to zoom in, i.e.
Command-= is now equivalent to Command-+.

• Improved URL coloring in messages.

• Made various performance improvements, particularly to file indexing, display in the
browser window, and emptying the trash.

• Now shows custom file icons (rather than a generic text icon) for files such as OmniGraffle
documents that are in XML format but are not strictly text documents.

• Added New Folder button to the Export. . . dialog.

• The Import Files. . . and Export. . . dialogs are now sheets.

• Worked around Search Kit bug that caused crashes when doing phrase searches.

• Worked around suspected Cocoa bug that could cause a crash if you pressed Cancel
when creating or opening a library.

• Worked around Cocoa bug that could cause the source list not to properly scroll to show
a new tag that had been created.

• Fixed bug importing MailTags projects.

• Fixed bug where the tags field in the Info inspector didn’t wrap when there were a lot
of tags, or update when the record selection changed.
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• Fixed bug where insertion point didn’t advance when pressing Space while editing a
tag’s name in the Tags inspector.

• Fixed bug accessing tags via AppleScript.

• Fixed bug displaying Web archives.

• Fixed problem displaying messages in tag sources if an index file had been damaged.

• Improved compatibility with pre-release versions of Mac OS X 10.5.

• The Software Update auto-updater is now compatible with FileVault.

• No longer shows inaccurate size for folders.

• Made various improvements to the error reporting and error logging.

1.1.3—January 25, 2007

• Can now capture from DEVONagent239, DEVONthink Pro240 (preserving comments),
Nisus Writer Express241, and Yojimbo242 (preserving comments and tags).

• Added Copy Source URL to the contextual menu.

• Better display of e-mail messages with embedded messages (such as digests and bounced
messages).

• You can now use just plain Tab instead of Control-Tab to tab out of the viewer pane in
the browser window when the viewer is a read-only text view.

• In the records list, you can now type Option-Enter to edit the title of the selected record.

• If a message attachment doesn’t have a name, EagleFiler will list the content subtype
next to the paperclip instead of omitting that attachment.

• When capturing from Apple Mail with both messages and mailboxes selected, “Mail-
boxes” is now the default choice.

• Better error messages when you try to capture a smart mailbox in Apple Mail.

• EagleFiler cannot import mailboxes from Apple Mail on Mac OS X 10.3 and earlier.
Rather than importing the mailboxes as folders, it now reports an error.

• Can now import more types of text clippings.

• Spaces in tag names are now converted to underscores instead of being deleted.

• Fixed error when pressing Enter in the records list.

• Fixed bug where capturing packages from the Finder didn’t work.

• Fixed bug where the scroll position and selection in the notes editor would be messed
up when switching to another application.

• Worked around a Web Kit bug that caused it to needlessly fetch archived portions of a
Web page over the network, or not display them at all if you were offline.

• Worked around a Web Kit bug when displaying a Web archive created from a local
HTML file.

239http://www.devon-technologies.com/products/devonagent/index.html
240http://www.devon-technologies.com/products/devonthink/index.html
241http://www.nisus.com/Express/
242http://www.barebones.com/products/yojimbo/
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• Fixed bug where Reveal In Library sometimes looked in the wrong library.

• Fixed error undoing in the tags fields.

• Fixed error using the Highlight command with no selection.

• EagleFiler’s helper tools don’t use the URL cache, so now they tell Web Kit not to store
one.

1.1.2—January 9, 2007

• Tabbing between the source list, records list, and viewer works much better, as EagleFiler
now overrides the Cocoa keyboard loop.

• You can now press Enter in the records list to edit the filename or press Return to open
the selected records.

• Can now capture from PDFView243.

• AppleScript enhancements:

– Added import text command, which takes a string and creates a new rich text file
in the library.

– You can now access the open browser windows along with their displayed records
and selected records.

– Added note file and trashed properties to library record. Also, various for-
merly read-only library record properties are now writable.

– Added container property to tag.

• If you click the + button in the browser window with the Tags folder or a tag selected,
EagleFiler will create a new tag instead of a new folder.

• EagleFiler is more responsive when emptying the trash, as the lengthy index updating
now takes place in a background thread. Also, EagleFiler now compacts the search index
when emptying the trash, which should reduce the disk space used and speed up future
searches.

• Added a hidden preference to make EagleFiler not check for duplicate files during im-
porting. Click the link to allow duplicate files or to forbid them.

• Worked around PDF kit bug that could cause repeated zooming out when viewing a
PDF.

• Fixed bug where EagleFiler didn’t recognize document packages when importing a folder
full of files.

• Fixed regression where EagleFiler could freeze when clicking an X button in the Activity
Viewer.

• If the library changes while you’re in the middle of editing a table cell or text field, Ea-
gleFiler will no longer replace your in-progress changes with the value from the database,
nor will it mess up the insertion point.

• When following an EagleFiler link, if the specified library can’t be found, but one with
the same name is already open, EagleFiler will try to use that library to open the link.

243http://pdfview.sourceforge.net
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• Made various changes to improve the responsiveness of the interface.

• Faster file deletions, with better threading, should improve the performance of all back-
ground operations that create temporary files.

• Fixed crash when logging indexing errors.

• Worked around some framework bugs that could cause a variety of different crashes.

• The indexer recovers better when a file is unexpectedly deleted.

• Worked around Cocoa bug that could cause some tags to be removed if you ended editing
in a tags field by pressing Return when the insertion point wasn’t at the end of the field.

• Fixed regression where changes to the tags weren’t saved when closing the Info inspector.

• Text filenames are now allowed to have no text before the extension, so you can now
store and rename “dotfiles” in EagleFiler.

• It is now possible to edit the extensions of text files.

• If you launch EagleFiler by dropping a file onto it, it will now open the default library
before importing the file rather than complaining that no library is open.

• Added blank line before the source URL in the records list tooltip.

• No longer brings the Errors window to the front (which was undesirable if you were in
the middle of typing something) when an error occurs—instead, it just makes sure the
window is visible.

• The mailbox importer now handles messages that start with “>From ” instead of a
header.

• Better handling of encrypted PDFs.

• Better error reporting in Endo capture script.

• Better error message when can’t capture from Mail.

• Fixed bug logging errors during mailbox rebuild jobs.

• Fixed bug where browser windows didn’t remember whether the trash source was ex-
panded between launches.

• Fixed bug where Command-Right Arrow and Command-Left Arrow didn’t work in text
views.

• Fixed bug where Reveal In Library didn’t work for records that were in the trash.

• Simplified the Purchase window.

1.1.1—December 18, 2006

• When capturing a selection of files from the Finder, Spotlight comments may now be
imported as tags or notes.

• Can now capture from Microsoft Excel.

• The keyboard shortcut for Import Text is now Command-% instead of Command-<, as
the latter conflicted with a system-wide shortcut when using certain keyboard layouts.

• When creating a rich text record using text dragged from Safari (or, generally, any
WebView), EagleFiler will now set the source URL and add it to the bottom of the text.
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• You can now create records by dragging text selections from within EagleFiler to its
source list or records list.

• After you choose Convert For Editing, EagleFiler will now select the newly created RTFD
files rather than leaving the original Web archives selected.

• When pasting the results of Copy Source URL into a rich text view, the clickable text
is now the URL itself, rather than the title, and no trailing newline is added.

• Added source URL to tooltip in records list.

• Generates better titles from dragged text.

• If you change the PDF view away from Zoom To Fit, it now remembers the current scale
factor.

• Improved the speed of the initial index check when opening the library.

• Improved parsing of mbox files.

• Fixed bug where capturing some URLs didn’t work.

• Fixed bug where, when opening a new window to display a record, the record wasn’t
always selected.

• Fixed bug where EagleFiler could hang if you tried to edit the title or filename of a
record while it was doing something else.

• Fixed regression where importing via drag and drop from another application sometimes
didn’t work.

• Fixed bug and reduced RAM usage when importing a large number of files/folders at
once.

• Fixed bug where the source list or records list would go into edit mode when you clicked
on it and it didn’t already have focus.

• Fixed bug where a PDF or Web archive would needlessly be scrolled to the first page.

• Stopping indexing operations by clicking the X button works better now.

• Indexing no longer hangs if there’s a problem loading a Web archive or if it’s corrupt.

• Worked around OS bug that prevented some Word documents from being indexed.

• Fixed bug reporting errors while adding a file to the library.

• Better error reporting for damaged Web archive files.

• Fixed bug where tag sources showed messages for mailboxes that were in the trash.

• Fixed bug where child tags weren’t sorted in the source list.

• EagleFiler no longer lets you give a tag an empty name.

• Worked around issue when saving libraries on Leopard.

• Worked around OS issue that caused EagleFiler to be the default opener for Word files.

• Worked around some bugs in libraries that EagleFiler uses, which caused errors when
importing text via drag and drop.

• Better error reporting when can’t write a temporary file or save the library.

• The contextual menu now says Delete instead of Move To Trash, since deleting from a
tag source doesn’t move to the trash.
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1.1—December 6, 2006

Importing

• EagleFiler will now let you import any kind of document. If it doesn’t know how
to display the document, it will simply show the file’s icon, which you can click to
open it in another application.
• When importing via drag and drop, you can now drop onto folders or tags in the

source list or into the records list in order to put the imported records into that
folder or assign them that tag.
• Now recognizes many more kinds of text files and text clippings.
• Can now import individual messages from Entourage via drag and drop.
• Added Command-< keyboard shortcut for the Import Text service.
• You can now import by control-clicking on a file in the Finder and choosing Open

With . EagleFiler.
• Added Import Clipboard command to the Dock menu.
• It is now possible to specify tag names and note text when importing via AppleScript.

Capture

• Can now capture IMAP mailboxes and individual selected messages from Apple
Mail.
• Can now capture from Endo244, Firefox245, and WebnoteHappy246.
• If you press the capture key when there is no library open or while in an unsupported

application, EagleFiler will now try to help you open a library or import the data
in another way.
• Capture scripts can now import tags and notes.

Text and Rich Text Files

• It’s now possible to edit text, RTF, and RTFD files directly in the record viewer.
EagleFiler will automatically save any changes that you make and update the files’
checksums.
• Creating new rich text files is much smoother. The keyboard shortcut is now

Command-N instead of Command-Control-N. If the File column is visible, Eagle-
Filer will bypass the sheet, select the new file in the records list, and bring the File
cell into edit mode so that you can set the filename and title. You can then tab into
the record viewer to begin typing the contents of the file.
• You can drag records into the record viewer (or the notes text view) to create links

to them.

Searching

• You can now search by tag. You can also add tag criteria when doing an Anywhere
or Notes search (e.g. tag:apple steve).
• Now remembers the last-used search scope (globally and per-window).

244http://kula.jp/software/endo/
245http://www.mozilla.com/en-US/firefox/
246http://www.happyapps.com/webnotehappy/
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• You can now access the search syntax help page from the toolbar search field menu.
Tags

• Added auto-completion when typing tag names.
• Added tags field to the bottom of the browser window, so that you can edit the tags

of the selected record without having to open another window. You can quickly give
the tags field keyboard focus by pressing Command-Shift-T.
• Tag sources now show all the e-mails with that tag (rather than just the files).
• Tag sources now behave more like iTunes playlists and iPhoto albums. If you delete

a record from a tag source, EagleFiler unassigns the tag, but the record remains in
the library.
• You can now arrange tags into a hierarchy in the source list, to organize them or to

hide the ones you don’t want to see at the moment.
• Added New Tag menu command. If records are selected it changes to New Tag

From Selection and the selected records are assigned the new tag.
Browser Windows

• You can now single-click to edit the Title, From, or File directly, instead of having
to open the Inspector window.
• Added Convert For Editing command, which lets you convert Web archives to RTFD

files that can be edited.
• If you hold down Option when double-clicking a Web archive (or a RTFD file con-

verted from a Web archive), EagleFiler opens the current version of the page rather
than the archive.
• EagleFiler now shows custom icons for folders. You can set a custom icon using the

Finder’s Get Info window.
• Added Show . Source List and Show . Record Viewer commands for people who

want to use the menu or keyboard instead of double-clicking the divider.
• Added Actual Size and Zoom to Fit commands. The PDF viewer now remembers

its zoom state, so that it won’t keep resetting to Zoom to Fit if you’ve zoomed in.
• Remembers the selected sources between launches.
• Arrow-keying through the records list is faster now.

Libraries

• Added Remember open libraries between launches preference and Startup Items
folder.
• The Drop Pad now has commands for creating a new library, opening a library, and

opening recent libraries.
• The Dock menu now shows recent libraries.

Other Enhancements

• If you ask EagleFiler to import a URL and the URL can’t be saved as a Web archive
(e.g. because it’s an image or PDF), EagleFiler will download the file and import it
as-is, rather than reporting an error about not being able to save a Web archive.
• Now imports MailTags247 projects as tags.

247http://www.indev.ca/MailTags.html
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• The Zoom In and Zoom Out commands now work with Web archives, where they
change the font size.
• The Copy URL command is now called Copy Record Link.
• Added Highlight command, which changes the background of the selected text to

yellow.
• Added Outline and Styles. . . to the Format menu.
• Dragging a library file onto the Drop Pad now opens the library rather than com-

plaining that the library can’t be imported.
• Improved the way EagleFiler auto-generates file names when creating a file from

dragged text or a Web page’s title.
• Now skips importing Apple Mail messages that are marked as deleted.
• Capture scripts are now allowed to use the compiled script format, with the .scpt

extension.
• Folders and mailboxes no longer have a title attribute that’s separate from the file

name.
• When creating a new rich text file inside a sub-folder, it’s now revealed there instead

of in the Records source.
• Indexing is now somewhat faster and uses less memory.
• Double-clicking a folder now opens it in EagleFiler instead of in the Finder.
• In the source list, single-clicking now enters edit mode and double-clicking now opens

the source.
• Improved secondary sorting of records list.
• Increased maximum width of the Kind column.
• Added keyboard shortcuts for Select Source and Hide Others.
• Rich text copied using Copy Record Link now includes the title of the record, rather

than just the URL.
• Now displays the proper background color for RTF documents.
• Added Open Source URL, Copy Record Link, and Verify to the contextual menu.
• The underscore and hyphen characters are now allowed in tag names.
• You can now drag into the records list of a tag source to assign that tag.
• Shortened toolbar button labels.
• The menu commands for Show Inspector and Show Tags now toggle the visibility

of the windows rather than showing them.
• The Software Update. . . checker now works behind an HTTP proxy.
• The Import Files menu command no longer allows you to import individual files

inside an Apple Mail mailbox, as this is usually an error.
• Moved Open in External Viewer command to the Record menu.
• Added keyboard shortcut for Open Source URL.
• Reordered Record menu.
• Reduced number of threads used on single-core Macs.
• You can now delete tags from the source list.
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Bug Fixes

• Periods in the names of folders are now treated as part of the name, rather than as
the beginning of a path extension.
• Worked around OS bug that prevented phrase searching from working. Because of

this, EagleFiler will automatically rebuild the indexes of any opened libraries.
• Fixed bug that could cause a crash when importing large folder hierarchies.
• When importing a folder, EagleFiler will now ignore any invisible Find By Content

index files.
• Fixed bug importing and moving files with very long names.
• Fixed bug in .emlx exporter.
• Fixed bug where EagleFiler couldn’t import a Web page if WebKit crashed while

trying to extract its text.
• Fixed bug with using Capture command in Dock menu.
• Fixed bug where EagleFiler didn’t let you capture if you launched it by opening a

library from the Finder and then switched to another application so that it finished
launching in the background.
• The capture key is now ignored if EagleFiler is frontmost.
• Fixed spelling and resizing of “Title” label in the New Rich Text File sheet.
• Fixed crash that could occur when indexing.
• Fixed bug where an indexing operation could stall indefinitely.
• If a document or message can’t be indexed, EagleFiler is better at continuing on

and indexing the rest of the documents or messages.
• Better logging of index problems.
• Fixed bug where indexed searching didn’t work in tag sources.
• Fixed bug where undo didn’t work after renaming in source list.
• Fixed bug where the user could use drag and drop to change the page that the Web

view was displaying to one other than that of the selected Web archive.
• Better display of messages with no text parts.
• Fixed bug where the Recent smart folders didn’t show records that were inside

folders.
• Fixed bug where Web archives couldn’t be displayed, depending on if you had certain

preferences set in Safari.
• Fixed bug where the selection in the notes text view would be needlessly reset when

the library changed.
• Fixed bug that could lead to error when undoing too far in the notes text view.
• No longer allows you to give a file an empty name (before the extension), as this

confuses Cocoa.
• Fixed bug where the Show Inspector command opened the inspector but didn’t

give it keyboard focus.
• Worked around OS bug that could cause crash when using NetNewsWire Lite.
• Fixed a few bugs that made it impossible to launch EagleFiler from a path containing

non-ASCII characters.
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• Fixed small memory leak when processing errors.
• Fixed bug where you couldn’t create a new folder with / in the name.
• Fixed bug where showed : instead of / when displaying file names.
• The file system encoding is no longer hard-coded to UTF-8.
• Improved thread-safety of record properties.
• When launching, no longer prints “CMSCreateDataProviderOrGetInfo : Invalid

colorspace type” message to console.
• Fixed bug where changes to a file’s name or title weren’t always propagated to the

index.
• Fixed bug where source URLs weren’t being cached properly.
• Fixed bug opening aliases of libraries.
• Fixed bug where you couldn’t create or open a library if its path contained non-

ASCII characters.
• Worked around bug in SOHO Notes (and other applications) that prevented drag-

and-drop importing of promised files from working.
• Fixed bug importing notes from MailTags248.
• Fixed bug where the drag image for a selected source used white text.
• Fixed bug where displaying an HTML e-mail message would take too long to time-

out.
• Fixed bug in reporting HTML rendering errors.
• Fixed internal error when closing a library right after opening it.
• Improved error recovery when an untrusted server certificate is encountered while

creating a Web archive.

1.0.2—October 14, 2006

• Fixed bug capturing from Apple Mail.

1.0.1—October 14, 2006

• Fixed problem where EagleFiler would sometimes crash at launch if an input manager
or haxie was installed.

• Worked around OS bug that caused jitter in the software update progress bar.

• The software update installer no longer says it failed if it succeeded.

1.0—October 13, 2006

• First public release.

248http://www.indev.ca/MailTags.html

186

http://www.indev.ca/MailTags.html

	Introduction
	Importing Is a Snap
	Familiar Mail-like Interface
	Search Everything
	The Library Is Open
	Reliable Data Storage
	Add Tags and Notes
	Speed Up and Simplify Your Other Applications
	Multiple Libraries
	Feature List

	Installing and Updating
	Requirements
	Installing EagleFiler
	Updating From a Previous Version
	Uninstalling EagleFiler

	Using EagleFiler
	Basics
	Library Folders
	What Can Be Imported
	Ways to Import
	Importing Existing Files
	Importing Web Pages and URLs
	Importing Text Snippets
	Importing From a Scanner
	The To Import Folder
	The Files Folder
	Services

	Importing Mail
	Importing Mail From Apple Mail
	Importing Mail From Entourage
	Importing Mail From Eudora
	Importing Mail From GyazMail
	Importing Mail From MailMate
	Importing Mail From Mailsmith
	Importing Mail From Outlook
	Importing Mail From Outspring Mail
	Importing Mail From Postbox
	Importing Mail From PowerMail
	Importing Mail From Thunderbird and Eudora 8
	Importing Mail From Webmail/Gmail

	Drag and Drop
	Shortcuts

	Browser Windows
	Source List
	Records List
	Record Viewer
	Searching

	Menus
	The EagleFiler Menu
	About EagleFiler
	Software Update…
	Purchase…
	Mac App Store

	The File Menu
	New Library…
	New Record  Rich Text File
	New Record  Plain Text File
	New Record  From Clipboard
	New Record  Open Stationery Folder
	New Folder…
	New Tag
	New Browser Window
	New Smart Folder…
	Edit Smart Folder…
	Open Library…
	Close & Lock
	Scan for New Files
	Import Files…
	Import URLs…
	Import Bookmarks…
	Export…
	Backup Metadata
	Empty Trash…
	Print

	The Edit Menu
	Undo/Redo
	Copy
	Copy Source URL
	Copy Record Link
	Paste/Paste and Match Style
	Find  Library Search…
	Find  Find…
	Find  Find Next/Previous
	Find  Use Selection for Find
	Spelling and Grammar
	Substitutions
	Transformations

	The View Menu
	Message  Raw Source
	Message  Plain Text
	PDF  Next/Previous Page
	Show  Source List
	Show  Record Viewer
	Show  Deleted Messages
	Show  Messages in Records Source
	Show  Messages in Tag Sources
	Allow Editing in Record Viewer
	Open in New Window
	Enter Full Screen

	The Go Menu
	Enclosing Record
	Contents of Record
	Previous/Next Record

	The Record Menu
	Mark as Unread/Read
	Mark as Flagged/Unflagged
	Tag
	Edit Notes
	Set Label
	Move To
	Batch Change…
	Convert for Editing
	Verify
	Update Checksum
	Merge Mailboxes/Message Files
	Reply to Message
	Open With External Viewer
	Open With
	Open Source URL
	Open in Delicious
	Quick Look
	Slideshow
	Reveal in Finder

	The Format Menu
	The Window Menu
	Show Info
	Show Tags
	Show Tag Cloud
	Activity
	Drop Pad
	Errors

	The Help Menu
	The Dock Menu

	Preferences
	Capture key
	Capture with options
	Quick entry
	Web page format
	Spotlight comments
	Fonts
	Search highlight color
	Quoted Text Colors
	Remember open libraries between launches
	Copy tags to Spotlight comments
	Allow duplicate files in library
	Esoteric Preferences

	Extending EagleFiler
	AppleScripting EagleFiler
	Applications That Support Capture
	Writing Capture Scripts
	Writing Stationery Scripts

	Frequently Asked Questions
	How can I access my library from multiple Macs?
	How can I put my library on my iPhone?
	How can I encrypt my files?
	How can I run optical character recognition (OCR) on my PDFs?
	How can I move messages between mailboxes?
	How can I copy my tags to another library?
	Why does EagleFiler import the wrong Web page when I press the capture key?
	How can I speed up EagleFiler?
	Why doesn't my serial number work?
	What information should I include when I report a problem?
	Sending in an Error Report
	Sending in Screenshots
	Sending in a ``Sample'' Report


	Legal Stuff
	Version History

